Legal Notice

Copyright © 2013 VMware, Inc. All rights reserved. This product is protected by U.S. and international copyright and intellectual property laws. VMware products are covered by one or more patents listed at http://www.vmware.com/go/patents. VMware is a registered trademark or trademark of VMware, Inc. in the United States and/or other jurisdictions. All other marks and names mentioned herein may be trademarks of their respective companies.

VMware, Inc.
3401 Hillview Ave.
Palo Alto, CA 94304

www.vmware.com
Contents

About vCenter Hyperic User Interface ............................................................... 5
  Intended Audience ............................................................................................. 5
ui-Admin ................................................................................................................ 6
  Administration Page ............................................................................................ 6
  ui-Admin.HQServer ............................................................................................ 8
  Groovy Console .................................................................................................. 14
  ui-tcservicelient ................................................................................................. 15
  HQ API .................................................................................................................. 15
  ui-Admin.Dependency ......................................................................................... 15
  ui-Admin.User ................................................................................................... 17
  ui-Admin.Role .................................................................................................... 19
  ui-HQHealth ....................................................................................................... 25
  ui-Admin.Escalation ......................................................................................... 30
  ui-Admin.Monitor ............................................................................................ 35
  ui-Administration.Plug-in.Manager .................................................................. 43
ui-Resources ....................................................................................................... 47
  Resources Browse ............................................................................................... 47
  Filter the Resource List ...................................................................................... 47
  Navigation and View Options ............................................................................ 47
  Create a Platform ............................................................................................... 49
  Create an Application ......................................................................................... 49
  Create a New Group .......................................................................................... 49
  Select and Add Platforms, Servers, or Services to a New or Existing Group ....... 49
  Create a New Group of Groups ......................................................................... 50
  Delete a Resource .............................................................................................. 50
  Enable or Disable Alert Definitions .................................................................... 50
ui-Monitor ............................................................................................................ 51
ui-Alert ............................................................................................................... 63
ui-Control ........................................................................................................... 87
ui-Views .............................................................................................................. 89
ui-CurrentlyDown .............................................................................................. 145
About vCenter Hyperic User Interface

vCenter Hyperic User Interface documents each page in the VMware® vCenter™ Hyperic® and user interface.

Intended Audience

vCenter Hyperic User Interface is intended for Hyperic users and administrators who interact with the Hyperic user in administrators who implement and support Hyperic resource monitoring and alerting.
ui-Admin

Administration Page

This page appears when you click Administration in the masthead. Only users with administrator privilege can use the features on this page.

Authentication/Authorization

The "Authentication/Authorization" section has options for viewing and updating HQ user accounts.

In vCenter Hyperic, additional options for creating and managing roles are also available.

HQ Server Settings

The "HQ Server Settings" section has links to several configuration pages:

**HQ Server Settings** — You can set a variety of deployment-wide HQ Server configuration options here.

**Monitoring Defaults** — You set the default monitoring settings for each resource type on this page. **Note**: Although metric collection settings defined here can be overwritten for an individual resource, such changes will not persist when type-level defaults are updated. Each time you update the monitoring configuration for a resource type, the settings for each individual resource of that type are updated.

**Escalation Schemes Configuration** — Use this page to create and manage escalation schemes for use in alert definitions.

**Plug-in Manager** — A user interface for deployment-wide management of product plug-ins; it displays all plug-ins deployed to the Hyperic Server, and a summary of agent deployment status for the plug-in. You can use Plug-in Manager to deploy new or updated plug-ins and to remove plug-ins on Hyperic Agents version 4.6 or later.

Plug-ins

This section is an attachment point for HQU plug-ins.

Learn About HQU Plug-ins

HQU plug-ins are Groovy-based HQ extensions that can be attached:

to the **Views** tab for a resource type,
as an item on a Masthead tab menu, or
to the "Plug-ins" section of HQ's **Administration** tab.

HQ has a number of built-in HQU plug-ins. Users can also develop and deploy custom HQU plug-ins. For more information see vCenter Hyperic HQU Plug-in Development.
The HQU plug-ins available here are:

**Network and Host Dependency Manager** * — In vCenter Hyperic, you can use this plug-in to define the relationship between platforms and network hosts or devices.

**Groovy Console** — Allows users to run Groovy code directly in the HQ Server.

**HQ Health** — Provides real-time diagnostic data for the HQ Server host used by HQ Support for troubleshooting.

**HQ Web Services API** — The API enables programmatic and command-line access to the HQ Server.

**tc Server Command-Line Interface** - A command-line tool, available with tc Server for use with vCenter Hyperic, for performing tc Server configuration and application deployment tasks. For more information, see [ui-Admin.tcServerCLI](#).

**vCenter Hyperic License Information**

This section appears if you have configured a vCenter Suite license, or you are running with the default Hyperic evaluation license. The following data is displayed:

**Expires** — When the license will expire. For a configured license, the value "Never" indicates that the license is perpetual. For the default evaluation license, "Never" is displayed until you import at least one platform into inventory, at which point the date two months after the first platform was imported appears.

**Platform Limit** — The maximum number of platforms the license entitles you to manage. "None" indicates that you can managed an unlimited number of platforms. If you are running with the default evaluation license, the limit is 60 platforms.

**vCloud Suite License Information**

This section appears if you have configured a vCloud Suite license. The following data is displayed:

**Expires** — When the license will expire. "Never" indicates that the license is perpetual.

**Platform Limit** — The maximum number of platforms the license entitles you to manage. "None" indicates that you can managed an unlimited number of platforms.

**vCenter Operations Management Suite License Information**

This section appears if you have configured a vCenter Operations Management Suite license. The following data is displayed:

**Expires** — When the license will expire. "Never" indicates that the license is perpetual.

**Platform Limit** — The maximum number of platforms the license entitles you to manage. "None" indicates that you can managed an unlimited number of platforms.
Licenses Usage Status

In this section, the value of **Platform Count** indicates how many platforms Hyperic is currently managing out of the total number of platforms that your licenses (including both vCenter and vCenter Operations Management Suite licenses if you have both) entitle you to manage. For example:

1/500 indicates that you have one platform under management and are licensed to manage 500 platforms.

1/UNLIMITED indicates you have one platform under management and are licensed to manage an unlimited number of platforms.

50/0 indicates that you have 50 platforms under management, and that your license is expired.

**ui-Admin.HQServer**

The **HQ Server Settings** page allows a Hyperic user with Super User role to configure a variety of Hyperic Server behaviors. Most changes take effect upon Hyperic Server restart.

HQ Server settings have a fundamental and wide-ranging impact on the functionality and behavior of your Hyperic deployment. Edit with extreme caution.

**HQ Email Configuration Properties**

HQ Server email configuration properties are used to form notifications that HQ sends for a fired alert.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base URL</td>
<td>The address:port where HQ Server listens for web application requests. The initial value of <strong>Base URL</strong> is the web application listen port configured when HQ Server was installed, for example: <a href="http://Ms-MacBook-Pro-15.local:7080">http://Ms-MacBook-Pro-15.local:7080</a></td>
</tr>
<tr>
<td></td>
<td>Base URL forms the prefix of an URL to any HQ appends the remainder of the URL that points to the <strong>Alert Detail</strong> page for the fired alert. For example: <a href="http://Ms-MacBook-Pro-15.local:7080/alerts/Alerts.do?mode=viewAlert&amp;eid=5:10611&amp;a=16431">http://Ms-MacBook-Pro-15.local:7080/alerts/Alerts.do?mode=viewAlert&amp;eid=5:10611&amp;a=16431</a></td>
</tr>
<tr>
<td>From Email Address</td>
<td>The email address listed as the sender of the alert emails. For example: <a href="mailto:hq@demo2.hyperic.net">hq@demo2.hyperic.net</a></td>
</tr>
</tbody>
</table>
HQ Announcement Properties

**HQ Version and Security Announcements** - Controls what security and version announcements will be sent to HQ Administrators: All, Major, or None.

Data Manager Properties

These properties control how HQ condenses and purges the contents of the HQ database. Regardless of these settings HQ will retain two years of compressed metric history, but you can control how long detailed metric data is retained. Retaining fewer days of detailed metric data and deleting alerts and other events on a timely basis can improve HQ performance.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Database Maintenance Every</td>
<td>Controls how frequently HQ compresses and archives detailed metric data that is older than the age specified by the following property.</td>
<td>By default, HQ does database maintenance every hour.</td>
</tr>
<tr>
<td>Delete Detailed Metric Data Older Than</td>
<td>Controls how many days of detailed metric data HQ retains before compressing it into hourly averages with highs and lows and archiving those values.</td>
<td>The default setting is 2 days. HQ does not support a value greater than 7 days.</td>
</tr>
<tr>
<td>Reindex Metric Data TablesNightly</td>
<td>Controls whether HQ reindexes metric data tables every night. If configured to re-index nightly, HQ re-indexes the tables around midnight.</td>
<td></td>
</tr>
<tr>
<td>Delete Alerts Older Than</td>
<td>Controls how long HQ stores alert event data.</td>
<td>The default value is 31 days.</td>
</tr>
<tr>
<td>Delete Events and Logs Older Than</td>
<td>Controls how long HQ stores other HQ event and log data.</td>
<td>The default value is 31 days.</td>
</tr>
</tbody>
</table>

**Note**: You must restart the Hyperic Server for data management changes to take effect.

Global Alert Properties

These properties enable immediate and global control of alert processing.

**Alerts** — Disable or enable all alert definitions for all resources immediately. Disabling stops any alerts from firing; notifications defined in escalations that are currently in progress will be completed.

**Alert Notifications** — Disable or enable alert notifications for all resources immediately. Disabling stops all notifications, include those for alerts with escalations currently in progress.
Hierarchical Alerting — In vCenter Hyperic, this setting controls whether alerts are evaluated using the hierarchical alerting method. When hierarchical alerting is enabled, before firing an alert for a resource, Hyperic considers the availability and alert status of the resource's parent. The purpose of hierarchical alerting is to avoid firing alerts for every resource affected by a single root cause.

Note: You can extend the effect of hierarchical alerting in vCenter Hyperic by configuring the relationship between a network device or virtual host and the platforms that depend on it using the Network and Host Dependency Manager available in the "Plug-ins" section of the Administration tab.

Notification Throttling Configuration Properties

In vCenter Hyperic, you can use notification throttling to limit the number of alert email actions (notifications sent by email for a fired alert) that Hyperic will issue in a 15 second interval. When the threshold you specify is reached, Hyperic stops sending email alert notifications and instead sends a summary of alert activity every ten minutes to the recipients you specify.

After starting to throttle, Hyperic re-evaluates notification volume for fired alerts every 10 minutes; when it determines that the per interval volume of individual notifications that fired alerts would generate is less than the configured threshold, Hyperic resumes sending individual notifications.

To enable notification throttling:

1. Click the Notification Throttling ON control.
2. In the Threshold field, enter the maximum number of notifications you want sent in a 15 second interval.
3. Enter one or more email addresses in the Notification Email(s) field.

Automatic Baseline Configuration Properties

In vCenter Hyperic, these properties control the baselining process. Changing the data set used to calculate baselines can affect baseline accuracy.

<table>
<thead>
<tr>
<th>Server Setting</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baseline Frequency</td>
<td>The frequency with which Hyperic calculates a baseline for each metric.</td>
<td>3 days</td>
</tr>
<tr>
<td>Baseline Dataset</td>
<td>The time range of metric data used in calculating the baseline.</td>
<td>7 days</td>
</tr>
<tr>
<td>Baseline Minimum Data Points</td>
<td>The minimum number of data points used in calculating a baseline.</td>
<td>40</td>
</tr>
<tr>
<td>Track Out-of-Bounds Metrics</td>
<td>Controls whether or not Hyperic tracks out-of-bounds metrics — measurements that are greater than expected high range for a metric, or less than the expected low range for a metric.</td>
<td>off</td>
</tr>
</tbody>
</table>
**LDAP Configuration Properties**

**Configure LDAP Authentication**

To configure Hyperic Server to use LDAP authentication for new users and to assign user roles based on LDAP group membership:

1. Click **HQ Server Settings** on the **Administration** tab.
2. Scroll down to the "LDAP Configuration Properties" section of the page.
3. Enter appropriate information for the properties described below:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use LDAP Authentication</td>
<td>Checkmark this option to enable LDAP authentication.</td>
</tr>
<tr>
<td>URL</td>
<td>Enter the location of your LDAP or Active Directory server. If other than the standard LDAP port is used, specify it the URL. Add the port to the end of the URL, after a colon (:) character. For example: ldap://YourLDAPHost:44389 If your LDAP directory requires SSL, specify the SSL port in the URL.</td>
</tr>
<tr>
<td>SSL</td>
<td>Place a checkmark in the box if your LDAP directory requires SSL connections.</td>
</tr>
<tr>
<td>Username</td>
<td>Supply an LDAP username with sufficient privileges to view the sections of the directory that contain the information for LDAP users who will access Hyperic. (Not necessary if the LDAP directory allows anonymous searching, rare insecure environments.</td>
</tr>
<tr>
<td>Password</td>
<td>Supply the password for the LDAP user specified in &quot;Username&quot; above.</td>
</tr>
<tr>
<td>Search Base</td>
<td>(Required) The &quot;Search Base&quot; property, sometimes referred to as the suffix, defines the location in the LDAP directory from which the LDAP user search begins. Supply the full path to the branch for example: ou=people,dc=example,dc=com Consult your LDAP administrator if necessary.</td>
</tr>
<tr>
<td>Search Filter</td>
<td>If desired, enter a filter to limits the LDAP user search to a subset of the object identified by the &quot;Search Base&quot; property. For example, (!{location=SFO*})</td>
</tr>
<tr>
<td>Login Property</td>
<td>(Required) The LDAP property (for an LDAP user) that Hyperic will use as the username for the user's Hyperic account. The default value is &quot;cn&quot;. Depending on your LDAP environment, a different property, for instance, &quot;uid&quot;, may be appropriate.</td>
</tr>
<tr>
<td>Group Search Base</td>
<td>Analogous to &quot;Search Base&quot;, this property defines the location in the LDAP directory from which the LDAP group search begins. If you want Hyperic to automatically assign Hyperic roles to new users, supply a value for this property.</td>
</tr>
<tr>
<td>Search Subtree</td>
<td>If you have configured the &quot;Group Search Base&quot;, described above, you can checkmark this box, to enable search of the entire subtree of the object identified by &quot;Group Search Base&quot;</td>
</tr>
</tbody>
</table>
If you have configured the "Group Search Base", described above, you can enter a filter to limit the LDAP group search to a subset of the objects found in the group search. The default value "Member={0}", results in filtering by the full distinguished name of a user. To filter by user login name, set "Member={1}" to filter on the login name.

4. Click OK.

**SNMP Server Configuration Properties**

**Configure HQ Server for SNMP v1**

Select "v1" from the **SNMP Protocol Version** dropdown menu and supply values for the properties defined in the table below.

The table below defines the properties for configuring HQ Server for SNMP V1 communications with an NMS.

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Description</th>
<th>Allowable Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNMP Trap OID</td>
<td>The OID of the notification to be sent. Supplies the value of snmpTrapOID.0 - the second varbind in a trap or inform that HQ Server generates. (The first varbind is SysUpTime.0.)</td>
<td></td>
</tr>
<tr>
<td>Default Notification Mechanism</td>
<td>Your selection governs the notification type that will appear as the default notification type option in the &quot;Notification Mechanism&quot; dropdown menu list that is presented in configuration dialogs when user configures an SNMP notification as an alert action, or as a step in an escalation.</td>
<td>For v1 of the SNMP protocol, choose V1 Trap. This is the only trap type you can generate for SNMP v1.</td>
</tr>
<tr>
<td>Enterprise OID</td>
<td>Enterprise OID.</td>
<td></td>
</tr>
<tr>
<td>Community</td>
<td>The community name to be sent with the trap.</td>
<td></td>
</tr>
<tr>
<td>Generic ID</td>
<td>Single digit identifier of the trap type.</td>
<td>0 - coldStart 1 - warmStart 2 - linkDown 3 - linkUp 4 - authenticationFailure 5 - egpNeighborLoss 6 - enterpriseSpecific</td>
</tr>
<tr>
<td>Specific ID</td>
<td>The specific trap code for an enterprise-specific trap (when Generic ID is set to to 6).</td>
<td></td>
</tr>
<tr>
<td>Agent Address</td>
<td>Address of the managed object that generates the trap.</td>
<td></td>
</tr>
</tbody>
</table>
## Configure HQ Server for SNMP v2c

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Description</th>
<th>Allowable Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNMP Trap OID</td>
<td>The OID of the notification to be sent. Supplies the value of <code>snmpTrapOID.0</code> - the second varbind in a trap or inform that HQ Server generates. (The first varbind is <code>SysUpTime.0</code>.)</td>
<td></td>
</tr>
<tr>
<td>Default Notification Mechanism</td>
<td>Specifies the default notification type that will appear in configuration dialogs when an authorized user configures an SNMP notification as an alert action, or as a step in an escalation. This choice simply defines the default option - the user configuring an alert action or escalation can choose a different message type.</td>
<td>V1 Trap V2c Trap Inform</td>
</tr>
<tr>
<td>Community</td>
<td>The community name to be sent with the trap.</td>
<td></td>
</tr>
</tbody>
</table>

## Configure HQ Server for SNMP v3

This section lists the properties for enabling vCenter Hyperic to send SNMP notifications to an NMS. When HQ is so enabled, you can use SNMP notifications in alert definitions - as alert actions and escalation steps.

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Description</th>
<th>Allowable Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNMP Trap OID</td>
<td>The OID of the notification to be sent. Supplies the value of <code>snmpTrapOID.0</code> - the second varbind in a trap or inform that HQ Server generates. (The first varbind is <code>SysUpTime.0</code>.)</td>
<td></td>
</tr>
<tr>
<td>Default Notification Mechanism</td>
<td>Specifies the default notification type that will appear in configuration dialogs when an authorized user configures an SNMP notification as an alert action, or as a step in an escalation. This choice simply defines the default option - the user configuring an alert action or escalation can choose a different message type.</td>
<td>V1 Trap V2c Trap Inform</td>
</tr>
<tr>
<td>Security Name</td>
<td>The username HQ's SNMP agent should use when sending notifications to the NMS.</td>
<td>Required.</td>
</tr>
<tr>
<td>Local Engine ID</td>
<td>ID of HQ's SNMP agent; this value appears automatically, and is not user-configurable.</td>
<td></td>
</tr>
<tr>
<td>Auth Protocol</td>
<td>The SNMP authentication protocol HQ Server should use for communications with the NMS.</td>
<td>none MD5 SHA</td>
</tr>
<tr>
<td>Auth Passphrase</td>
<td>The SNMP authorization passphrase configured for use when communication with the NMS.</td>
<td></td>
</tr>
</tbody>
</table>
### Configuration Options

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Description</th>
<th>Allowable Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privacy Protocol</td>
<td>The SNMP Privacy Protocol HQ Server should use for communication with the NMS.</td>
<td>none, DES, 3DES, AES-128, AES-192, AES-256</td>
</tr>
<tr>
<td>Privacy Passphrase</td>
<td>The SNMP privacy passphrase configured for use when communication with the NMS.</td>
<td></td>
</tr>
<tr>
<td>Context Engine ID</td>
<td>The EngineID of the NMS. This, along with Context Name, identifies the SNMP context for accessing management data.</td>
<td>Required for v1 and v2c traps. Do not supply for Inform.</td>
</tr>
<tr>
<td>Context Name</td>
<td>The name of the SNMP context that provides access to management information on the NMS. A context is identified by the Context Name and Context Engine ID.</td>
<td></td>
</tr>
</tbody>
</table>

### Groovy Console

This screen allows users to run Groovy code directly in the HQ Server. This provides users low-level interaction with HQ, for example, doing advanced scripting, clearing caches, and diagnosing issues. The Groovy console is available to Administrators only.

**To run a Groovy script:**

1. Type the script into the text box or click the name of a script template just above the text box.

<table>
<thead>
<tr>
<th>Script Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>database_locks</td>
<td>Shows what's going on in the database, what queries are currently being run</td>
</tr>
<tr>
<td>aiApprove</td>
<td>Adds all the platforms in the auto-inventory queue (auto-discovery in regular HQ parlance) to the HQ inventory. Performs the same task as users can perform Auto-Discovery portlet (described in ui-Dashboard.AutoDiscovery) in the Hyperic Dashboard, but en masse. Basically, a simple and fast way of adding lots of platforms to the inventory.</td>
</tr>
</tbody>
</table>

2. Click **Execute**.

The script is executed in the same process as the HQ Server code, and the results are displayed immediately below.
ui-tcserverclient

To navigate to the download page for the tc Server Command-line Interface (CLI) click tc Server Command-line Interface in the "Plug-ins" section of the Hyperic Administration page.

You can use the CLI to perform configuration and application deployment tasks on individual HQ-managed tc Server instances, or groups of HQ-managed tc Server instances.

HQ API

HQApi is Hyperic's built-in web services API; it enables programmatic and command line access to Hyperic Server features and data.

To download HQApi, click HQ Web Services Api in the "Plug-ins" section of the Administration page. The HQApi package includes:

- The hqapi-client-n.n.n.jar client library and support jars.
- The XSD that defines the web service.
- Javadoc documentation for HQApi.
- The HQApi supports two methods of interaction:
  - Programmatic access through the Java API.
  - Script-based access using command line tools.

For API documentation, see vCenter Hyperic Web Services API.

ui-Admin.Dependency

Define Network Host Relationships

The Network and Host Dependency Manager, available from the "Plug-ins" section of the Administration tab, allows you to define relationships between a top level platform (a network device or virtual host) and lower level (operating system) platforms that depend on it.

Defining dependency relationships extends the benefits of Hyperic hierarchical alerting to top level platforms.

vSphere Resource Relationships

If you manage vSphere resources using the vSphere plug-in, do not use the Network Host Dependency Manager to configure dependencies for vSphere resources. vSphere resource types will be removed from the Network Host Dependency Manager dropdown menu menus in a future release.
Step 1 - Select a Top Level Platform to Update

To define or change the dependent platforms for a top level platform, you first select the top level platform. For ease of navigation, the Network and Host Dependency Manager provides two ways to find a top level platform. Depending on how many top level platforms you have in inventory, and what you know about your target, one of the following options may be preferable.

Option A - Browse a Filtered List of Top Level Platforms

You can peruse a complete or filtered list of top level platforms in inventory to find the one you want to update.

1. Select the By Top Level Platform tab to list all top level platforms in inventory.
2. Filter the list, as desired:
3. Enter the leading characters of the top level platform name in the "Name" field.
4. Select a type of device or host from the Type pull-down.
5. Use the Show pull-down to limit the display to: all top level platforms, those with existing dependent platforms, or those with none.
6. Select a top level platform from the filtered list.
   Any dependent platforms already assigned to the top level platform are listed.
7. To add or remove dependent platforms, follow the instructions in Step 2.

Option B - Navigate from a Dependent Platform

If the top level platform you want to update already has a dependent platform, you can start from there.

1. Select the By Dependent Platform tab to list all operating system platforms that have a top level platform defined.
2. Filter the list, as desired:
3. Enter the leading characters of the platform name in the "Name" field.
4. Select an operating system platform type from the "Type" pull-down.
   The dependent platforms that match the filter settings are listed in this format: dependent platform name > top level platform name
5. Click top level platform name to select it.
   The dependent platforms already assigned to the top level platform are listed.
6. To add or remove dependent platforms, follow the instructions in Step 2.

Step 2 - Manage a Top Level Platform's Dependents

1. Navigate to the desired top level platform and select it, using one of the methods described in Step 1.
2. To remove dependencies use the Select and Remove controls on the page.
3. To add dependencies click Add.
4. The Available Platforms popup lists operating system platforms in inventory that are not currently assigned to a top level platform. Filter the list, as desired:
5. Enter the leading characters of the operating system platform name in the Name field.
6. Select an operating system platform type from the "Type" pull-down.
7. Select one or more operating system platforms from the list.
8. Click Add Dependency to save the association immediately.
9. Click Done to close the window when you are done updating dependencies for the top level platform.

**ui-Admin.User**

The General Properties section contains this information:

- Name
- Username — The username the user logs in with.
- Phone
- Department
- Password — The user's password is not displayed. If you have the permission to modify the password, a Change... link is present.
- Email — User's email address. Click to send an email to the user.
- Format — Format for email notifications sent to the user — HTML or plain text.
- SMS Address — An email-to-SMS gateway email address for the user's SMS device.
- Enable Login — Indicates whether or not the account is enabled. The user cannot log in when the login is disabled.

The Roles Assigned To section contains:

- A list of the roles to which the user is assigned.
- An Add to List button — click it to assign additional roles to the user.

**ui-Admin.User.AssignRole**

To assign roles to a user:

1. In the "Roles" panel on the left side of the page, checkmark each role to which you want to assign the user, and click the blue arrow to move the roles to the "Add to Roles" panel.
2. Click OK when you are done adding users to the role.

**ui-Admin.User.Edit**

1. Enter values for:
   - Name
   - Username — The username the user logs in with.
   - Phone
   - Department
   - Email — User's email address.
   - Format — Toggle the radio button to select HTML or plain text.
- **SMS Address** — An email-to-SMS gateway email address for the user's SMS device. For a cellular phone on the Cingular network, this might look like 4155551212@mobile.mycingular.com. Check with the service provider for details about an email-to-SMS configuration. Basic alert notification sent to this user's SSS address will be in long format, which can result in up to five separate messages on the SMS device each time notification is sent by HQ. Hyperic recommends that SMS alerting be used as a step in an escalations, not basic alert notification, but short format is used there.
  - **Enable Login** — Toggle the radio button to disable or enable the account. The user cannot log in when the login is disabled.

2. Click **OK**.

### ui-Admin.User.List

The **List Users** page lists the following information for each user account.

- **First Name**
- **Last Name**
- **UserName** — Click a user name to view and edit the user account.
- **Email** — Click an email address to send mail to the user.
- **Department**

### ui-Admin.User.New

To create a new Hyperic user:

1. Click **New User** on the Administration page.
2. Enter values for:
   - **Name**
   - **Username** — The username the user logs in with.
   - **Phone**
   - **Department**
   - **Password** — Passwords must contain at least 6 case-sensitive characters and numbers, and no spaces or quotation marks.
   - **Email** — User's email address.
   - **Format** — Toggle the radio button to select HTML or plain text.
   - **SMS Address** — An email-to-SMS gateway email address for the user's SMS device.

For a cellular phone on the Cingular network, this might look like 4155551212@mobile.mycingular.com. Check with the service provider for details about an email-to-SMS configuration. Basic alert notification sent to this user's SSS address will be in long format, which can result in up to five separate messages on the SMS device each time notification is sent by HQ. Hyperic recommends that SMS alerting be used in conjunction with escalations, not basic alert notification, but short format is used there.
Enable Login — Toggle the radio button to disable or enable the account. The user cannot log in when the login is disabled.

3. Click **OK and Assign to Roles** in vCenter Hyperic.

**ui-Admin.User.Password**

The **Change Password** page allows you to change a user's account password.

### Requirements for changing passwords

In vCenter Hyperic, only a user with a role that grants "Full" or "Read/Write" permissions to user accounts may change another user's password. You must enter your current password in order to change an account password, whether the account is yours, or another user's.

### To change the password for a Hyperic account:

1. Click the **Administration** tab in the Hyperic user interface.
2. Click **List Users** in the "Authentication/Authorization" section.
3. The **List Users** page appears.
4. Click the link in the "UserName" column for the user whose password you wish to change.
5. In the "General Properties" section of the page that appears, click the **Change...** link in the "Password" field.
6. Enter your password in the **Enter Your Current Password** field.
   
   The password entered must be the password of the user making the change, not the password of the user whose password is being changed.
7. Enter the new password for the selected account in the **New Password** field.
8. Re-enter the password in the **Confirm New Password** field.
9. Click **OK**.

**ui-Admin.Role**

### Properties Section

The **Properties** section contains this information:

- **Name**
- **Owner** — The user that created the role.
- **Description**
- **Administer HQ Server Configuration**
- **Dashboard Name**

### Permissions Section

The **Permissions** section displays the permission matrix for the role.

- **None** - No access at all to instances of the type.
• **Read-Only** - Allows role users to view instances of the type, but not create, edit, or delete them. For **Platforms, Servers, Services, Groups**, also enables:
  A role with **Read-Only** access to alert definitions for the inventory type.
  A role with **Read-Only** permission level does **not** have permissions to enable/disable/fix/ack alerts or control resources - these capabilities must be explicitly granted

• **Read-Write** - Allows role users to view and edit instances of the type, but not create or delete them. For **Platforms, Servers, Services, Groups**, also gives:
  • **Full** access to alert definitions for the inventory type,
  o Permission to manage alerts (enable/disable, fix, acknowledge) for the inventory type.
  o Permission to perform supported control operations on resources of the inventory type.

• **Full** - Allows role users to create, edit, delete, and view instance of the type. For **Platforms, Servers, Services, Groups**, also gives:
  • **Full** access to alert definitions for the inventory type.
  o Permission to manage alerts (enable/disable, fix, acknowledge) for the inventory type.
  o Permission to perform supported control operations on resources of the inventory type.

Click **Edit** to modify the permission matrix.

**Assigned Users**

The **Assigned User** section lists the following information for each user assigned to the role:

• **First Name**
• **Last Name**
• **UserName** — Click to view the user.

Click **Add to List** to add users to the role.

**Assigned Groups**

The **Assigned Groups** section lists the following information for each group assigned to the role:

• **Group** — The name of the group. Click to view the group.
• **Description**

Click **Add to List** to add users to the role.
Alert Calendar

The **Alert Calendar** section defines the availability calendar during which role users are available for alert notifications.

Custom alerts calendars enable "follow the sun" alert notifications. To implement a follow the sun notification strategy, you create multiple roles with complementary alert calendars. You assign a user to the role whose alert calendar matches the user's availability.

By default, a role's alert calendar settings specify that role users are available for notifications 24 hours a day, 7 days a week, with no exceptions.

To define an availability calendar for a role:

For each day in the week,

Use the first set of **From** and **To** pull-downs to specify a start time and an end time that role users are availability for notifications.

If there is a period of time within the availability period specified in the previous step, during which role users should *not* receive notifications, click **Except**, and use the **From** and **To** pull-downs on the right to specify that period of time.

Click **Save** after defining the alert calendar.

You must define additional role or roles with complementary alert calendars to ensure that there is a role whose users are available during periods of time that the current role's alert calendar does not include.

**ui-Admin.Role.AssignUser**

In vCenter Hyperic, each user you assign to a role can exercise the permissions defined for the role, on resources in the groups assigned to the role.

1. If you are not currently viewing the role to which you wish to assign users, navigate to the role.
2. Click **Add to List** in the "Assigned Users" section of the page.
3. On the "Users" panel on the left side page, checkmark each HQ user you wish to add to the role, and click the blue arrow to move the users to the "Assign To Role" panel.
4. Click **OK** when you are done adding users to the role.

**ui-Admin.Role.Groups**

In vCenter Hyperic, the groups of resources you assign to a role constitute the population of resources to which users with that role may exercise the permissions associated with the role. (For example, if the role's permission level to Platforms is **None**, role users will not have access to platforms in groups assigned to the role.)
Permissions are granted only to groups of individual resources
Assigning a group of groups or a group of applications to a role does not grant permissions to individual resources in nested groups or applications. Groups you assign to a role for the purpose of granting permissions must contain individual resources, as opposed to other groups or applications.

1. If you are not currently viewing the role to which you wish to assign groups, navigate to the role.
2. Click Add to List in the "Assigned Groups" section.
3. On the "Groups" panel on the left side of the page, checkmark each resource group you wish to add to the role, and click the blue arrow to move the groups to the "Assign To Role" panel.
4. Click OK when you are done adding groups to the role.

ui-Admin.Role.List

The List Roles page lists the following information for each role.

- Name — Click a role name to view and edit the role.
- Number of Members
- Description

ui-Admin.Role.New

Role Names and LDAP Authorization
If you use LDAP or Active Directory for user authorization, vCenter Hyperic can automatically assign users to Hyperic roles whose name matches a group to which the user is assigned — if the Hyperic role names and LDAP group names adhere to a required naming convention.

To take advantage of this functionality:
a role name in Hyperic must match a group name in your authorization directory. In addition to being identical, both role name and group name must be prefixed by "org\", for example "org\Admin".

Hyperic Server must be configured to use your LDAP system.

1. Click New Role on the Administration page.
2. In the "Properties" section of the New Role page, enter:
   - Name
   - Description, if desired.
3. In the Permissions section, select a permission level - Full, Read-Write, Read-Only, or None for each type:
   - Users
     - Grant Full to enable role users to create and delete HQ user accounts.
     - Grant Read-Write to enable role users to edit HQ users accounts.
Roles
If you select Full, which enables role users to create roles, HQ will ensure that the role's permission level to Users and Groups is at least Read-Only, because to create a role, you need to view users and groups.

Groups
- Grant Full to enable role users to delete groups created by others.
- Grant Read-Write to enable role users to modify groups created by others.
Note that regardless of the permission level you select, any user can create groups, and as the owner of such groups, delete them.

Platforms
- If you select Full, which enables role users to delete platforms and their child resources, HQ will require that the role's permission level to Servers and Services is also Full.
- If you select Full or Read-Write, HQ will automatically checkmark the Can Fix/Ack Alerts? and Can Control? capabilities.
- If you select Read-Only, you have the option to grant alert management or resource control capabilities by clicking Can Fix/Ack Alerts? or Can Control? respectively.
- If you select None, you cannot grant alert management or resource control permissions.

Servers
- If you select Full, which enables role users to delete servers and child services, HQ will require that the role's permission level to Platforms is at least Read-Write, and its permission level to Services is Full.
- If you select Full or Read-Write, HQ will automatically checkmark the Can Fix/Ack Alerts? and Can Control? capabilities.
- If you select Read-Only, you have the option to grant alert management or resource control capabilities by clicking Can Fix/Ack Alerts? or Can Control? respectively.
- If you select None, you cannot grant alert management or resource control permissions.

Services
- If you select Full, HQ will require that the role's permission level to Servers is at least Read-Write.
- Grant at least Read-Only if you are going to grant the role Full permission to Applications.
- If you select Full or Read-Write, HQ will automatically checkmark the Can Fix/Ack Alerts? and Can Control? capabilities.
- If you select Read-Only, you have the option to grant alert management or resource control capabilities by clicking Can Fix/Ack Alerts? or Can Control? respectively.
If you select None, you cannot grant alert management or resource control permissions.

Applications
- Grant Full if you want role users to be able to create and delete applications.
- Grant Read-Write if you want role users to be able to modify change applications created by others.

Escalations
- Grant Full if you want role users to be able to create and delete escalations groups
- Grant Read-Write if you want role users to be able to modify escalations.

The role is saved, and the refreshed role page will have three new sections: "Assigned Users", "Assigned Groups", and "Alert Calendar".

ui-Admin.Role.Permissions
You assign one of the following permission levels to each type.

None - No access at all to instances of the type.

Read-Only - Allows role users to view instances of the type, but not create, edit, or delete them. For Platforms, Servers, Services, Groups, also enables:

Read-Only access to alert definitions for the inventory type.
A role with Read-Only permission level does not have permissions to enable/disable/fix/ack alerts or control resources - these capabilities must be explicitly granted.

Read-Write - Allows role users to view and edit instances of the type, but not create or delete them. For Platforms, Servers, Services, Groups, also gives:

Full access to alert definitions for the inventory type,
- Permission to manage alerts (enable/disable, fix, acknowledge) for the inventory type.
- Permission to perform supported control operations on resources of the inventory type.

Full - Allows role users to create, edit, delete, and view instance of the type. For Platforms, Servers, Services, Groups, also gives:

Full access to alert definitions for the inventory type.
- Permission to manage alerts (enable/disable, fix, acknowledge) for the inventory type.
- Permission to perform supported control operations on resources of the inventory type.
Permission Tips

**Defining a Role's Permission Matrix**

For roles that:

**Add resources to inventory and create alert definitions** - use **Full** or **Read-Write** permission levels. These permission levels enable a role to also process fired alerts and control resources.

**Monitor resources, respond to alerts and control resources** - use the **Read** permission level, and then grant **Fix/Ack** and **Control** capability, or both. This allows operations staff to respond to alerts, see the details of alert definitions, and perform routine or as-needed resource control tasks but **not** create/modify/delete resources and alert definitions.

**Need visibility only** - Use **Read** permission level for roles that view and monitor resources, but do not (1) create/modify/delete resources and alert definitions, or (2) response to alerts.

---

**How HQ Validates Platform-Server-Service Permission Level Assignments**

vCenter Hyperic does a bottom-up validation of the permission levels a role grants to Platforms, Servers, and Services.

A role with **Full** access (which enables resource deletion) to an inventory type must have at least **Read-Only** access to the parent type (if there is one) and **Full** to the child type (if there is one).

For example, **Full** access to Servers requires at least Read access to Platforms and **Full** access to Services.

---

**ui-HQHealth**

**HQ Health**

The **HQ Health** page, accessible to Hyperic administrators on the "Plug-ins" section of the **Administration** tab of the Hyperic userface, displays real-time Hyperic Server diagnostics. **HQ Health** is helps Hyperic Support troubleshoot problems; it is not intended for customer use.

**Key Statistics**

The top of the screen displays standard health statistics for a server.
**Diagnostics Tab**

This tab contains the information that Hyperic prints to log files every 15 minutes. You can choose these diagnostics from the drop-down list:

- **Agent Synchronizer** — Lists the Hyperic Agents (up to 10 of them) that have done the most metric scheduling, unscheduling, and plug-in synchronization jobs since last Hyperic Server restart. The number of jobs of each type that the agent has run is shown. *(For information about plug-in synchronization, see Plug-in Deployment and Management in vCenter Hyperic Administration.)*

- **Batch Aggregate AvailabilityInserter** — Status of the queue that contains resource availability data to be stored in the database.

- **Batch Aggregate DataInserter** — Status of the queue of that contains resource metrics to be stored in the Hyperic database.

- **EhCache** — Size, hits, and misses for Hyperic cache regions.

- **Enabled Metrics Not Coming In** — Lists up to 10 platforms for which enabled metrics (for the platform, or resources running on the platform) were not reported during the last 60 minutes. For each such platform, the number of unreported metrics is listed, along with the internal ID for the metric, metric name (if known), the internal ID for the resource with the unreported metric, and the resource name. Note that only metrics for resources that (1) have been configured for monitoring, if necessary, and (2) are currently available, will be included in this diagnostic.

```
Report generated at 1/13/12 10:32:20 AM
Top 10 available platforms with enabled metrics not reported in for 60 minutes (by platform hierarchy)
------------------------------------------------------------------------
fqdn=goku.localdomain (5 not collecting):
  mid=80097, name=UNKNOWN, resid=26068, resname=goku Coldfusion 7.x
  mid=80098, name=UNKNOWN, resid=26068, resname=goku Coldfusion 7.x
  mid=80100, name=UNKNOWN, resid=26068, resname=goku Coldfusion 7.x
  mid=80104, name=UNKNOWN, resid=26068, resname=goku Coldfusion 7.x
  mid=80105, name=UNKNOWN, resid=26068, resname=goku Coldfusion 7.x
fqdn=w1-lotor.local (4 not collecting):
  mid=40694, name=UNKNOWN, resid=15573, resname=w1-lotor Solaris Network Interface lo0 (loopback)
  mid=40696, name=UNKNOWN, resid=15573, resname=w1-lotor Solaris Network Interface lo0 (loopback)
  mid=40514, name=UNKNOWN, resid=15558, resname=w1-lotor Sendmail 8.x
  mid=40515, name=UNKNOWN, resid=15558, resname=w1-lotor Sendmail 8.x
fqdn=w1-zarkon.local (2 not collecting):
  mid=61944, name=UNKNOWN, resid=22441, resname=w1-zarkon Solaris Network Interface lo0 (loopback)
  mid=61946, name=UNKNOWN, resid=22441, resname=w1-zarkon Solaris Network Interface lo0 (loopback)
```

- **Metric Reports Stats** — A running average of how fast metrics are being pushed into the database.
- **ZEvents** — Status of the internal BUS.

**Cache Tab**
This tab presents the detailed status of Hyperic cache regions:

- Total Memory Usage (of all cached objects)

For each region:

- Size
- Hits
- Misses,
- Limit
- Limit
- Memory Usage

**Load Tab**
Current load on Hyperic Server, including:

- Metrics collected per minute
- Platforms
- CPUs
- Agents
- Active Agents
- Servers
- Services
- Applications
- Roles
- Users
- Active Alert Defs
- Resources
- Resource Types
- Groups
- Escalations
- Active Escalations

**Database Tab**
The Database tab contains an **Actions** dropdown menu with database cleanup commands, and a **Query** dropdown menu with queries that return information about resources in the auto-inventory queue and resources that are orphaned.
You can perform the following database cleanup commands from the **Actions** dropdown menu:

- Purge AIQ Data — Deletes the contents of the auto-discovery queue. This is useful if the queue contains resources that for some reason cannot be imported. Deleting resources from the queue will cause the agent to rediscover them.
- Purge Stalled Executions — Deletes escalations that are stalled.

You can run the following queries from the **Queries** dropdown menu:

- AutoInventory IPs
- AutoInventory Platforms
- AutoInventory Servers
- Database Character Set
- Orphaned Alert Definition Count
- Orphaned Audit Count
- Orphaned (Stalled) Escalations
- Orphaned Group Count (deprecated)
- Orphaned Platform Count
- Orphaned Resource Group Count
- Orphaned Resource Count (deprecated)
- Orphaned Server Count
- Orphaned Service Count
- Postgres Locks
- Postgres Activity
- Active But Disabled Resource Alert Defs
- Database Version Information

**Agents Tab**

For each Hyperic Agent connected to the Hyperic Server, the following information is listed:

- **FQDN** — of the machine it runs on; this is the identifier of the monitored platform in Hyperic.
- **Address** — The IP address upon which the agent listens for server communications.
- **Port** — The port on the agent's listen address upon which it listens for server communications. By default, the listen port is 2144. The value "-1" indicates that the agent is configured for unidirectional communications.
- **Version** — Hyperic version
- **Bundle Version**
- **Creation Time** — When the platform where the agent runs was first added to Hyperic inventory.
- **# Platforms** — The number of platforms the agent is monitoring. Typically this value is "1", indicated that the agent is monitoring only the platform where it runs. The value is greater, if the agent is also monitoring an an agentless device, for instance an SNMP device.
- **# Metrics** — This is the number of metrics the agent collects. Hyperic recommends balancing the metric collection load across agents. For example, don't use a single agent to monitor every SNMP device in your network - this would constitute a single point of failure, and the metric load might downgrade the performance of other services running on the host.

- **Time Offset (ms)** — The system time offset between Hyperic Server and Hyperic Agent. Time synchronization on Hyperic Server and Hyperic Agents is very important to determine the availability of platforms and services correctly. Single or double digit values are okay. Higher values indicate a problem. In this case, set up NTP-daemons on your server and agent hosts. You can monitor the NTP-daemons and set an alert on the offset value.

- **License count**

**Maintenance Tab**

The **Maintenance tab** has commands for listing and removing orphaned resources.

---

### About Orphaned Objects in Cache

Interrupted database updates can result in orphaned rows in the Hyperic database. Orphaned rows can cause Hyperic exceptions. For example, if the Hyperic database contains alert definitions that are no longer associated with a resource, trying to edit a resource type alert can result in a stack trace similar to:

```java
org.hyperic.hq.events.AlertConditionCreateException:
org.hyperic.hq.measurement.MeasurementNotFoundException: No measurement found for 10288 with template 33434 at
org.hyperic.hq.bizapp.server.session.EventsBossImpl.updateAlertDefinition(EventsBossImpl.java:887)
```

- **Cleanup Orphaned Nodes** — Removes orphaned resources from the Hyperic database. For example, a service whose relationships to its metadata or related resources are broken.

- **List Orphaned Nodes** — List orphaned resources in the Hyperic database.

You can see the number of orphaned resources of a particular type by running the queries available on the "Database" tab of HQ Health.

---

### Inventory Summary Tab

The **Inventory Summary tab** lists the resource types in inventory and the number of each type.
Create an Escalation

Step 1 - Create New Escalation Scheme

1. Click Administration in the masthead.
2. Click Escalation Schemes Configuration.
3. Enter values in the Name and optionally, the Description fields.
4. Configure acknowledgment options in the "If the alert is acknowledged" section:
   a. Allow user to pause escalation for - Click to enable a user to pause the escalation when acknowledging the alert. Select "Until Fixed" or a duration from the dropdown menu list. (Options range from 5 minutes to 72 hours.) A user acknowledging an alert with this escalation will have the option to pause the escalation process for the period you specify.
   b. Continue escalation without pausing - With this default value, a user acknowledging an alert with this escalation will not be offered the option to pause the escalation.
5. Configure state change notification options in the "If the alert state has changed" section:
   a. Notify previously notified users of the change - With this default setting, when the state of the alert changes, state change notifications will be sent only to recipients who have already received a notification in previous escalation steps.
   b. Notify entire escalation of the change - Click if you want alert state change notifications to be sent to every notification recipient in the escalation - whether or not they have received a previous notification.
6. Configure escalation repeat behavior in the "If alert is fixed" section:
   a. Stop escalation execution - With this default setting, the escalation will not be repeated for an alert that is unfixed at the end of the escalation.
   b. Repeat escalation actions - Click to repeat the escalation process if the alert has not been fixed by the end of the escalation.
7. Click Next Step.

Step 2 - Create Escalation Actions

After performing Step 1 - Create New Escalation Scheme:

1. On the Escalation Configuration page, click Create Action.
2. In the Create Escalation Scheme Actions section, select an action type and proceed to the directions for that type.
   o Email - Create an Email or SMS Action
   o SMS - Create an Email or SMS Action
   o Sys Log - Create a Sys Log Action
   o SNMP Trap - Create an SNMP Notification Action
   o Suppress Alert - Create a Suppress Alerts Action
Create an Email or SMS Action
   a. After selecting the "Email" or "SMS" action type:
   b. Select a notification target type from the Choose Who to Notify dropdown menu:
   c. Notify Roles - You will be prompted to select one or more Hyperic roles. The Hyperic users with those role assignments will be notified.
   d. Notify HQ Users - You will be prompted to select one or more Hyperic users to be notified.
   e. Notify Other Recipients - You will be prompted to enter a comma-separated email list of the email addresses for the individuals you be notified.
   f. Leave "continue" selected if you want the next step in the escalation to occur immediately after the current one. To specify a delay before the next step is performed, select an interval from the dropdown menu. The intervals range from 5 minutes to 24 hours.
   g. Click Save.
3. Repeat Step 2 - Create Escalation Actions to add another step to the escalation, as desired

Create a Sys Log Action
   This option is available if the configuration described in Enable Syslog Notifications for Escalations has been performed.
   a. After selecting the "Sys Log" action type:
   b. Supply the value for these segments of the syslog message:
   
   meta
   product
   version
   c. Leave "Then continue" selected if you want the next step in the escalation to occur immediately after the current one. To specify a delay before the next step is performed, select an interval from the dropdown menu. The intervals range from 5 minutes to 24 hours.
   d. Click Save.
4. Repeat Step 2 - Create Escalation Actions to add another step to the escalation.
About Syslog Notifications
You can enable Hyperic to issue a syslog notification as a step in an alert escalation. The notification will log a line in the following format:

```
SyslogAction[ALERT_ID]: DB_1 4 META/PRODUCT/VERSION
RESOURCE_NAME : ALERT_NAME - ALERT_CONDITION
```

where:

- **ALERT_ID** is a number representing the alert ID in HQ.
- **META** is the "Meta" string configured for the syslog action in the escalation.
- **PRODUCT** is the "Product" string configured for the syslog action in the escalation.
- **VERSION** is the "Version" string configured for the syslog action in the escalation.
- **RESOURCE_NAME** identifies the resource for which the alert was fired.
- **ALERT_NAME** identifies the alert definition that fired the alert.
- **ALERT_CONDITION** is the alert condition and reported measurement that led to the alert firing, for example, "If Availability > 0.0 (actual value = 1)"

Create an SNMP Notification Action
You can define an SNMP notification to be performed as a step in an escalation if the Hyperic Server is configured for your NMS. See "SNMP Server Configuration Properties" on Hyperic Server Settings help page for more information.

The data that you see in a trap depends on the SNMP protocol version that you select.

If you select SNMP protocol version 1, the trap sent when the escalation step is performed will contain these variable bindings:

- sysUptimeOID.0 - No configuration is required for this binding.
- Enterprise OID - Identifies the type of managed object that generates the trap.
- Agent Address - Provides the address of the managed object that generates the trap.
- Generic ID - Indicates one of a number of generic trap types.
- Specific ID - Indicates one of a number of specific trap codes.
- A variable binding for the alert data specified in snmp_trap.gsp, a Groovy Server Page template that returns the alert definition name and the "short reason" for firing. This template can be customized, as desired.
- any additional variable bindings that you define.

If you select SNMP protocol version 2, the trap sent when the escalation step is performed will contain these variable bindings:

- sysUptimeOID.0 - No configuration is required for this binding.
- snmpTrapOID.0 - This binding is configured on the HQ Server settings page.
- A variable binding for the alert data specified in snmp_trap.gsp, a Groovy Server Page template that returns the alert definition name and the "short reason" for firing. This template can be customized, as desired.
- any additional variable bindings that you define.
To configure an SNMP notification as an escalation step:

a. After selecting the "SNMP Notification" action type, enter:
   - **IP Address** - Enter the address and port of the target SNMP server.
   - **Notification Mechanism** - Choose the type of notification to send.
     - v1 Trap
     - v2c Trap
     - Inform - not supported if Hyperic Server is configured for SNMP v1.
   - **OID** - Enter the OID of the notification that will contain the alert details specified in the `snmp_trap.gsp` template.

b. For each additional variable binding you wish to add, click **Add Another Variable Binding** and enter:
   - **OID** - Enter an additional OID to include in the notification.
   - **Value** - Enter a value for the OID. You can enter plain text, or an alert variable. For more information, see Variables Available for Notification Templates.

c. Leave "Then continue" selected if you want the next step in the escalation to occur immediately after the current one. To specify a delay before the next step is performed, select an interval from the dropdown menu. The intervals range from 5 minutes to 24 hours.

d. Click **Save**.

e. Repeat **Step 2 - Create Escalation Actions** to add another step to the escalation.

Create a Suppress Alerts Action

This action stops the alert from repeated firing - it is useful if the alert definition for the fired alert is not is not configured to "fire once until fixed", and but you want to stop repetitive firing at a specific point in the escalation process. After this step in the escalation process is performed, the alert will not fire again until fixed.

def. After selecting the "SNMP Notification" action type:
   - Leave "Then continue" selected if you want the next step in the escalation to occur immediately after the current one. To specify a delay before the next step is performed, select an interval from the dropdown menu. The intervals range from 5 minutes to 24 hours.
   - Click **Save**.

g. Repeat **Step 2 - Create Escalation Actions** to add another step to the escalation.

View an Escalation

To view an escalation:

1. Click **Administration** in the masthead.
2. Click **Escalation Schemes Configuration**.
3. In the "Escalation Name" panel on the left side of the page, click the escalation's name. The escalation details appear on the right side of the page.
**Edit an Escalation**

Edits to an escalation scheme take effect for all alert definitions to which the escalation has previously been assigned. When you edit an escalation, you can:

Edit an escalation's **Name**, **Description**, and its acknowledgment, notification, and repeat behaviors.

- Delete actions from an escalation.
- Add actions to an escalation.
- You cannot edit an escalation action, you must delete it and create a new action.

**To edit an escalation:**

1. Navigate to the escalation as described in *View an Escalation*.
2. To change the scheme's **Name**, **Description**, or high-level instructions, click **Edit**, change the values, and click **Save**.

To delete an existing action, click **Delete** to the right of the action.

To create a new action, choose an action type and follow the instructions in *Step 2 - Create Escalation Actions*.

---

**Editing an Escalation Affects Escalations in Progress**

When you edit an escalation scheme, HQ will immediately stop executing any escalations that are in progress for alerts to which the escalation is assigned. Note that once an escalation for an alert has been stopped: * The alert cannot be acknowledged.

No further notifications of alert state changes will be issued. So, although an alert with a stopped escalation can be "fixed", notification recipients configured for the escalation will not be notified that the alert was fixed.

---

**Delete an Escalation**

To delete an escalation:

1. Navigate to the escalation as described in *View an Escalation*.
2. In the "Escalation Name" section, click **Delete** to the right of the scheme's name.

---

**Deleting an Escalation Affects Associated Alerts and Escalations in Progress**

When you delete an escalation scheme:

HQ will immediately stop executing any escalations that are in progress for alerts to which the escalation is assigned.

The escalation will be removed from any alert definition to which the escalation is was assigned; when an alerts that had the escalation fires, the escalation process will not be performed.
ui-Admin.Monitor

Monitoring Defaults Page
To display the Monitoring Defaults page, click Monitoring Defaults in the "HQ Server Settings" section of the Administration tab.

What's on the Monitoring Defaults Page
The Monitoring Defaults page lists all of the resource types that Hyperic can monitor, organized in three sections:

- **Platforms Types** - Lists the platform types that Hyperic can monitor.
- **Platform Service Types** - Lists the platform service types that Hyperic can monitor.
- **Server Types** - Lists the servers types and service types Hyperic can monitor, arranged hierarchically. Each server type in the list is followed by an indented list of associated services, each preceded by the ⌉ icon.
- Navigate to Monitoring Configuration and Resource Lists
- The following links are available for each resource type:
  - resource type name - the name of each resource type (such as "Linux" or "Win32") is a link you can click to list all resources of that type in Hyperic inventory; changes made to the metric template for the resource type will update the monitoring settings for each resource shown.
  - Edit Metric Template - Click to view and update see the current metric collection settings for the resource type. For more information, see the associated help page.
  - Edit Alerts - Click to view or create alert definitions for the resource type. For more information, see the associated help page.

ui-Admin.Monitor.NewResourceTypeAlert

Define a Resource Type Alert
This page explains how to define an resource type alert. A resource type alert is applied to all resources of the specific type that currently exist and new resources of the type that get created in the future. Only HQ Administrators can create resource type alerts.

Step 1 - Select Target Resource Type
1. Click Administration in the masthead.
2. Click Monitoring Defaults in "HQ Server Settings" section of the page.
3. On the HQ Monitoring Defaults Configuration page, click Edit Alerts for the resource type for which you want to define an alert. The Monitoring Defaults page will display any alert definitions already assigned to the alert.
4. Click New to create a new alert definition.

Step 2 - Define Alert Properties
- On the New Alert page, define each property in the "Alert Properties" section.
Name — Name assigned by the user creating an alert definition. A fired alert is identified, in the Hyperic user interface and alert notifications, by the alert definition name and a timestamp. An alert definition name should clearly communicate the nature of the problem. For example, "Down" for an alert on availability, or "Low Memory" for an alert on free memory.

Description — Description entered by the user creating the alert definition.

Priority — The severity of the problem, as defined by the person creating the alert definition: "Low", "Medium", or "High". A consistent policy for defining an alert definition priority makes it easier to triage problems appropriately. An alert's priority is shown in Hyperic pages that present alert status and in alert notifications. You can sort alerts by priority in vCenter Hyperic's Alert Center or Operations Center.

Active — The current enabled/disabled status of the alert definition. Alerts only fire for enabled alert definitions. When an alert definition is disabled, Hyperic does not evaluate its condition or fire alerts for it.

Step 3 - Define Alert Condition Set

- On the New Alert page, define the Condition Set, and click OK when you are done.

Condition Set

An alert condition specifies a resource metric value or event that will initiate the alert firing process.

The condition types you can choose when you define a alert vary by resource type and Hyperic version. If a condition type is not supported by your version of Hyperic or is not valid for the target resource, it will not appear as an option.

To define a condition, choose one of the following condition types, and supply required parameter values.

- Metric condition - To base the alert on the value of a metric that Hyperic collects for the resource:
  i. Metric - Select a metric from the selector list. Only currently enabled metrics are listed. (If the metric you're looking for is not listed, see the note below.)
  ii. Define the rule for evaluating the metric value. You can:
     ▪ Compare metric value to an absolute value. Select an operator: > (greater than), < (less than), = (equal to), or != (not equal to), and enter a metric value. If the metric value is a percentage, specify it as a float value. For example, enter .99 for 99%, 1.0 for 100%. Use a period (.) as a decimal separator, rather than a comma (,).
     ▪ Compare metric value to its minimum, baseline, or maximum value, in vCenter Hyperic only. Select an operator: > (greater than), < (less than), = (equal to), or != (not equal to), and choose "Min Value", "Baseline Value" or "Max Value". Baselining must be enabled.
     ▪ Fire upon change in metric value. Click value changes.
To Enable Collection of a Metric
If you want to base a metric condition on a metric that is not currently collected, you have to enable collection of that metric. To do so, update the metric collection settings for the resource type (choose Monitoring Defaults from the Administration tab), or for the specific resource (click Metrics on the Monitor tab for the resource).

- **Inventory Property Condition** - To define a condition that is triggered when the value of an inventory property for resource changes, select an inventory property. The dropdown menu contains only those inventory properties that are valid for the type of the resource to which the alert applies.

- **Control Action Condition** - When you define an alert for a resource that supports control actions, you can define a condition that is triggered when a particular control action is performed. If desired, you can base the condition on a control action with a particular result status: "in progress", "completed", or "failed". Dropdown menus allow you to select a control action that the resource supports, and a result status if desired.

- **Events/Log Level Condition** - To define a condition that is triggered by a log event, select a message severity level ("error", "warn", "info", "debug", "all") and optionally a match string. The condition is satisfied each time a message of the selected severity that contains the match string (if one was specified) is written to a log file that Hyperic is tracking. Log tracking must be enabled for the resource. To determine the log files that Hyperic monitors for the resource, see the Configuration Properties section of the resource's Inventory tab. The log files that Hyperic monitors for a resource are defined using the server.log_track.files property. For configuration instructions, see Set Up Log Tracking for a Resource.

- **Config Changed... Condition** - This type of condition is triggered by a change to a configuration file that Hyperic is configured to monitor for the resource. To limit the condition to a single file, enter its filename in the "match filename" field. If you don't specify a filename, a change to any file monitored will trigger the alert. To determine the log files that Hyperic monitors for the resource, see the Configuration Properties section of the resource's Inventory tab. The files that Hyperic monitors for a resource are defined using the server.config_track.files property. The maximum length for filename entered is 25 characters.

**Define Additional Conditions**
You can define up to three conditions for an alert. To add another condition, click Add Another Condition and specify whether both the new condition and the preceding one must be satisfied for the alert to be triggered ("AND") or only one must be satisfied ("OR").
Define Recovery Alert Behavior

To designate the alert you're defining as a recovery alert, select the primary alert definition from the dropdown menu.

A recovery alert condition should detect when the condition that fired the primary alert is no longer true. When a recovery alert fires, it marks the primary alert "Fixed", and the primary alert definition is re-enabled. The primary alert definition should be configured to **Generate one alert and then disable alert definition until fixed**, as described below.

Enable Actions

You can make the condition absolute - (one strike you're out) or fire after the condition occurs repeatedly. Choose either:

- **Each time conditions are met.** The alert fires upon a single occurrence of the condition, or
- **Once every _ times conditions are met within a time period of _ minutes.** This option configures an alert to fire when the condition(s) occur multiple times over a period of time. Enter the number of occurrences and period of time.

Enable Action Filters

An action filter can be used to control alert firing and alert actions.

*Disable an Alert Definition upon Firing*

Click **Generate one alert and then disable alert definition until fixed** to disable the alert definition after firing and re-enable it when the alert that triggered it is marked "Fixed".

This option eliminates redundant firing for the same problem. If you do not choose this option, the alert will fire repeatedly as long as the triggering condition is still true.

This configuration option, used in conjunction with recovery alerts, automates the process of disabling and re-enabling an alert definition. Result: (1) no redundant alerts for the same problem, and (2) you don't have manually "fix" an alert triggered by a transient problem.

*Disregard Control Actions for Related Alerts.*

The **Disregard control actions that are defined for related alerts** option appears on **New Alert Definition** pages for resources that support control actions. This option only applies when:

i. The current alert definition will include an alert action
ii. The resource associated with the alert is a member of an application
iii. There are other members of the same application with alerts that fire control actions (ideally the same control action)
Under these circumstances, this configuration option ensures that if multiple alerts are fired within a short period for resources that are members of the same application, only one control action will be executed. For example, this would prevent a server from being restarted several times in a short period of time for the same alert conditions. For instance, you might have an alert with an action to restart a Tomcat server if the JVM Free Memory got too low and another alert with an action to restart the same server if the JVM Active Thread count got too high. If both alerts fired at the same time and they were filtering control actions, only 1 restart control action would be executed and not two.

Step 4 - Define Alert Actions

You assign actions to an alert definition on the Alert Definition page, which appears when you save a new alert definition or edit an existing alert definition.

The Alert Definition page is similar to the New Alert page, with the addition of Edit controls in the "Alert Properties" and "Condition Set" sections, and tabs at the bottom of the page for defining alert actions.

You can specify multiple actions to be performed automatically when an alert fires. The types of actions available in the Alert Definition page vary based on: (1) the type of resource the alert applies to, (2) your version of Hyperic, and (3) whether you've configured Hyperic for the types of actions that must be enabled before you can use them, such as escalations, OpenNMS trap actions, and in vCenter Hyperic, SNMP notifications.

To define an alert action, select one of the tabs and supply the required information:

**Escalation**

Select an escalation from the "Escalation Scheme" dropdown menu; the tab refreshes and shows the escalation steps. You must define an escalation before you can assign it to an alert definition. Using an escalation that is configured to repeat until the alert is fixed is a good way to prevent redundant alerts firing for the same problem. To create an escalation, click Escalation Schemes Configuration on the Administration tab.

**Control Action**

You can define a resource control action for Hyperic to perform when the alert fires. The control action can target the current resource (the one to which the alert definition is assigned) or a different resource on the same platform, as long as the resource type has Hyperic-supported control actions. To configure a control action for the alert, select the Control Action tab and click Edit. Follow the instructions on the associated help page. You can only assign a single control action to an alert definition. **Note:** You cannot assign a control action to a resource type alert.
Notify Roles

You can specify one or more roles as notification recipients. Hyperic users with a role you specify will be notified when an alert is fired. Click Add to List on the Notify Roles tab. On the roles selection page, choose the role(s) to be notified when the alert fires.

Notify HQ Users

Click Add to List on this tab to specify one or more Hyperic users as notification recipients. On the user selection page, choose the users to be notified when the alert fires. The help page has instructions.

Notify Other Recipients

Click Add to List on this tab to specify non-Hyperic user email recipients for alert notifications. The help page has instructions.

Script

To assign a script action to the alert definition, click the Script tab, enter the full path to the script, and click Set. Hyperic will run the script when the alert fires. Scripts can reference alert-related Hyperic environment variables to perform custom notification logic.

Script actions are synchronous

Script actions execute one at a time. Until a script action completes, additional alerts will not fire on the resource.

OpenNMS

If Hyperic Server is configured for OpenNMS integration, you can use this tab to configure Hyperic to send an SNMP trap to OpenNMS when the alert fires. The notification will be generated by opennms_notify.gsp alert notification template.

To configure an OpenNMS trap action, enter:

a. **Server** - Listen address for the OpenNMS server
b. **Port** for the OpenNMS server.

SNMP Notification

If the Hyperic Server is configured to send SNMP notifications to your NMS, you can use this tab to configure a trap notification action. See SNMP Server Configuration Properties for more information.

The notification sent when the alert fires will contain three variable bindings:

- **sysUptimeOID.0** - No configuration is required for this binding.
- **snmpTrapOID.0** - This binding is configured on the HQ Server settings page.
A variable binding for the alert data specified in the `snmp_trap.gsp` alert notification template - the alert definition name and the "short reason" for firing. Note that Alert templates may be customized.

**Including more variable bindings in SNMP messages**

For richer capability, you can configure a SNMP notification as a step in an escalation. An SNMP notification in an escalation can be configured with additional variable bindings.

To configure an SNMP notification action enter:

1. **IP Address** - the address and port of the target NMS.
2. **OID** - The OID of the notification to send, which will contain the alert details specified in the `snmp_trap.gsp` template.
3. **Notification Mechanism** - The type of SNMP notification to send:
   - v1 Trap
   - v2c Trap
   - Inform

**ui-Admin.Monitor.MetricTemplate**

Metric collection settings for a resource type are configured on the **Monitoring Defaults** page for the resource type.

**Template Changes Vs. Custom Configurations**

Note that an authorized user can tailor metric collection settings on a per resource basis (on the resource's Metric Data minitab in the Resource Hub.) When you save changes to the metric collection settings for a resource type on the **Monitoring Defaults** page, the settings you configure will apply to all resources of that type in inventory. So, any custom metric collection configuration for resources of that type will be overwritten.

Note however, that if a user has chosen a different set of indicator metrics for a resource instance (on the resource's Indicators minitab in the Resource Hub) changing the indicator metrics for a resource type on the **Monitoring Defaults** page will not override the user's selections.

**Navigate to the Monitoring Defaults Page for a Resource Type**

1. Click the **Administration** tab.
2. Click **Monitoring Defaults** in the "HQ Server Settings" section of the **Administration** tab.
3. Scroll to the desired resource type on the **Monitoring Defaults** page, and click **Edit Metric Template** in that row.
Enable Collection of a Metric

- To enable the collection of a metric, follow the directions in Change a Metric Collection Interval. Collection of the metric is now enabled by default with the specified collection interval on every resource of this type.

Disable Collection of a Metric

- To disable the collection of a metric, check the metric name at the left and click Disable Collection at the bottom of the page.

Change a Metric Collection Interval

1. Check the metric name at the left.
2. In Collection Interval for Selected at the bottom of the page, enter a time value and select a unit of time measure for the collection interval.
3. Click the Collection Interval for Selected control at the bottom of the Monitoring Defaults page.

Set Indicator Metrics

To select the indicator metrics for a resource type (indicator metrics are the metrics that are charted on a resource's Indicators minitab in the Resource Hub) check the metric name at the left for each metric you wish to be an indicator, and click the Set Selected Metrics as Indicators control at the bottom of the Monitoring Defaults page.

The metrics you configure will be the default indicators for the resource type.

Changes to indicator metrics apply to existing resources but only for users that have not explicitly changed the default indicator page on the resources (of the specified type). If a user has changed the default indicator page for a resource, that will not be overwritten with changes made here.

APIs for Metric Collection Settings

As an alternative to the updating metric collection settings from the Hyperic user interface, you can use Hyperic APIs to perform updates from the command line or from scripts to perform bulk updates:

- HQApi metric command - for listing and updating metric collection settings for an individual resource.
- HQApi metricTemplate command - for listing and updating metric collection settings for an all instances of a resource type.

For general information, see vCenter Hyperic Web Services API.
ui-Administration.Plug-in.Manager

Plug-in Manager is a user interface for deployment-wide management of product plug-ins; it displays all plug-ins deployed to the Hyperic Server, and a summary of agent deployment status for the plug-in. You can use Plug-in Manager to deploy new or updated plug-ins and to remove plug-ins from Hyperic Agents.

Plug-in Manager can only administer plug-ins on agents that are the same or later version than the Hyperic Server.

View the Plug-in Manager Page

1. Click the Administration tab in the Hyperic user interface.
2. Click Plug-in Manager in the "HQ Server Settings" section of the Administration tab.

Plug-in synchronization must be enabled.
The Plug-in Manager displays a warning if plug-in synchronization is currently disabled. To re-enable synchronization set server.plug-insync.enabled in ServerHome/conf/hq-server.conf file to "true" and restart the server.

Contents of the Plug-in Manager Page

The Plug-in Manager page lists all of the resource plug-ins deployed to the server and their deployment status on all up-to-date Hyperic Agents reporting to the Hyperic Server. You can use the Plug-in Manager to add and remove plug-ins from up-to-date Hyperic Agents.

In the upper right corner of the Plug-in Manager page, a message indicates how many of the agents reporting to the server support the Server Agent Plug-in Synchronization (SAPS) feature, and the total number of agents reporting to the server.

If there are agents that do not support SAPS, the message is a link.

The following information is listed for each plug-in:

- **Plug-in** — The name of the plug-in.
  - If the 📦 icon is present, the plug-in is a system plug-in that other plug-ins depend upon — you cannot change or remove these plug-ins.
  - If the 🔗 icon is present, the plug-in is a custom plug-in.

See a "File Not Found" warning?
The message "File Not Found" in this column indicates that the plug-in file or archive has been manually removed from the Hyperic Server's hq-plug-ins directory. The best practice is to remove plug-ins using the Plug-in Manager, which removes the resources managed by the plug-in being removed, as well as the plug-in itself. To remove the resources that were defined by the plug-in, checkmark the plug-in, and click Remove Selected Plug-in(s).
• **Version** — The version of Hyperic Server in which the plug-in was distributed.
• **File Name** — The name of the archive or file that contains the plug-in.
• **Added Time** — When the plug-in was first deployed to the Hyperic Server.
• **Updated Time** — When the plug-in was most recently redeployed to the Hyperic Server.

• **Agent Sync Status** — Summarizes the deployment status of the plug-in on up-to-date agents reporting to the server. Deployment status may be:
  • If this icon is present, the value next to it indicates the number of agents to which the plug-in is deployed.
  • If this icon is present, the value next to it indicates the number of agents on which deployment has been initiated and is still in progress.
  • If this icon is present, the value next to it indicates the number of agents on which deployment failed.

**Determine Why an Agent is not Synchronizing**

If one or more agents reporting to the Hyperic Server are not synchronizing plugs with the server, click the link in the upper right of the **Plug-in Manager** page that says how many agents are synchronizing.

The **Out-of-date installed Agents** popup lists the name and version of each agent that is reporting to the Hyperic Server but not synchronizing plug-ins.

There are two main reasons an agent might not sync with the server:

The Hyperic Agent is an older version than the Hyperic Server. SAPS is only supported for up-to-date Hyperic Agents — that is, agents that are the same or later version than the Hyperic Server. Agents that are out of date will be listed in the first table on the **Out-of-date installed Agents** popup. To solve the problem, upgrade the agent.

The Hyperic Agent is up to date, but not Available in Hyperic, for instance because agent startup is incomplete or failed. Up-to-date agents that are not synchronizing plugs with the agent are listed in the second table on the **Out-of-date installed Agents** popup. If an agent remains on this list for more than a few minutes, restart it.

**View Agent Sync Detail for a Plug-in**

If plug-in deployment is in progress or failed for one or more agents, the **Agent Sync Status** is a link — click it to view the **Agent Status** page, which lists the agents upon which deployment is in progress or failed, and the status of each.

**Troubleshoot Failed Plug-in Deployment**

If deployment of a plug-in to a Hyperic Agent fails, check the Hyperic Server's log file (ServerHome/logs/server.log) for this message:

agent=id=<id>, address=<addr>, port=<port> has checked in the exact same plug-in set twice in a row. To avoid any potential issues on the agent which may cause it to continuously restart the Server will
Upload a Plug-in

When you upload a plug-in with the **Plug-in Manager**, the plug-in is deployed to custom plug-in directory on the Hyperic Server and on each up-to-date agent reporting to the server. Each agent to which the plug-in is deployed is automatically restarted.

You can only upload plug-ins that are 5 MB or less in size, and comply with plug-in naming conventions.

**To upload a new plug-in, or a new version of a plug-in:**

1. Click **Add/Update Plug-in** on the Plug-in Manager page.
2. Click **Browse** to browse the file system for the plug-in .jar or .xml file.
   - You can only upload files of these types that are less than five megabytes in size.
3. Click **Upload**.
   - The **Agent Sync Status** column for the plug-in shows the number of agents on which deployment is in-progress, complete, or failed.

Remove Plug-ins

When you remove a plug-in with the **Plug-in Manager**, the plug-in is removed from its plug-in directory on the Hyperic Server, and all resources that were defined and managed by the plug-in are removed from inventory. The plug-in is removed from the plug-in directory of each up-to-date agent reporting to the server. Each agent from which the plug-in was removed is automatically restarted.

**To remove a one or more plug-ins:**

1. On the **Plug-in Manager** page, place a checkmark next to each plug-in you wish to remove.
2. Click **Remove Selected Plug-in(s)**
   - The **Confirm Remove** page lists the number of resources in inventory managed by the plug-in. If there are no resources managed by the plug-in, no resource count is shown.
3. Click **Remove** to remove the plug-in and all resources managed by the plug-in.
   - The string "disabled" appears in red next to the removed plug-in’s name on the **Plug-in Manager** page.
   - The **Agent Sync Status** column for the plug-in shows the number of agents on which undeployment is in-progress, complete, or failed.
ui-Administration.Plug-in.Manager.Troubleshooting

The **Out-of-date installed Agents** popup lists the name and version of each agent that is reporting to the Hyperic Server but not synchronizing plug-ins.

There are two main reasons an agent might not sync with the server:

- The Hyperic Agent is an older version than the Hyperic Server. SAPS is only supported for up-to-date Hyperic Agents —— that is, agents that are the same or later version than the Hyperic Server. Agents that are out of date will be listed in the first table on the **Out-of-date installed Agents** popup. To solve the problem, upgrade the agent.
- The Hyperic Agent is up to date, but not Available in Hyperic, for instance because agent startup is incomplete or failed. Up-to-date agents that are not synchronizing plugs with the agent are listed in the second table on the **Out-of-date installed Agents** popup. If an agent remains on this list for more than a few minutes, restart it.
ui-Resources

Resources Browse

Click Browse on the Resources tab in the masthead to display the Browse page.

The Browse page lists all or a subset of your managed resources of a selected inventory level. The default List View lists key property values and the current availability of each resource of the selected inventory level. Chart View charts the indicator metrics for each resource.

The controls on the Browse page allow you to navigate to resource of interest and manage your resource inventory.

Filter the Resource List

1. Click an inventory type to display resources of that type:
   - Platforms
   - Servers
   - Services
   - Compatible Groups/Clusters
   - Mixed Groups
   - Applications

2. Specify one or more filter criteria:
   - **Name** - Type part or all of the resource's name in Search. The search is case-insensitive.
   - **Resource Type** - Filter the list by resource type by selecting a type from the pull-down list.
   - **Availability** - Limit the list to unavailable resources by clicking Unavailable (not supported for Compatible Groups/Clusters or Mixed Groups).
   - **Owner** - Limit the list to resources owned by the user you are logged in as by checking Owned by.
   - **match criteria** - Click Any or All to list resources that meet all of the criteria, or those that meet any of the criteria, respectively.

3. Click to run the search.

Navigation and View Options

Switch Between Chart and List View

- To view indicator metric charts for each resource, click Show Chart View in the upper right corner of the page.
- To switch back to List View, click Show List View.
Navigate to a Resource

From either List View or Chart View, click the name of a resource to display its Monitor page.

From List View, click the M, I, or A icon next to the resource name to navigate to its Monitor, Inventory, or Alert page. If an icon does not appear for a resource, the associated page is not available for that resource type. For instance, there is no Monitor page for a Mixed Group.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>M</td>
<td>&quot;Monitor&quot; page</td>
</tr>
<tr>
<td>I</td>
<td>Inventory page (for a platform, server, service, group, application)</td>
</tr>
<tr>
<td>A</td>
<td>&quot;Alert&quot; page</td>
</tr>
<tr>
<td></td>
<td>Indicates this feature is not available due to permissions.</td>
</tr>
</tbody>
</table>

About Breadcrumb Links

The breadcrumbs on resource pages in the Hyperic user interface ease the process of navigating among related resources and backtracking to previously viewed resources.

The breadcrumbs on a resource page reflect where the resource fits in a resource hierarchy. Breadcrumbs correspond to steps you took (resources you selected) to navigate down a resource hierarchy. For example, if you navigate to a service, starting at the top of the hosting hierarchy - by browsing to a platform and drilling down - the breadcrumbs are links to the platform and server you visited along the way:

Browse > PlatformName > ServerName > ServiceName

When you navigate to a resource that is outside the currently resource hierarchy, the breadcrumb trail is purged. For example, if you drill down to a service, as described above, and then navigate to an application that the service belongs to (from the service’s Inventory page) the breadcrumbs are purged and the application is your new starting point. Note that, when you jump outside the current hosting hierarchy, a link to the previously viewed resource appears - so you can get back to it easily, if you wish. For example

Browse > ApplicationName
Return to ServiceName

Clicking Browse in the breadcrumb trail opens the Browse page for the inventory level (platform, server, or service) most recently browsed.

The Platforms link opens the Browse page for all platforms; the Linux link opens the Browse page for platforms whose resource type is "Linux".
Create a Platform

Click New Platform in the Tools menu and proceed to the "New Platform" page.

Note: The only types of platforms you can create are non-discoverable platforms, such as network devices or virtual hosts. Operating system platforms are auto-discovered by the Hyperic Agent, and cannot be manually created.

Create an Application

Click New Application in the Tools Menu and proceed to the "New Application" page.

Create a New Group

To create a new group, click New Group in the Tools Menu and proceed to the "New Group" page.

Note: To create a group that contains one or more of the resources listed the Browse page, see the next section below.

Select and Add Platforms, Servers, or Services to a New or Existing Group

When the Browse page lists platforms, servers, or services, you can select one or more resource instances and add them to a new or an existing group.

1. Click Platforms, Servers, or Services to list resources of that inventory type.
2. Filter the list as desired.
3. Checkmark desired resources and click Group.
   - The Group Manager popup lists any existing groups to which you can add the selected resources. The existing groups that appear take into account these facts about the resource instances you have selected:
     - Current membership in a group - Any group to which any of the currently selected resources is a member will not appear on the list. Any group to which one of the selected resources is already assigned is excluded from the
     - Types of the selected resources - If the selected resources are not all of the same type (for example, both "Linux" and "Win32" platforms are selected”, only mixed groups appear in the list. If the currently selected resources are all the same type (for example "Linux”) the list of groups will include any existing compatible groups for that type.
4. You can add selected resources to existing group or create a new group:
   - To add the selected resources to an existing group, select the desired group and click Add to Existing Group.
   - To add the selected to new group, click Add to new Group, and follow the instructions in help for the New Group page.
Create a New Group of Groups

When the Browse page lists groups, you can select one or more resource instances and add them to a new group.

**Note:** You cannot add groups to an existing group from the Browse page. Instead, navigate the group to which you wish to add a group, and click **Add to List**.

1. Click **Mixed Groups** or **Compatible Groups/Clusters**.
2. Filter the list as desired.
3. Checkmark desired groups and click **Group** to display the New Group page.
4. Follow the instructions in help for the **New Group** page.

Delete a Resource

To delete a resource from the Hyperic inventory, checkmark the resource and click .

The resource is permanently removed from the Hyperic inventory, and therefore cannot be monitored or controlled.

Resource deletion is asynchronous.

Resources you delete will disappear from the resource list immediately. Removal of the resources from the Hyperic database occurs asynchronously; there may be a slight delay before resources are removed from the database. If you restart agent prior to the resource is removed from the database, errors might occur if you re-add the resource to memory after the agent rediscovers it.

Do not try to re-import a platform immediately after deleting it - this may fail. Note also that until the delete process running in background completes, a deleted platform will still appear in the HQ Health page's Agent tab. Similarly, the Hyperic license count displayed in the web user interface will not be decremented until the delete process is completed.

Enable or Disable Alert Definitions

The Resource > Browse page allows you to enable or disable all alerts for one or more resources.

Select the desired resources, and click **Enable All Alerts** or **Disable All Alerts**.
ui-Monitor

ui-Monitor.CurrentHealth

The **Indicators** minitab contains a chart for each indicator metric for the currently selected resource.

**Availability Bar and Time Slices**

The bars across the top and bottom of the tab — labeled "D" and "G" in the screenshot in the Overview of Indicators minitab section — contain grey dots, each of which corresponds to a time slice. The length of the time slices depends upon the currently selected **Metric Display Range** — if the display range is 8 hours, each time slice is 8 minutes. If the display range is 4 hours, each time slice is 4 minutes. The color of the dot for a time slice indicates the availability of the resource during that time slice. If the time slice is longer than the collection interval for the metric, the availability shown for the time slice is based on the multiple data points collected during the time slice.

- **Green** — indicates 100% availability during time slice — each time that availability was reported during the interval, the resource was available.
- **Orange** — indicates availability greater than 0% and less than 100% — during the interval, the availability of the resource was reported to be unavailable data point during the interval was the resource was available.
- **Red** — indicates 0% availability during time slice — each time that availability was reported during the interval, the resource was not available.

The average availability over the display range is shown to the right of the availability bar.

Click an availability indicator to display the start time of

**Metric Charts in the Indicators Minitab**

The **Indicators** page displays a chart of each of the resource's indicator metrics. (This portion of the page is labeled "E") in the screenshot in the Overview of Indicators minitab section ---The values labeled **LOW**, **AVG**, and **PEAK** are the lowest, average, and highest values collected during the metric display range.

The indicators are displayed as column charts: the area of each column indicates the value range (the high and low values) of the metric. The average value of the metric is indicated by the cross in the column. The charts are stacked vertically so that their X-axis (time) values line up. This works in conjunction with the vertical highlight from the availability and timeline bars to analyze the metric data across multiple metrics for a specific time. This is useful when trying to diagnose a problem at a specific time by correlating relevant metric values. Arrangements of charts for selected metrics can be saved as a "view" so that users can easily always compare the same metric data and therefore understand the interaction between different resources.

- To change the display order of the charts, click the up and down arrow controls at the upper-right-hand corner of each chart.
- To remove a chart from display, click the red X icon at the upper-right-hand corner of the chart.
- To save the set of displayed charts and their order, either
  - Update the current view: Select "Update <current-view name>" in View and click the icon.
  - Create a new view: Select "Create New View" in View, type a view name, and click the icon.
- To delete the current view: Select "Delete View" in View and click icon.png!
- To display another view: Select "Go to View" in View and select one of the views.

**Event Icons and Popups**

A purple circular icon over a time slice in the bar at the bottom of the **Indicators** pane indicates an event was logged occurred during that time slice. Click an event icon to display details in a popup.
Metric Chart

To chart metrics:

1. Navigate to the resource for which you wish to chart metrics.
2. In the Resources tab, check the resources of interest.
3. Toggle the Problem Metrics/All Metrics control as desired, and click the View Metrics button.
4. Place your cursor over the callout icon for the metric you wish to chart, and select the View Full Chart option.
Charts vary depending on how many resources and metrics you plot.

To graph different kinds of data for a metric:

In the chart legend, check or uncheck the desired kinds of data (described below) and click the Redraw button. The chart will be refreshed to reflect the new selections.

To change the display range:

At the bottom right of the "Metric Chart" section, either:

- To move forward or back eight hours, click ► or ◄, respectively. The new display range is indicated.
- For a specific date/time range:
  a. Click Edit Range.
  b. For a range counting back from the current time: Select a length of time.
  c. For a date/time range: Select a date/time range.
  d. Click Redraw
     The metric charts on the screen automatically refresh to reflect the new display range. This display range value applies to all resource-monitoring screens.

To save the chart to the Dashboard:

At the top of the page, click Save Chart to My Dashboard, to add the chart to the "Saved Charts" portlet in the dashboard.

If you have edit permissions for multiple dashboards, the Tools menu will instead have an Save Chart to Dashboards option. Select the option to view a list of dashboards for which you have edit permissions. You can select one or more dashboards, and click Add to add the chart to those dashboards.

To save the chart in CSV format:

At the top of the page, click Export to CSV.
For Single Resources

To change the baseline or acceptable range of values for the charted metric:

1. In "Metric Baseline & Expected Range," click **Change Value** next to the Baseline, High Range, or Low Range.
2. Either leave the displayed calculated value or enter another value.
   Enter the unit of measure appropriate for the selected metric. For example, % for the Availability metric or MB for the Free Memory metric.
   If specifying both high and low values, the low must be lower than the high.
3. Click **Save Value**.
   HQ automatically checks "Baseline," "High Range," or "Low Range" (depending on what was changed) in the chart legend and refreshes the chart with those values.

Sections on This Screen

**Metric Chart**

The chart legend allows users to select types of data to include in the chart:

- **Actual**: The observed metric value at any point in time
- **Peak**: The highest observed metric value (this will be a horizontal line)
- **Average**: The average of observed metric values across the entire graph (this will be a horizontal line)
- **Low**: The lowest observed metric value (this will be a horizontal line)
- **Low Range**: The user-specific lowest acceptable metric value (this will be a horizontal line)
- **High Range**: The user-specific highest acceptable metric value (this will be a horizontal line)
- **Baseline**: The HQ- or user-set baseline value (this will be a horizontal line)
- **Control Actions**: Indicates on the chart when control actions were performed on the resource (to help correlate the actions with changes in performance)

**Participating Resource**

This section lists the resource and its metrics or the resources (in the case of charting a group) that are plotted in the chart. Users can change the individual resource's metrics or the set of group member resources that are included in the chart.
**Metric Baseline and Expected Range**

This section allows the user to view and change the values current calculated or set for the metric baseline and the acceptable range of metric values (outside of which observed metric values will be considered "out-of-bounds" (or "OOB")). This section is available only when a single metric is charted.

**Reading a Chart**

The Y-axis represents the metric value; the X-axis, time. Each column represents a 1/60 time slice of the selected metric display range. A chart can plot a maximum of 60 points.

The chart displays:

- The average, peak, and low observed values for the metric for the slice of time along the X-axis
- If available, the established baseline, high range (highest acceptable), and low range (lowest acceptable) values

Each column displays:

- The observed metric value for that slice of time. For dynamic metrics, this can be an average. See details below.
- (In the case where the plotted point is an average) The range (represented by an I bar) of metric values collected in that slice of time

**Time Slices**

The charts are divided into a maximum of 60 slices, where each slice represents the same amount of time, over any display range the user chooses. Here are a few examples to help explicate the use of time slices:

- If the metric a user is viewing has a collection interval of 5 minutes and the selected display range is an hour long (making 12 observed metric values), then the chart will contain only 12 time slices, and each slice will represent a single observed metric value.
- If the selected display range is 5 hours long (making 12 collections per hour x 5 hours = 60 observed metric values), then the chart will display 60 time slices, and each slice will represent a single observed metric value.
- If the selected display range is 10 hours long (making 12 collections per hour x 10 hours = 120 observed metric values), then the chart will still display its maximum of 60 time slices, but each time slice represents an average of the two observed metric values leading up to the (slice of) time.
**Display of Dynamic Data vs. Static Data**

For static metrics, the plotted point represents a single metric value at one moment in time. For dynamic metrics, a point on the chart represents the average of the metric values observed over the period of time that ended at the specific time (X-axis value). How long is that period of time over which the value was averaged? That depends on the display range. For a display range of eight hours, each charted point represents the average of the preceding eight-minute period (8 hours / 60 time slices along the X-axis = 8 minutes). If the metric is collected every 60 seconds, and the chart’s display range is 60 minutes, each of the 60 plotted points on the graph represents the single, observed value for the metric at a single point in time.

**Display of Cumulative Data**

The values for data that is cumulative (trending up or down) — such as bytes served, uptime, minimum response time, number of transactions — are not averaged. A point charted for this kind of data shows the maximum (or minimum) value for the time slice.


**Metric Data Minitab**

The **Metric Data** minitab, available when an individual resource, or a group of resources of the same type are selected, is a tabular summary of the measurements collected during the currently selected metric display range.

By default, the **Metric Data** minitab displays only metrics for which measurements exist during the metric display range. To list all metrics supported for the resource, click the control next to **Show All Metrics** at the top of the **Metric Data** minitab.

When all supported metrics for a resource are listed, a **Hide Metrics Without Data** control replaces the **Show All Metrics** control - click the the control next to it to toggle the display.

The columns in the **Metric Data** minitab vary, depending on whether an individual resource or a group of resources is selected, as described in the subsections below.

**Metric Data Minitab for a Single Resource**

The **Metric Data** minitab displays the following data for each metric that is enabled for one or more members of a compatible, over the current metric display range:

- **Alerts** — Number of times a collected metric value triggered an alert.
- **OOB** — Number of times the metric was out-of-bounds.
- **LOW** — Lowest value collected.
- **AVG** — Average of values collected.
- **PEAK** — Highest value collected.
- **LAST** — Last collected value.
- **Collection Interval** — Frequency of metric collection. "NONE" indicates that data is not being collected.
Metric Data Minitab for an Autogroup or Compatible Group

The Metric Data minitab displays the following data for each metric that is enabled for one or more members of a group of resources of the same type — an autogroup or a compatible group.

- **Number Coll** — Number of data points collected across all group members for which the metric is enabled.
- **Alerts** — Number of times a collected metric value triggered an alert.
- **OOB** — Number of times the metric was out-of-bounds across all group members.
- **LOW** — Lowest value collected across all group members.
- **AVG** — Average of values collected across all group members.
- **PEAK** — Highest value collected across all group members.
- **SUM** — Sum of all values collected, not for a metric whose unit is percentage.
- **Collection Interval** — Frequency of metric collection. "NONE" — indicates that data is not being collected. "VARIES" — Indicates that the collection interval varies among members of the group.
- **Member health data** — (For compatible groups only, not autogroups) The lower portion of the Metric Data minitab for a compatible group lists the resources in the group, the current availability of each, and in the rightmost column an icon that links to the Alerts page for the resource.

Compare Metrics for Resources in a Compatible Group

Check the member resources in "Current Health of group's <group name> resources collecting metrics" and click Compare Metrics of Selected at the bottom of the page and proceed to the "Compare Metrics" screen.

View Metric Details and Metadata

To display metric data for a single resource in a separate window, click the log at the right end of metric data for the resource.

Set Page Refresh Frequency

To change the frequency with which the page refreshes, click a refresh value or OFF, in the Metric Refresh section in the upper right of the minitab.
Tailor Metric Collection Settings for the Resource

You can tailor the metric collection settings for the resource on the **Metric Data** minitab.

**Resource-Level Metric Collection Settings can Be Overwritten**
The default metric collection settings for a resource are specified on the **Administration > Monitoring Defaults** page for the associated resource type. You can alter the metric collection interval for a specific resource on its **Metric Data** minitab — note however that subsequent updates to the monitoring defaults for the resource type will overwrite any modifications to collection intervals made for a specific resource. For information about setting metric collection options for all resources of the same resource type, see the **Tailor Metric Collection for a Resource Type** page of vCenter Hyperic Administration.

**Modifying Metric Collection for a Group**
Changes to make to metric collection settings for a group will apply to all members of that group.

**Disable Collection of a Metric**
1. Place a checkmark next to each metric you wish to disable.
2. Click **Disable Collection** at the bottom of the minitab.
   
   *Note*: If the currently selected resource is a compatible group, collection of the metric is disabled for all resources in the group.

**Enable Collection of a Metric**
1. Click the arrow to the right of **Show All Metrics** at the top of the minitab.
   
   All metrics, including currently disabled metrics, will be listed.
2. Place a checkmark next to each metric you wish to enable.
3. To specify the frequency of metric collection:
   a. Enter an integer value in the **Collection Interval for Selected** field.
   b. Select "Minutes" or "Hours" from the pull-down list.
   c. Click the arrow to the right of the "Minutes/Hours" pull-down list.
   
   *Note*: If the currently selected resource is a compatible group, collection of the metric is enabled for all resources in the group.

**Set Collection Interval for a Metric**
1. If the Metric Data minitab currently display all metrics for the resource, including disabled metrics, click **Hide Metrics Without Data**.
2. Place a checkmark next to the metric whose collection interval you wish to modify.
   
   You can checkmark more than one metric if you want to set the same collection interval for each of them.
3. To specify the frequency of metric collection:
   a. Enter an integer value in the **Collection Interval for Selected** field.
   b. Select "Minutes" or "Hours" from the pull-down list.
   c. Click the arrow to the right of the "Minutes/Hours" pull-down list.

Configure Metric Baselines

You can use the **Set Baselines** control at the bottom of the **Metric Data** minitab to reset the baseline, acceptable high, and acceptable low values for a metric.

**ui-Monitor.Group.Compare**

**Compare Metrics for Resources in a Compatible Group**

**Select Metrics to Compare**

1. Navigate to a compatible group.
   The **Monitor** tab for the group appears, with the **Indicators** minitab active.
2. Click the **Metric Data** minitab to toggle the view to a tabular view of metrics for the group.
3. In the **Current Health of...** section in the lower portion of the **Metric Data** minitab, checkmark each resource in the group whose metrics you wish to compare.
4. Click **Compare Members of Selected**.
   The **Compare Metrics** page appears.

**Contents of the Compare Groups Page**

The **Compare Metrics** page lists the metrics collected for selected resources, organized by metric category, metric, and resource. If a metric was not collected for a resource during the current metric display range, the resource does not appear in the section for that metric. The following data is displayed for each resource that does have metric data during the interval:

- **LOW** — The lowest observed metric value.
- **AVG** — The average of the observed metric values.
- **PEAK** — The highest observed metric value.
- **LAST** — The last observed metric value.

The **Compare Metrics** page does not automatically refresh. Click the **Get Current Values** control at the bottom of the page to refresh the display.

**Metrics with "--" Low, Avg, and Peak Values**

Hyperic displays dashes for the **Low**, **Avg**, and **Peak** values of a metric whose value type is "Trends Up" — that is, a metric like "Bytes Served" whose value only increases over time. For "Trends Up" metrics, a cumulative value is shown in the **LAST** column.
Extrapolating Metrics for a Group

This page allows you to predict future values of a metric for the members of group based on historical metrics.

The Metric Data Extrapolation plug-in is available on the Views tab when a group is selected. Although this function is available for any group, whether compatible or mixed, metric projections are most meaningful for compatible groups.

The extrapolation method is a simple linear regression using the Apache Commons Math package. The historical metric data for a group is used to calculate a slope, which is used to predict future values.

To extrapolate a metric for members of a group:

1. Navigate to compatible group of interest.
2. Choose the Metric Data Extrapolation option from the Views tab.
3. Select from the following:
   a. Metric to extrapolate. By default, Availability is selected. If desired, choose another metric.
   b. Known Data Range. The volume of history upon which the extrapolation will be based. You can select values ranging from 1 day to 1 year. Typically, a longer data range yields a better extrapolation. In some cases, however, it might be better to select the data range based on the timing of environment-related events, such as a new release or infrastructure change.
   c. Projection Range. The total duration included in the trend analysis, including the Known Data Range and the Projection Range. The range you select determines, but is not equal to, how far into the future the metric will be projected.
   d. Threshold value for the metric. Charts will display a horizontal line at the metric value you enter.
4. Click Update to plot the extrapolated values for the selected metric for each member of the Group. Historical values are plotted in blue.

Understanding Extrapolation Charts

Each chart has the same scale, to better show differences between the resources, and ease analysis. This is different from other HQ charts which are scaled independently. The heading for each chart shows:

- The resource name and metric charted
- The units of the metric charted
- Extrapolation confidence; values can be 'Excellent', 'Good', 'Average', 'Questionable', or 'Poor'.
- Extrapolated values are represented by the orange triangle that appears between "now" and the end of the projection range on the timeline.
Using JMX MBean Query

The JMX MBean Query tool allows you to search for MBeans, display their attributes, and invoke selected MBean operations on them.

When HQ alerts you of availability or health issues with a JVM resource or service, you can use the JMX MBean Query tool to troubleshoot and resolve the problem.

The MBean attributes displayed in the JMX MBean Query tool are read-only; the console does not support attribute editing. In this version of HQ, support for MBean operations is limited to operations with one or no arguments of primitive or simple type.

The JMX MBean Query tool is available on the Views tab when you have a JVM selected in the HQ portal. These instructions assume that your JVM is in HQ inventory.

Note that JVMs are not auto-discovered by HQ. You must add a JVM to HQ inventory and configure for monitoring.

Entering Query Options

To access specific MBean attributes and operations, you enter search patterns in the theses text boxes in the JMX MBean Query tool page:

- **Object Name Pattern** - To specify the MBean or MBeans of interest, enter a valid MBean object name pattern.
- **Attribute Regex Filter** - To restrict the attributes returned, enter a valid Java regular expression.
- **Operation Regex Filter** - To restrict the MBean operations returned, enter a valid Java regular expression.

Click the **Query MBeans** button to execute the search.

For MBeans whose object name matches the Object Name Pattern, attributes and operations that match your filter criteria will be listed.

Enabling Automatic Refresh

If you wish the console to periodically refresh the attribute values, select an interval from the **Refresh Interval** dropdown menu.
Defining Saved MBean Searches

If you expect to perform the same search frequently, you can create an XML file that specifies the search criteria. You name the file according to a predefined convention, and store it in a specific directory in your HQ Server installation. Each saved search will appear in the MBean Query page’s Preset Searches menu.

When you run a saved search, the values you defined for the search Object Name Pattern, Attribute Regex Filter, and Operation Regex Filter appear in the text boxes at the top of the view.

Create a saved search in accordance with the schema described below in [Schema for JMX Search Criteria], and save it with a name like this:

`SearchID-filter.xml`

where `SearchID` is a meaningful name for the search to which you append "-filter.xml" identifies the search

The filters values defined in this file will then appear in the Preset Searches drop-down menu and will be named according to the filter ID. Save the file in:

`ServerHome/hq-engine/hq-server/webapps/ROOT/hqu/jmx/conf`

The following topics define the XML schema for saved MBean searches.

Schema for JMX Search Criteria

A saved MBean search criteria consists of:

- A top-level `filters` element, containing at least one `filter` sub-element. Each filter sub-element consists of:
  - An `id` attribute containing an identifier for the search. This string will appear in the Preset Searches drop-down menu. Each search you define and save on an HQ server must have a unique `d` attribute.
  - An `objectName` sub-element, whose value is the object name pattern used for the MBean query.
  - An `attributeRegex` subelement, whose value is the Java regular expression used to filter the attributes returned from the MBean query.
  - An `operationRegex` subelement, whose value is the Java regular expression used to filter the operations returned from the MBean query.

For example:
Edit Display Range

The metric display range specifies the time range Hyperic HQ considers for displaying the metric data. There is one universal display range value stored for each user. When you change the display range, it will affect both the data displayed in the monitoring pages and the charts.

The range can be defined as a specific time range (Within a Date Range option) or as a relative time range preceding the current time (Last option).

ui-Alert

ui-Alert.Script

Define a Script Action for an Alert

A script action allows you to access and use Hyperic environment variables that contain information about a fired alert. You can use the data in any fashion you wish, for instance in a web service call to external management system.

To use the script action feature, write a script that implements the action or logic you wish to perform with the alert-related environment variables. When you configure the alert, specify the script to be executed when the alert fires. The script is server-side only, meaning it must be accessible and executable by the same user running the HQ Server process.

Script actions can be defined for resource alerts and resource type alerts. In this version of Hyperic, escalation schemes do not support script actions.
**Script actions are synchronous**
Script actions execute one at a time. Until a script action completes, additional alerts will not fire on the resource.

**Script actions and memory**
Script actions are forked by the Hyperic Server’s Java process. Most operating systems duplicate the Java process's memory before executing the new process; exact behavior varies by operating system. If the operating system does not provide for over-committing memory, script execution requires an amount of free memory equal to the amount of memory that the Hyperic Server's Java process consumes — otherwise, the script action will not run.

**Environment Variables for Fired Alert Data**
The environment variables for fired alert data are prefixed with the string "HYPERIC_". The table below describes the variables.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>HYPERIC_ALERT_ALERT_TIME</td>
<td>The time at which the alert fired, in milliseconds from epoch.</td>
<td>1219167000000</td>
</tr>
<tr>
<td>HYPERIC_ALERT_CONDITION</td>
<td>The condition that caused the alert to fire. Note: This environment variable is supported only on Unix-based platforms. The value contains the Java \n character, which causes errors under Windows. In Windows environments, use the HYPERIC_ALERT_SUMMARY variable, which provides the same information without the \n character.</td>
<td>If Load Average 5 Minutes &gt; 1.0 (actual value = 1.4)</td>
</tr>
<tr>
<td>HYPERIC_ALERT_DESCRIPTION</td>
<td>The description of the alert that fired.</td>
<td>This alert will fire when the load rises</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
<td>Example Output</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HYPERIC_ALERT_ID</td>
<td>The internal Hyperic ID for the alert that fired.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The HYPERIC_ALERT_ID for an alert is not committed to the Hyperic database until all alert actions are complete. Therefore, an alert action script (whether it uses SQL or HQApi) cannot query or update the Hyperic database using the alert's HYPERIC_ALERT_ID, because that value will not yet exist in the Hyperic database.</td>
<td></td>
</tr>
<tr>
<td>HYPERIC_ALERT_NAME</td>
<td>The name of the alert that fired.</td>
<td>High Load</td>
</tr>
<tr>
<td>HYPERIC_ALERT_PRIORITY</td>
<td>The priority of the alert that fired, 1 for Low, 2 for Medium, 3 for High.</td>
<td>2</td>
</tr>
<tr>
<td>HYPERIC_ALERT_SUMMARY</td>
<td>A condensed data string that contains the relevant alert and resource names and values which triggered the alert.</td>
<td>Mac OS X DOWN The-Idea-Men Availability (0.0%)</td>
</tr>
<tr>
<td>HYPERIC_FIXED_ALERT_ID</td>
<td><strong>This variable was added in Hyperic 4.5.1.2.</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Valid for recovery alerts only. Supplies the internal Hyperic ID for the primary alert to which the recovery alert is assigned.</td>
<td></td>
</tr>
<tr>
<td>HYPERIC_FIXED_ALERT_NAME</td>
<td><strong>This variable was added in Hyperic 4.5.1.2.</strong></td>
<td>High Load</td>
</tr>
<tr>
<td></td>
<td>Valid for recovery alerts only. Supplies the name of the primary alert to which the recovery alert is assigned.</td>
<td></td>
</tr>
<tr>
<td>HYPERIC_PLATFORM_NAME</td>
<td>The platform on which this alert fired.</td>
<td>localhost.hyperic.com</td>
</tr>
<tr>
<td>HYPERIC_RECOVERY_ALERT</td>
<td>A boolean that indicates if the alert is a recovery alert.</td>
<td>false</td>
</tr>
<tr>
<td>HYPERIC_RESOURCE_ID</td>
<td>The internal ID for the resource for which the alert fired.</td>
<td></td>
</tr>
<tr>
<td>HYPERIC_RESOURCE_NAME</td>
<td>The name of the resource for which the alert fired.</td>
<td>localhost.hyperic.com</td>
</tr>
</tbody>
</table>
Example Script

The following script is an example of using the alert variables. The example script simply writes the time that the script executed and the variables to a log file; it is not a representative use case. The purpose of script actions is to enable more complex alert actions, and actions that meet the unique needs of your environment.

```perl
#!/usr/bin/perl
my $logfile = "~/tmp/output.txt";
my $date = localtime();
open LOGFILE, ">$logfile" or die "Cannot open log file for writing";
print LOGFILE "# Running script at $date", "\n";
foreach $key (sort keys(%ENV)) {
  if ($key =~ m/^HYPERIC/) {
    my $msg = "$key = $ENV{$key}";
    print LOGFILE $msg, "\n";
  }
}
close LOGFILE;
```

Assign the Script Action to an Alert

To assign a script action to an alert definition:

1. Select the alert definition.
2. Click the Script tab in the Alert Definition page.
3. Enter the full path to script and click Set.

ui-Alert.Edit

On the Alert Definition page, you can edit an alert definition's properties and condition set, and define and edit the alert actions HQ should perform when the alert fires.

The Alert Definition page, which appears when you save a new alert definition or edit an existing alert definition, is similar to the New Alert page, with the addition of Edit controls in the "Alert Properties" and "Condition Set" sections, and a set of tabs at the bottom of the page for Edit Alert Properties

Click Edit in "Alert Properties" section.

- **Name** — Name assigned by the user creating an alert definition. A fired alert is identified, in the Hyperic user interface and alert notifications, by the alert definition name and a timestamp. An alert definition name should clearly communicate the nature of the problem. For example, "Down" for an alert on availability, or "Low Memory" for an alert on free memory.
- **Description** — Description entered by the user creating the alert definition.
• **Priority** — The severity of the problem, as defined by the person creating the alert definition: "Low", "Medium", or "High". A consistent policy for defining an alert definition priority makes it easier to triage problems appropriately. An alert's priority is shown in Hyperic pages that present alert status and in alert notifications. You can sort alerts by priority in vCenter Hyperic's **Alert Center** or **Operations Center**.

• **Active** — The current enabled/disabled status of the alert definition. Alerts only fire for enabled alert definitions. When an alert definition is disabled, Hyperic does not evaluate its condition or fire alerts for it.

**Edit Alert Condition Set**

Click **Edit** in "Condition Set" section.

**Condition Set**

An alert condition specifies a resource metric value or event that will initiate the alert firing process.

The condition types you can choose when you define a alert vary by resource type and Hyperic version. If a condition type is not supported by your version of Hyperic or is not valid for the target resource, it will not appear as an option.

To define a condition, choose one of the following condition types, and supply required parameter values.

• **Metric condition** - To base the alert on the value of a metric that Hyperic collects for the resource:

  1. **Metric** - Select a metric from the selector list. Only currently enabled metrics are listed. (If the metric you're looking for is not listed, see the note below.)
  2. Define the rule for evaluating the metric value.
     
     - **Compare metric value to an absolute value**. Select an operator: > (greater than), < (less than), = (equal to), or != (not equal to), and enter a metric value. If the metric value is a percentage, specify it as a float value. For example, enter .99 for 99%, 1.0 for 100%. Use a period (.) as a decimal separator, rather than a comma (,).
     - **Compare metric value to its minimum, baseline, or maximum value** *, in vCenter Hyperic only. Select an operator: > (greater than), < (less than), = (equal to), or != (not equal to), and choose "Min Value", "Baseline Value" or "Max Value".
     - **Fire upon change in metric value**. Click **value changes**.
To Enable Collection of a Metric
If you want to base a metric condition on a metric that is not currently collected, you have to enable collection of that metric. To do so, update the metric collection settings for the resource type (choose Monitoring Defaults from the Administration tab), or for the specific resource (click Metrics on the Monitor tab for the resource).

- **Inventory Property Condition** - To define a condition that is triggered when the value of an inventory property for resource changes, select an inventory property. The dropdown menu contains only those inventory properties that are valid for the type of the resource to which the alert applies.

- **Control Action Condition** - When you define an alert for a resource that supports control actions, you can define a condition that is triggered when a particular control action is performed. If desired, you can base the condition on a control action with a particular result status: "in progress", "completed", or "failed". Dropdown menus allow you to select a control action that the resource supports, and a result status if desired.

- **Events/Log Level Condition** - To define a condition that is triggered by a log event, select a message severity level ("error", "warn", "info", "debug", "all") and optionally a match string. The condition is satisfied each time a message of the selected severity that contains the match string (if one was specified) is written to a log file that Hyperic is tracking. Log tracking must be enabled for the resource. To determine the log files that Hyperic monitors for the resource, see the Configuration Properties section of the resource’s Inventory tab. The log files that Hyperic monitors for a resource are defined using the server.log_track.files property.

- **Config Changed... Condition** - This type of condition is triggered by a change to a configuration file that Hyperic is configured to monitor for the resource. To limit the condition to a single file, enter its filename in the "match filename" field. If you don’t specify a filename, a change to any file monitored will trigger the alert. To determine the log files that Hyperic monitors for the resource, see the Configuration Properties section of the resource’s Inventory tab. The files that Hyperic monitors for a resource are defined using the server.config_track.files property. The maximum length for filename entered is 25 characters.

Define Additional Conditions
You can define up to three conditions for an alert. To add another condition, click Add Another Condition and specify whether both the new condition and the preceding one must be satisfied for the alert to be triggered ("AND") or only one must be satisfied ("OR").

Define Recovery Alert Behavior
To designate the alert you’re defining as a recovery alert, select the primary alert definition from the dropdown menu.
A recovery alert condition should detect when the condition that fired the primary alert is no longer true. When a recovery alert fires, it marks the primary alert "Fixed", and the primary alert definition is re-enabled. The primary alert definition should be configured to **Generate one alert and then disable alert definition until fixed**, as described below.

**Enable Actions**

You can make the condition absolute - (one strike you're out) or fire after the condition occurs repeatedly. Choose either:

- **Each time conditions are met.** The alert fires upon a single occurrence of the condition, or
- **Once every _ times conditions are met within a time period of _ minutes.** This option configures an alert to fire when the condition(s) occur multiple times over a period of time. Enter the number of occurrences and period of time.

**Enable Action Filters**

An action filter can be used to control alert firing and alert actions.

**Disable an Alert Definition upon Firing**

Click **Generate one alert and then disable alert definition until fixed** to disable the alert definition after firing and re-enable it when the alert that triggered it is marked "Fixed".

This option eliminates redundant firing for the same problem. If you do not choose this option, the alert will fire repeatedly as long as the triggering condition is still true.

This configuration option, used in conjunction with recovery alerts, automates the process of disabling and re-enabling an alert definition. Result: (1) no redundant alerts for the same problem, and (2) you don't have manually "fix" an alert triggered by a transient problem.

**Disregard Control Actions for Related Alerts.**

The **Disregard control actions that are defined for related alerts** option appears on **New Alert Definition** pages for resources that support control actions. This option only applies when:

1. The current alert definition will include an alert action
2. The resource associated with the alert is a member of an application
3. There are other members of the same application with alerts that fire control actions (ideally the same control action)
Under these circumstances, this configuration option ensures that if multiple alerts are fired within a short period for resources that are members of the same application, only one control action will be executed. For example, this would prevent a server from being restarted several times in a short period of time for the same alert conditions. For instance, you might have an alert with an action to restart a Tomcat server if the JVM Free Memory got too low and another alert with an action to restart the same server if the JVM Active Thread count got too high. If both alerts fired at the same time and they were filtering control actions, only 1 restart control action would be executed and not two.

Create or Edit Alert Actions

You assign actions to an alert definition on the Alert Definition page, which appears when you save a new alert definition or edit an existing alert definition.

The Alert Definition page is similar to the New Alert page, with the addition of Edit controls in the "Alert Properties" and "Condition Set" sections, and tabs at the bottom of the page for defining alert actions.

You can specify multiple actions to be performed automatically when an alert fires. The types of actions available in the Alert Definition page vary based on: (1) the type of resource the alert applies to, (2) your version of Hyperic, and (3) whether you've configured Hyperic for the types of actions that must be enabled before you can use them, such as escalations, OpenNMS trap actions, and in vCenter Hyperic, SNMP notifications.

To define an alert action, select one of the tabs and supply the required information:

**Escalation**

Select an escalation from the "Escalation Scheme" dropdown menu; the tab refreshes and shows the escalation steps. You must define an escalation before you can assign it to an alert definition. Using an escalation that is configured to repeat until the alert is fixed is a good way to prevent redundant alerts firing for the same problem. To create an escalation, click Escalation Schemes Configuration on the Administration tab.

**Control Action**

You can define a resource control action for Hyperic to perform when the alert fires. The control action can target the current resource (the one to which the alert definition is assigned) or a different resource on the same platform, as long as the resource type has Hyperic-supported control actions. To configure a control action for the alert, select the Control Action tab and click Edit. The Add Control Action page appears; click the thumbnail below for a screenshot. Follow the instructions on the associated help page. You can only assign a single control action to an alert definition. **Note:** You cannot assign a control action to a resource type alert.
Notify Roles

You can specify one or more roles as notification recipients. Hyperic users with a role you specify will be notified when an alert is fired. Click Add to List on the Notify Roles tab. On the roles selection page, choose the role(s) to be notified when the alert fires. The help page has instructions.

Notify HQ Users

Click Add to List on this tab to specify one or more Hyperic users as notification recipients. On the user selection page, choose the users to be notified when the alert fires. The help page has instructions.

Notify Other Recipients

Click Add to List on this tab to specify non-Hyperic user email recipients for alert notifications. The help page has instructions.

Script

To assign a script action to the alert definition, click the Script tab, enter the full path to the script, and click Set. Hyperic will run the script when the alert fires. Scripts can reference alert-related Hyperic environment variables to perform custom notification logic. For information, see Define a Script Action for an Alert.

Script actions are synchronous
Script actions execute one at a time. Until a script action completes, additional alerts will not fire on the resource.

OpenNMS

If Hyperic Server is configured for OpenNMS integration, you can use this tab to configure Hyperic to send an SNMP trap to OpenNMS when the alert fires. The notification will be generated by opennms_notify.gsp alert notification template.

To configure an OpenNMS trap action, enter:

- **Server** - Listen address for the OpenNMS server
- **Port** for the OpenNMS server.

SNMP Notification

If the Hyperic Server is configured to send SNMP notifications to your NMS, you can use this tab to configure a trap notification action. See SNMP Server Configuration Properties for more information.

The notification sent when the alert fires will contain three variable bindings:

- **sysUptimeOID.0** - No configuration is required for this binding.
- **snmpTrapOID.0** - This binding is configured on the HQ Server settings page.
o A variable binding for the alert data specified in the `snmp_trap.gsp` alert notification template - the alert definition name and the "short reason" for firing. Note that Alert templates may be customized.

**Including more variable bindings in SNMP messages**

For richer capability, you can configure a SNMP notification as a step in an escalation. An SNMP notification in an escalation can be configured with additional variable bindings.

To configure an SNMP notification action enter:

- **IP Address** - the address and port of the target NMS.
- **OID** - The OID of the notification to send, which will contain the alert details specified in the `snmp_trap.gsp` template.
- **Notification Mechanism** - The type of SNMP notification to send:
  - v1 Trap
  - v2c Trap
  - Inform

**ui-Alert.ControlAction**

**Configure a Control Action as an Alert Action**

You can configure an alert to fire a supported resource control action either on the resource that fired the alert or on another resource on the same platform. You can assign either a built-in or a custom control action to an alert definition.

1. Navigate to the alert definition.
2. Click **Edit** in the "Control Action" section of the alert definition page.
3. The **Resource Type** dropdown menu lists the resource types with supported control actions that exist on the current platform. These include:
   - Resource types whose managing resource plug-ins implement control actions.
   - The service type "FileServer Service", if any instances of that type exist on the platform.
     - A custom control action is configured as a "FileServer Service" platform service. The configuration process is described in the Configure a Custom Control Action section of vCenter Hyperic Administration Guide.
4. Select the target resource type from the **Resource Type** dropdown menu. (Select "File Service" if you want to assign a custom control action to the alert.)
   After you select a resource type, the **Resource Name** dropdown menu will contain a list of the resource instances of that type that run on the current platform.
5. Select resource from **Resource Name** dropdown menu — this will be the target of the control action, or if the selected type is "FileServer File", the custom control action to be run.
6. The **Control Type** dropdown menu lists the commands available for the selected resource. Select the command you want to run when the alert fires.
For a custom control action configured as a FileServer File service, the only command available is "run".

7. Click **OK**.

To remove the Control Action from the alert definition, edit the alert definition, select "None" from the **Control Type** dropdown menu, and click **OK**.

**ui-Alert.ListTypeDefinition**

This page lists alert definitions for a resource type, and allows you to create, edit, enable/disable, and delete resource type alert definitions.

**List Alert Definitions for a Resource Type**

This page lists alert definitions for the selected resource type.

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert Definition</td>
<td>Name assigned to the alert definition.</td>
</tr>
<tr>
<td>Description</td>
<td>Description defined in the alert definition.</td>
</tr>
<tr>
<td>Date Created</td>
<td>Date and time the alert definition was created.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates whether the alert definition is currently enabled or disabled.</td>
</tr>
</tbody>
</table>

**Create a Resource Type Alert Definition**

Click **New** and proceed to the "New Alert Definition" screen - the new alert definition will apply to the all resources of current resource type. For instructions see Define an Alert for a Resource Type.

**Enable or Disable a Resource Type Alert Definition**

Check the alert definition name, and in **Set Active**, select "YES" (to enable) or "NO" (to disable) in the dropdown box and click **OK**.

**Edit a Resource Type Alert Definition**

Check the alert definition name and proceed to the "Edit Alert Definition" screen. Changes you make will apply to all resources of the resource type to which the alert definition is assigned.

**Delete Resource Type Alert Definition**

Check the alert definition name and click **Delete**. The alert definition will be removed for all resources of the resource type to which the alert definition is assigned.

**ui-Alert.Actions**

You assign actions to an alert definition on the **Alert Definition** page, which appears when you save a new alert definition or edit an existing alert definition.
The **Alert Definition** page is similar to the **New Alert** page, with the addition of **Edit** controls in the "Alert Properties" and "Condition Set" sections, and tabs at the bottom of the page for defining alert actions.

You can specify multiple actions to be performed automatically when an alert fires. The types of actions available in the **Alert Definition** page vary based on: (1) the type of resource the alert applies to, (2) your version of Hyperic, and (3) whether you’ve configured Hyperic for the types of actions that must be enabled before you can use them, such as escalations, OpenNMS trap actions, and in vCenter Hyperic, SNMP notifications.

To define an alert action, select one of the tabs and supply the required information:

**Escalation**

Select an escalation from the "Escalation Scheme" dropdown menu; the tab refreshes and shows the escalation steps. You must define an escalation before you can assign it to an alert definition. Using an escalation that is configured to repeat until the alert is fixed is a good way to prevent redundant alerts firing for the same problem. To create an escalation, click **Escalation Schemes Configuration** on the **Administration** tab.

**Control Action**

You can define a resource control action for Hyperic to perform when the alert fires. The control action can target the current resource (the one to which the alert definition is assigned) or a different resource on the same platform, as long as the resource type has Hyperic-supported control actions. To configure a control action for the alert, select the **Control Action** tab and click **Edit**. The **Add Control Action** page appears; click the thumbnail below for a screenshot. Follow the instructions on the associated help page. You can only assign a single control action to an alert definition. **Note:** You cannot assign a control action to a resource type alert.

**Notify Roles**

You can specify one or more roles as notification recipients. Hyperic users with a role you specify will be notified when an alert is fired. Click **Add to List** on the **Notify Roles** tab. On the roles selection page, choose the role(s) to be notified when the alert fires. The help page has instructions.

**Notify HQ Users**

Click **Add to List** on  this tab to specify one or more Hyperic users as notification recipients. On the user selection page, choose the users to be notified when the alert fires. The help page has instructions.

**Notify Other Recipients**

Click **Add to List** on this tab to specify non-Hyperic user email recipients for alert notifications. The help page has instructions.
Script

To assign a script action to the alert definition, click the **Script** tab, enter the full path to the script, and click **Set**. Hyperic will run the script when the alert fires. Scripts can reference alert-related Hyperic environment variables to perform custom notification logic. For information, see [Define a Script Action for an Alert](#).

**Script actions are synchronous**

Script actions execute one at a time. Until a script action completes, additional alerts will not fire on the resource.

OpenNMS

If Hyperic Server is configured for OpenNMS integration, you can use this tab to configure Hyperic to send an SNMP trap to OpenNMS when the alert fires. The notification will be generated by `opennms_notify.gsp` alert notification template.

To configure an OpenNMS trap action, enter:

- **Server** - Listen address for the OpenNMS server
- **Port** for the OpenNMS server.

SNMP Notification

If the Hyperic Server is configured to send SNMP notifications to your NMS, you can use this tab to configure a trap notification action. See [SNMP Server Configuration Properties](#) for more information.

The notification sent when the alert fires will contain three variable bindings:

- **sysUptimeOID.0** - No configuration is required for this binding.
- **snmpTrapOID.0** - This binding is configured on the **HQ Server** settings page.
- A variable binding for the alert data specified in the `snmp_trap.gsp` alert notification template - the alert definition name and the "short reason" for firing. Note that Alert templates may be customized.

**Including more variable bindings in SNMP messages**

For richer capability, you can configure a SNMP notification as a step in an escalation. An SNMP notification in an escalation can be configured with additional variable bindings.
To configure an SNMP notification action enter:

- **IP Address** - the address and port of the target NMS.
- **OID** - The OID of the notification to send, which will contain the alert details specified in the `snmp_trap.gsp` template.
- **Notification Mechanism** - The type of SNMP notification to send:
  o v1 Trap
  o v2c Trap
  o Inform

**ui-Alert.Condition**

**Condition Set**

An alert condition specifies a resource metric value or event that will initiate the alert firing process.

The condition types you can choose when you define a alert vary by resource type and Hyperic version. If a condition type is not supported by your version of Hyperic or is not valid for the target resource, it will not appear as an option.

To define a condition, choose one of the following condition types, and supply required parameter values.

- **Metric condition** - To base the alert on the value of a metric that Hyperic collects for the resource:

  1. **Metric** - Select a metric from the selector list. Only currently enabled metrics are listed. (If the metric you're looking for is not listed, see the note below.)
  2. Define the rule for evaluating the metric value. You can:
     o Compare metric value to an absolute value. Select an operator: > (greater than), < (less than), = (equal to), or != (not equal to), and enter a metric value. If the metric value is a percentage, specify it as a float value. For example, enter .99 for 99%, 1.0 for 100%. Use a period (.) as a decimal separator, rather than a comma (,).
     o Compare metric value to its minimum, baseline, or maximum value *, in vCenter Hyperic only. Select an operator: > (greater than), < (less than), = (equal to), or != (not equal to), and choose "Min Value", "Baseline Value" or "Max Value". Baselining must be enabled. For more information, see Baselines.
     o Fire upon change in metric value. Click value changes.
**To Enable Collection of a Metric**

If you want to base a metric condition on a metric that is not currently collected, you have to enable collection of that metric. To do so, update the metric collection settings for the resource type (choose Monitoring Defaults from the Administration tab), or for the specific resource (click Metrics on the Monitor tab for the resource).

- **Inventory Property Condition** - To define a condition that is triggered when the value of an inventory property for resource changes, select an inventory property. The dropdown menu contains only those inventory properties that are valid for the type of the resource to which the alert applies.

- **Control Action Condition** - When you define an alert for a resource that supports control actions, you can define a condition that is triggered when a particular control action is performed. If desired, you can base the condition on a control action with a particular result status: "in progress", "completed", or "failed". Dropdown menus allow you to select a control action that the resource supports, and a result status if desired.

- **Events/Log Level Condition** - To define a condition that is triggered by a log event, select a message severity level ("error", "warn", "info", "debug", "all") and optionally a match string. The condition is satisfied each time a message of the selected severity that contains the match string (if one was specified) is written to a log file that Hyperic is tracking. Log tracking must be enabled for the resource. To determine the log files that Hyperic monitors for the resource, see the Configuration Properties section of the resource's Inventory tab. The log files that Hyperic monitors for a resource are defined using the server.log_track.files property.

- **Config Changed... Condition** - This type of condition is triggered by a change to a configuration file that Hyperic is configured to monitor for the resource. To limit the condition to a single file, enter its filename in the "match filename" field. If you don't specify a filename, a change to any file monitored will trigger the alert. To determine the log files that Hyperic monitors for the resource, see the Configuration Properties section of the resource's Inventory tab. The files that Hyperic monitors for a resource are defined using the server.config_track.files property. The maximum length for filename entered is 25 characters.

**Define Additional Conditions**

You can define up to three conditions for an alert. To add another condition, click Add Another Condition and specify whether both the new condition and the preceding one must be satisfied for the alert to be triggered ("AND") or only one must be satisfied ("OR").
Define Recovery Alert Behavior

To designate the alert you’re defining as a recovery alert, select the primary alert definition from the dropdown menu.

A recovery alert condition should detect when the condition that fired the primary alert is no longer true. When a recovery alert fires, it marks the primary alert “Fixed”, and the primary alert definition is re-enabled. The primary alert definition should be configured to **Generate one alert and then disable alert definition until fixed**, as described below.

Enable Actions

You can make the condition absolute - (one strike you’re out) or fire after the condition occurs repeatedly. Choose either:

- **Each time conditions are met.** The alert fires upon a single occurrence of the condition, or
- **Once every _ times conditions are met within a time period of _ minutes.** This option configures an alert to fire when the condition(s) occur multiple times over a period of time. Enter the number of occurrences and period of time.

Enable Action Filters

An action filter can be used to control alert firing and alert actions.

Disable an Alert Definition upon Firing

Click **Generate one alert and then disable alert definition until fixed** to disable the alert definition after firing and re-enable it when the alert that triggered it is marked "Fixed".

This option eliminates redundant firing for the same problem. If you do not choose this option, the alert will fire repeatedly as long as the triggering condition is still true.

In vCenter Enterprise this configuration option, used in conjunction with recovery alerts, automates the process of disabling and re-enabling an alert definition. Result: (1) no redundant alerts for the same problem, and (2) you don’t have manually "fix" an alert triggered by a transient problem.

Disregard Control Actions for Related Alerts.

The **Disregard control actions that are defined for related alerts** option appears on **New Alert Definition** pages for resources that support control actions. This option only applies when:

1. The current alert definition will include an alert action
2. The resource associated with the alert is a member of an application
3. There are other members of the same application with alerts that fire control actions (ideally the same control action)
Under these circumstances, this configuration option ensures that if multiple alerts are fired within a short period for resources that are members of the same application, only one control action will be executed. For example, this would prevent a server from being restarted several times in a short period of time for the same alert conditions. For instance, you might have an alert with an action to restart a Tomcat server if the JVM Free Memory got too low and another alert with an action to restart the same server if the JVM Active Thread count got too high. If both alerts fired at the same time and they were filtering control actions, only 1 restart control action would be executed and not two.

**Edit Alert Add Notification**

When you select the *Notify Roles* (in HQ Enterprise only), *Notify HQ Users*, or *Notify Other Recipients* when creating or editing an alert definition, you can select whom to notify when the current alert definition fires an alert.

**Notify Roles**

In HQ Enterprise you can select one or more roles from the *Roles* list on the left side of the page and click the right-arrow control to move it to the *Add Role Notification* list. A notification will be sent to each HQ User with a role on the *Add Role Notification* list.

**Notify HQ Users**

Select one or more HQ users from the *Users* list on the left side of the page and click the right-arrow control to move them to the *Add User Notification* list. A notification will be sent to each HQ User on the *Add User Notification* list.

**Notify Other Recipients**

Enter a comma-separated list of email address to receive notifications.

**ui-Alert.Detail**

The *Alert Detail* page lists information about a fired alert, and allows you to mark it "fixed", and acknowledge it if there is an associated escalation.

**View Alert Detail**

The *Alert Detail* page displays the alert definition for a fired alert, what actions have been performed, and as available, comments supplied when the alert was acknowledged or fixed.

- **Alert Properties** - Shows the name of the alert definition, the resource for which the alert fired, the priority of the alert, when it fired, and whether it has been fixed. You can click the alert definition name to view or edit it, or click the resource name to see its Indicators page.
- **Condition Set** - The metric value or event that caused the alert.
- **Control Action** - If HQ performed a control action when the alert fired, it is listed.
- **Notification Actions** - The HQ user(s) or other recipients for notifications.
• **Escalation** - If the alert has an escalation, this section lists the actions defined for the escalation, and a log of any steps that have been performed. Acknowledgment notes are shown, if available.

• **Fix** - If the alert has been marked fixed, the HQ user that fixed it, and comments entered at fix time are shown. If the alert was fixed by a recovery alert, the Fix section will say "The problem fixed itself."

**Mark Alert Fixed**

In the "Fix" section, enter comments on the alert resolution, and click **Fixed** at the bottom of the page. The icon appears only if the alert is unfixed.

**Acknowledge Alert**

In the "Escalation" section, click the **Acknowledge** icon. The icon appears only if the alert has an escalation, and hasn't already been acknowledged.

**Go to the Alert Definition Page**

To view or edit the alert definition, click the alert definition name in the "Alert Properties" section of the page.

**Go to the Resource's Indicators Page**

To view the **Indicators** page for the resource for which the alert fired, click the resource name in the Alert Properties section of the page.

**ui-Alert.List**

The default view when you click the **Alert** tab for a resource is a list of the alerts that fired on the current day for the resource.

You can use the navigation controls on the page to list all alerts for the resource that are still in the HQ database. By default, alerts are removed from the HQ database after 31 days - the retention period is configurable on the **HQ Server Settings** page, in the **Administration** tab.

**Alert List for a Resource**

The following information is shown for each alert.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>The priority assigned to the alert definition.</td>
</tr>
<tr>
<td>Alert Date</td>
<td>The date and time the alert fired.</td>
</tr>
<tr>
<td>Alert Definition</td>
<td>The name of the alert definition. Click to view the alert definition.</td>
</tr>
<tr>
<td>Alert Condition</td>
<td>The alert condition that was triggered.</td>
</tr>
<tr>
<td>Actual Value</td>
<td>If the alert condition is a metric comparison, the reported metric value triggered the condition.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Fixed</td>
<td>Whether or not the alert has been marked “fixed”.</td>
</tr>
<tr>
<td>Ack</td>
<td>An icon in this column indicates that the alert both has an escalation assigned, and has not yet been acknowledged.</td>
</tr>
</tbody>
</table>

**View Alerts and Status for a Different day**

To display alerts for a different date click ⬅ or ➡ to navigate forward and backward, or by click ☐ and select a specific date.

**Mark One or More Alert Fixed**

1. Check the alert(s) and click **Fixed**.
2. In the “Alerts” popup,
   a. Enter a comment in the "Resolution for Fix for Selected Alerts" area.
   b. Starting in HQ 4.1.1, if there are multiple unfixed alerts with the same alert definition you can choose to **Fix all previous**.
   c. Click **Fixed**.

**Acknowledge Alert with Escalation**

Alerts with escalations that have not yet been acknowledged will have 🕵️‍♂️ in the "Ack" column. You can:

- Click 🕵️‍♂️ on the alert's row in the "Ack" column to acknowledge the alert, if you don't want to enter a comment or take advantage of a pause option defined for the escalation.
- Checkmark one or more alerts and click **Acknowledgment** at the bottom of the page. You are prompted to enter a comment. If the escalation has a pause option, it is presented.

You can click the icon to acknowledge the alert - but you won't have the option to supply a comment or exercise an escalation pause option, if one is defined. If you want to comment on or exercise a pause option, you must acknowledge the alert from a different page.

**View and Update Alert Definitions for the Resource**

To view a list of alert definitions for the resource, click **Configure** at the top of the alert list. The page has options for creating and editing alert definitions.

**ui-Alert.New**

**Navigate to the New Alert Definition Page**

The **New Alert Definition** page allows you to define the properties and condition set for an alert definition. After you define the alert properties and condition set, and save your changes, you can define actions for HQ to perform when an alert is fired.

To access the **New Alert Definition** page,

1. Select a resource.
2. Click the Alert tab.
3. Click Configure.
4. Click New.

Define Alert Properties

- **Name** — Name assigned by the user creating an alert definition. A fired alert is identified, in the Hyperic user interface and alert notifications, by the alert definition name and a timestamp. An alert definition name should clearly communicate the nature of the problem. For example, "Down" for an alert on availability, or "Low Memory" for an alert on free memory.

- **Description** — Description entered by the user creating the alert definition.

- **Priority** — The severity of the problem, as defined by the person creating the alert definition: "Low", "Medium", or "High". A consistent policy for defining an alert definition priority makes it easier to triage problems appropriately. An alert's priority is shown in Hyperic pages that present alert status and in alert notifications. You can sort alerts by priority in vCenter Hyperic's Alert Center or Operations Center.

- **Active** — The current enabled/disabled status of the alert definition. Alerts only fire for enabled alert definitions. When an alert definition is disabled, Hyperic does not evaluate its condition or fire alerts for it.

Define Alert Condition Set

The options for defining alert conditions and firing rules vary by the type of resource to which the alert applies, and your version of HQ.

Condition Set

An alert condition specifies a resource metric value or event that will initiate the alert firing process.

The condition types you can choose when you define a alert vary by resource type and Hyperic version. If a condition type is not supported by your version of Hyperic or is not valid for the target resource, it will not appear as an option.

To define a condition, choose one of the following condition types, and supply required parameter values.

- **Metric condition** - To base the alert on the value of a metric that Hyperic collects for the resource:
  1. **Metric** - Select a metric from the selector list. Only currently enabled metrics are listed. (If the metric you’re looking for is not listed, see the note below.)
2. Define the rule for evaluating the metric value. You can:
   - Compare metric value to an absolute value. Select an operator: > (greater than), < (less than), = (equal to), or != (not equal to), and enter a metric value. If the metric value is a percentage, specify it as a float value. For example, enter .99 for 99%, 1.0 for 100%. Use a period (.) as a decimal separator, rather than a comma (,).
   - Compare metric value to its minimum, baseline, or maximum value *, in vCenter Hyperic only. Select an operator: > (greater than), < (less than), = (equal to), or != (not equal to), and choose "Min Value", "Baseline Value" or "Max Value". Baselining must be enabled. For more information, see Baselines.
   - Fire upon change in metric value. Click value changes.

To Enable Collection of a Metric
If you want to base a metric condition on a metric that is not currently collected, you have to enable collection of that metric. To do so, update the metric collection settings for the resource type (choose Monitoring Defaults from the Administration tab), or for the specific resource (click Metrics on the Monitor tab for the resource).

- **Inventory Property Condition** - To define a condition that is triggered when the value of an inventory property for resource changes, select an inventory property. The dropdown menu contains only those inventory properties that are valid for the type of the resource to which the alert applies.
- **Control Action Condition** - When you define an alert for a resource that supports control actions, you can define a condition that is triggered when a particular control action is performed. If desired, you can base the condition on a control action with a particular result status: "in progress", "completed", or "failed". Dropdown menus allow you to select a control action that the resource supports, and a result status if desired.
- **Events/Log Level Condition** - To define a condition that is triggered by a log event, select a message severity level ("error", "warn", "info", "debug", "all") and optionally a match string. The condition is satisfied each time a message of the selected severity that contains the match string (if one was specified) is written to a log file that Hyperic is tracking. Log tracking must be enabled for the resource. To determine the log files that Hyperic monitors for the resource, see the Configuration Properties section of the resource’s Inventory tab. The log files that Hyperic monitors for a resource are defined using the server.log_track.files property.
- **Config Changed... Condition** - This type of condition is triggered by a change to a configuration file that Hyperic is configured to monitor for the resource. To limit the condition to a single file, enter its filename in the "match filename" field. If you don't specify a filename, a change to any file monitored will trigger the alert. To determine the log files that Hyperic monitors for the resource, see the Configuration Properties section of the resource’s Inventory tab. The files that Hyperic monitors for a resource are defined using the server.config_track.files property. The maximum length for filename entered is 25 characters.
Define Additional Conditions
You can define up to three conditions for an alert. To add another condition, click Add Another Condition and specify whether both the new condition and the preceding one must be satisfied for the alert to be triggered ("AND") or only one must be satisfied ("OR").

Define Recovery Alert Behavior
To designate the alert you're defining as a recovery alert, select the primary alert definition from the dropdown menu.

A recovery alert condition should detect when the condition that fired the primary alert is no longer true. When a recovery alert fires, it marks the primary alert "Fixed", and the primary alert definition is re-enabled. The primary alert definition should be configured to Generate one alert and then disable alert definition until fixed, as described below.

Enable Actions
You can make the condition absolute - (one strike you're out) or fire after the condition occurs repeatedly. Choose either:

- Each time conditions are met. The alert fires upon a single occurrence of the condition, or
- Once every _ times conditions are met within a time period of _ minutes. This option configures an alert to fire when the condition(s) occur multiple times over a period of time. Enter the number of occurrences and period of time.

Enable Action Filters
An action filter can be used to control alert firing and alert actions.

Disable an Alert Definition upon Firing
Click Generate one alert and then disable alert definition until fixed to disable the alert definition after firing and re-enable it when the alert that triggered it is marked "Fixed".

This option eliminates redundant firing for the same problem. If you do not choose this option, the alert will fire repeatedly as long as the triggering condition is still true.

This configuration option, used in conjunction with recovery alerts, automates the process of disabling and re-enabling an alert definition. Result: (1) no redundant alerts for the same problem, and (2) you don't have manually "fix" an alert triggered by a transient problem.

Disregard Control Actions for Related Alerts.
The Disregard control actions that are defined for related alerts option appears on New Alert Definition pages for resources that support control actions. This option only applies when:

1. The current alert definition will include an alert action
2. The resource associated with the alert is a member of an application
3. There are other members of the same application with alerts that fire control actions (ideally the same control action)

Under these circumstances, this configuration option ensures that if multiple alerts are fired within a short period for resources that are members of the same application, only one control action will be executed. For example, this would prevent a server from being restarted several times in a short period of time for the same alert conditions. For instance, you might have an alert with an action to restart a Tomcat server if the JVM Free Memory got too low and another alert with an action to restart the same server if the JVM Active Thread count got too high. If both alerts fired at the same time and they were filtering control actions, only 1 restart control action would be executed and not two.

Save the Alert Definition

After defining alert properties and conditions, click OK to save the alert definition. The alert definition is created, and complete if you do not want to configure any alert actions. The Alert Definition page appears. This page allows you to edit the alert properties and conditions, and add alert actions, as desired.

Define Alert Actions

You can use the tabs at the bottom of the Alert Definition page to set up one or more actions to be performed when the alert fires. See the "Create or Edit Alert Actions" section on the associated help page for instructions.

Note: Defining actions for an alert definition is optional.

ui-Alert.ListDefinition

Display a List of Alert Definitions

To view a list of alert definitions that apply to a resource, click Configure in its Alerts tab.

The list includes resource type alert definitions — alerts defined at the resource type level.

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert Definition</td>
<td>Name assigned to the alert definition.</td>
</tr>
<tr>
<td>Description</td>
<td>Description defined in the alert definition.</td>
</tr>
<tr>
<td>Date Created</td>
<td>Date and time the alert definition was created.</td>
</tr>
<tr>
<td>Last Modified</td>
<td>Date and time the alert definition was most recently modified.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates whether the alert definition is currently enabled or disabled.</td>
</tr>
<tr>
<td></td>
<td>&quot;Yes&quot; and a yellow flag 🚨 in this column indicates that the alert definition has fired once and is disabled until it it is &quot;Fixed&quot;. (The alert definition was configured to &quot;fire once and disable until fixed&quot;). When the alert is fixed the definition will be re-enabled.</td>
</tr>
</tbody>
</table>
Create an Alert Definition for a Resource

Click **New** and proceed to the "New Alert Definition" page - the new alert definition will apply to the currently selected resource. For more information, see the associated help page.

Enable or Disable a Resource Alert Definition

When an alert definition is "enabled" it is active and alerts can fire. When an alert definition is "disabled", alerts for it will not fire.

Check the alert definition name, and in Set Active, select "YES" (to enable) or "NO" (to disable) in the dropdown box and click [ ].

**Note:** If you use vCenter Hyperic, do not disable an alert definition marked with an asterisk - this indicates it is inherited from a resource type alert definition. Changes made to an inherited alert definition from a resource's **Alert** tab will be overridden by subsequent updates to the resource type alert definition. To enable or disable a resource type alert definition, go to the list of alert definitions for the resource type, as described in the note at the top of this page.

Edit a Resource Alert Definition

Check the alert definition name and proceed to the "Edit Alert Definition" screen.

**How to Edit a Resource Type Alert Definition**

If you use vCenter Hyperic, do not use the edit option on this page for an alert definition marked with an asterisk - this indicates it is inherited from a resource type alert definition. Changes made to an inherited alert definition from a resource's **Alerts** tab will be overridden by subsequent updates to the resource type alert definition. To view and edit alert definitions for a resource type, click **Monitoring Defaults** on the **Administration** tab, and then click **Edit Alerts** in the row for the resource type.

Delete a Resource Alert Definition

Check the alert definition name and click **Delete**.

**Note:** Do not use the delete option on this page on an alert definition marked with an asterisk — this indicates it is inherited from a resource type alert definition. Changes made to an inherited alert definition from a resource's **Alert** tab will be overridden by subsequent updates to the resource type alert definition. To delete a resource type alert definition, go to the list of alert definitions for the resource type, as described in the note in the previous section.

**ui-Alert.Properties**

- **Name** — Name assigned by the user creating an alert definition. A fired alert is identified, in the Hyperic user interface and alert notifications, by the alert definition name and a timestamp. An alert definition name should clearly communicate the nature of the problem. For example, "Down" for an alert on availability, or "Low Memory" for an alert on free memory.
• **Description** — Description entered by the user creating the alert definition.
• **Priority** — The severity of the problem, as defined by the person creating the alert definition: "Low", "Medium", or "High". A consistent policy for defining an alert definition priority makes it easier to triage problems appropriately. An alert's priority is shown in Hyperic pages that present alert status and in alert notifications. You can sort alerts by priority in the Alert Center or Operations Center.
• **Active** — The current enabled/disabled status of the alert definition. Alerts only fire for enabled alert definitions. When an alert definition is disabled, Hyperic does not evaluate its condition or fire alerts for it.

**ui-Control**

**Managing Control Actions**
This screen allows users to view the control actions currently being performed on a resource and to manage both on-demand and scheduled control actions.

**Availability of Control Actions**
The control actions available on this screen depend on the resource type. A product's plug-in determines the control actions available for the product.

**Run a Control Action on Demand**
To initiate an on-demand (quick) control action on the resource:
1. Select the action in Control Action.
2. Type in Control Arguments for the action (if the control action uses or requires arguments).
3. Click .
   The control action will take place immediately or, if other control actions are currently taking place, just after they finish.

**Schedule a Control Action**
In the "Control Action Schedule" section, click **New** and proceed to the "New Scheduled Control Action" screen.

**Edit a Scheduled Control Action**
In the "Control Action Schedule" section, click the scheduled control action and proceed to the "Edit Scheduled Control Action" screen.

**Delete a Scheduled Control Action**
In the "Control Action Schedule" section, check the scheduled control action and click **Delete**. This control action will no longer be performed on the resource.
Sections on This Screen

Current Status

This section displays the status of a currently running control action (if any). This section displays the following information about the currently running control action:

- **Control Action**: The control action being performed on the resource
- **Command State**: The result of the control action. Possible values = Successful, Failed.
- **Command Status**: What the control action is currently doing. Possible values = In Progress, Stopped, Running, Restarting, Stopping.
- **Elapsed Time**: How long HQ has been performing the control action
- **Description**
- **Date Started**: The day and time on which HQ started performing this control action
- **Date Scheduled**: The day and time on which the control action is scheduled to run

Quick Control

This section displays the control actions available for this resource and allows users to initiate an on-demand control action.

Control Action Schedule

This section lists all control actions currently scheduled for this resource. Users can edit or delete an existing scheduled control action or create a new one.

Editing a Scheduled Control Action

This screen allows users to edit a scheduled control action for a resource.

Availability of Control Actions

The control actions available on this screen depend on the resource type.

To edit the scheduled control action:

- Change any of the following values, which were specified when the control action was originally scheduled, and click **OK**.
  - Control Action
  - Description
  - The schedule of the control action: Immediately or on a specific date (month/dd/yyyy) and time (hh:mm). (If it is a specific date and time, also specify whether the action should Recur daily, weekly, or monthly (if at all).)

ui-Control.History

To view a list of control actions that were performed on a resource:

1. Navigate to the resource in the Resource Hub.
2. Click the **Control** tab, which is present only if Hyperic supports control action for the selected resource type.
3. Click **History** on the **Control** tab.

The **Control History** page lists the following information for actions that were performed on the resources:

- **Control Action** — The action performed.
- **Arguments** — Arguments supplied to the control action.
- **Command State** — Status of the action: "Completed", "In Progress", or "Failed".
- **Date Started** — Date and time that the control action was initiated.
- **Elapsed Time** — How long it took to perform the control action.
- **User** — User name of the Hyperic user who initiated or scheduled the control action.
- **Message** — (optional) Additional information about the control action.

To delete a control action, place a checkmark next to it in the list, and click **Delete** at the bottom of the page.

**Scheduling Control Actions**

This screen allows users to schedule a control action for a resource.

**Availability of Control Actions**

The control actions available on this screen depend on the resource type.

To schedule a control action:

1. Select a Control Action.
2. (optional) Type a Description.
3. Specify when the control action should run:
   - Immediately (this equates to "on demand" or "quick start" on other control-action-related screens) or
   - A date (month/dd/yyyy) and a time (hh:mm) and whether the action should **Recur** daily, weekly, or monthly (if at all)
4. Click **OK**.
HQU plug-ins are Groovy-based HQ extensions that can be attached: to the Views tab for a resource type, as an item on a Masthead tab menu, or in the "Plug-ins" section of HQ's Administration tab. HQ has a number of built-in HQU plug-ins. Users can also develop and deploy custom HQU plug-ins.

ui-SpringInsight

Spring Insight Applications

This page describes the Spring Insight Applications page, available in vCenter Hyperic if you have Insight Operations under management.

Understanding Application Metrics

The Spring Insight Applications page presents multiple metrics that indicate how well an application is running, for instance, the percentage of application requests had an unacceptable response time, how many requests return errors, and so on.

These metrics, described in the sections below, appear in several places in the Spring Insight Applications user interface: on the Health tab, which presents metrics for all applications reporting to Hyperic monitored Dashboards applications, and also on the Performance tab for an Insight Dashboard or an Insight Application.

Application Health

The Application Health metric for an application is the health value that Insight calculates for the application. The Insight health metric is based on the percentage of Insight traces that complete without error. The values, indicators, and thresholds for the Application Health metric are defined below.

<table>
<thead>
<tr>
<th>Value</th>
<th>Indicator</th>
<th>Percentage of Successful Insight Traces</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent</td>
<td>![Icon]</td>
<td>94% or more</td>
</tr>
<tr>
<td>Good</td>
<td>![Icon]</td>
<td>85% - 93%</td>
</tr>
<tr>
<td>Fair</td>
<td>![Icon]</td>
<td>70% - 84%</td>
</tr>
<tr>
<td>Poor</td>
<td>![Icon]</td>
<td>50% - 83%</td>
</tr>
<tr>
<td>Unacceptable</td>
<td>![Icon]</td>
<td>0% - 49%</td>
</tr>
</tbody>
</table>
Application Vitals

The Vitals metric for an application is calculated by Hyperic. It is based on the Application Health metric (described above), and also takes into account the Hyperic metrics and events for the application and for resources that the application depends upon, including:

- Number of unfixed alerts for the application in Hyperic.
- Availability of the managed resources that the application depends upon: application servers, database servers (if applicable), and platforms.
- Number of unfixed alerts for the resources that the application depends upon: application servers, database servers (if applicable), and platforms.

If an application has no unfixed alerts in Hyperic and the resources it depends upon are available and have no unfixed alerts, the application’s value of the applications Vitals metric is equal to the value of its Application Health metric.

Unfixed Alert Count

The number of unfixed alerts during the timeframe.

Error Rate

The percentage of Insight traces that resulted in an HTTP error status code (500 to 600).

Response Time Levels

The "Invocations" metric tells you what percentage of traces had response times in each of three response time levels. The response time thresholds for each level are configurable in Spring Insight, and by default are:

- Satisfied — Response time 200 ms or less.
- Tolerated — Response time over 200 ms but less than 800 ms.
- Frustrated — Response time 800 ms or over.

For example

\[19.8\%/7.4\%/72.7\%\]

indicates that over the selected interval:

- 19.2% of the traces had response time 200 ms or less.
- 7.5% had response time over 200 ms but less than 800 ms.
- 73.4% had response time 800 ms or over.
Contents of the Spring Insight Applications Page

The sections below describe the contents of each section of the Spring Insight Applications page.

Dashboards Tab

The Dashboards pane on the left side of the Spring Insight Applications page is a tree control whose nodes are Insight Dashboards and Insight Applications.

The color of the bar to the left of a Dashboard node indicates the worst Vitals metric among the applications reporting to the Dashboard.

You use the Dashboards pane to browse a hierarchy of performance data. Depending on your need and interest, you view filter your view to include health information for:

- All applications reporting to all Hyperic-managed Insight Dashboards
  This is the view that appears when neither a dashboard or application is selected in the tree control. To return to this view, click the Dashboards link above the tree control. For a description of the view, see Health Tab for all Applications.

- Just the applications reporting to a particular Insight Dashboards
  To display this view, click the dashboard of interest in the tree control. For a description of the view, see Performance Tab for a Dashboard.

- Just one particular application
  To display this view, select the application of interest in the tree control. For a description of the view, see Performance Tab for an Application.

Health Tab for all Applications

The Health tab summarizes the health of all of the applications reporting to Hyperic-managed Insight Dashboards. This tab is present when you first open the Spring Insight Applications page.

After navigating to a dashboard or an application, you can redisplay the Health tab by clicking the "Dashboards" link at the top of the left pane.

The Health tab contains the following data and metrics:

- Applications Health Trend chart — By default, this chart plots the health of the five applications that currently have the poorest vitals. You can add and remove applications to the chart by checking and unchecking the box next to it. For a definition of the metric, see Application Health.
- Worst Vitals — The Vitals indicator in the "All Applications" bar reflects the worst value reported among all applications reporting to all Dashboards. For a definition of the Vitals metric, see Application Vitals.
Application Metrics — Below the **Applications Health Trend** chart is a list of all applications under management, ordered by the applications' Vitals metric, starting with the worst. The following data and metrics are displayed for each application:

- **Application** — The name of the application is a link; if you click it, the Performance tab for the dashboard appears. See [Performance Tab for an Application](#).
- **Vitals**
- **Alerts** — For a definition of the metric, see [Unfixed Alert Count](#).
- **Errors** — For a definition of the metric, see [Error Rate](#).
- **Invocations (F/T/S)** — For a definition of the metric, see [Response Time Levels](#).

**Performance Tab for a Dashboard**

To display the **Performance** tab for an Insight Dashboard, click the dashboard's name in the **Dashboards** tab.

**Note:** In the list of applications reporting to the dashboard:

- The list is ordered by application health, from worst to best.
- You can mouse over the application name to highlight the line for it in the **Application Health Trend** chart.
- You can click the application name to display the **Performance** tab for it. See [Performance Tab for an Application](#).

The **Performance** tab for a Dashboard contains:

- **Applications Health Trend** chart — By default, this chart plots the health of the five applications (reporting to the Dashboard) that currently have the poorest vitals. You can add and remove applications to the chart by checking and unchecking the box next to it. For a definition of the metric, see [Application Health](#).
- **Dashboard Vitals** — The **Vitals** indicator in the "Dashboard" bar is a composite health indicator that takes into account:
  - The Vitals for the applications reporting to the currently selected Insight Dashboard.
  - Availability of the managed resources that the Insight Dashboard depends upon: application server (tc Server) and platform.
  - Number of unfixed alerts for the resources that the Insight Dashboard depends upon: application server (tc Server) and platform.
- **Application Metrics** — Below the **Applications Health Trend** chart is a list of the applications reporting to the Dashboard. The following metrics are displayed for each application:
  - **Vitals** — For a definition, see [Application Vitals](#).
  - **Alerts** — For a definition, see [Unfixed Alert Count](#).
- **Errors** — For a definition, see Error Rate.
- **Invocations (F/T/S)** — For a definition, see Response Time Levels.
  - Application Server Performance — To view health data for the application server that the Insight Dashboard runs on, click the control in the Application Server bar. See Application Server Performance.
  - Platform Performance — To view health data for platform on which the Insight Dashboard runs, click the control in the Platforms bar. See Platform Performance.

**Application Server Performance**
The "Application Server" section charts a selected app server metric for all, or selected application servers where the applications in the dashboard run.

The Metric Low/Avg/Peak dropdown menu lists all of the available metrics for the application server and shows the low, average, and peak values for the metric over the current time range. Choose a metric from the list to graph it.
Below the chart, the following information is listed for each application server:

- name — The name of the resource in Hyperic.
- AVAIL — Current availability of the resource
- ALERTS — Current number of unfixed alerts
- LOW — Low value during current display range.
- AVG — Average value during current display range.
- PEAK — High value during current display range.

**Platform Performance**
The "Platform" section charts a selected platform metric for all, or selected platforms where the applications in the dashboard run.

The Metric Low/Avg/Peak dropdown menu lists all of the available platform metrics and shows the low, average, and peak values for the metric over the current time range. Choose a metric from the list to graph it.

Below the chart, the following information is listed for each platform:

- name — The name of the resource in Hyperic.
- AVAIL — Current availability of the resource
- ALERTS — Current number of unfixed alerts
- LOW — Low value during current display range.
- AVG — Average value during current display range.
- PEAK — High value during current display range.

**Performance Tab for an Application**
To display the Performance tab for an Insight Application, click the application’s name in the Dashboards tab.
The **Performance** tab has four sections:

- **Applications**
  - The application name is a link — if you click it, Insight Operations will open in a new window, and display more detailed resource health and performance metrics for the current display range.
  - The **Vitals** health bar to the right of the application name indicates the current Vitals for the application. For a definition of the Vitals metric, see [Application Vitals](#).
  - The **Health Trend** chart plots the application's "Health" and "Error Rate" metrics for the display range. For a definition of the health metric, see [Application Health](#).
  - The **Invocations** chart plots the distribution of request response times across the three response time levels defined in [Response Time Levels](#).

- **Application Server**
  - This section is expanded if one or more application servers to which the app is deployed is unhealthy. Otherwise, the section is collapsed.
  - For information about the metrics presented, see [Application Server Performance](#).

- **Data Service**
  - This section is present if the application access a Hyperic managed database server. See [Data Service Performance](#).
  - This section is expanded if the database that the app uses is unhealthy. Otherwise, the section is collapsed.
  - For information about the metrics presented, see [Data Service Performance](#).

- **Platform**
  - This section is expanded if one or more platforms where the app runs is unhealthy. Otherwise, the section is collapsed.
  - For information about the metrics presented, see [Platform Performance](#).

### Data Service Performance

The "Data Service" section is present if the currently selected application accesses a database managed by Hyperic.

The **Metric Low/Avg/Peak** dropdown menu lists all of the available platform metrics and shows the low, average, and peak values for the metric over the current time range. Choose a metric from the list to graph it.

Below the chart, the following information is listed for each platform:

- **name** — The name of the resource in Hyperic.
- **AVAIL** — Current availability of the resource
- **ALERTS** — Current number of unfixed alerts
- **LOW** — Low value during current display range.
- **AVG** — Average value during current display range.
- **PEAK** — High value during current display range.
Jump to Insight Operations

You can jump from the Spring Insight Applications page into the Insight application to investigate problems. Click the application name link on the application’s Performance tab. Insight will open in a new window, with the application selected in the Browse Resources tab, where you can view more detailed application health data for display range currently selected in the Hyperic user interface.

ui-tcserv.ServerConfiguration

The features described on this page are available in tc Server and tc Server Standard Edition.

tc Runtime Configuration

On this page you can configure the selected tc Runtime instance.

Navigating tc Runtime Configuration Pages

To navigate to the Server Configuration pages of a tc Runtime instance:

1. Click Resources > Browse in the HQ user interface.
2. Click Servers link to list all the tc Runtime instances in inventory.
   tc Runtime instances have the server type "SpringSource tc Runtime VersionNumber"
   Apache Tomcat instances have the server type "Tomcat X.X".
3. Click the name of the tc Runtime instance to which you want to navigate.
4. Click the Views > Server Configuration tab.

There are four tc Runtime configuration pages, three of which have their own tab beneath the main Views > Server Configuration tab:

- Configuration - Configure general tc Runtime options, such as JVM options, JSP behavior, and default options for static content.
- Resources - Create, configure, and delete JDBC data sources.
- Services - Configure the default Catalina service, and create new ones. A tc Runtime service groups together one or more connectors and a single engine. The engine, in turn, groups together one or more virtual hosts.

The Advanced section provides links for reloading, reverting, and uploading server configurations.

Saving or Undoing Changes

HQ populates the fields of the tc Runtime configuration pages from the its configuration files, including:

- conf/server.xml
- conf/context.xml
- conf/web.xml
• bin/setenv.sh  
• conf/catalina.properties  
• conf/logging.properties  

(All relative to CATALINA_BASE, the root directory of the tc Runtime instance.)

Each configuration page includes a Save button for saving the changes made in the user interface to the tc Runtime configuration files. If you try to navigate to a different page without saving any of your updates, HQ asks you if you want to leave the page and lose these updates.

When you click Save to save your changes, a box labeled "Changes have been made locally" is displayed until you click either:

• **Push** - to write the configuration changes you have made to the appropriate tc Runtime configuration file (such as server.xml). If you push the changes, HQ overwrites existing configuration, saving a backup of the overwritten configuration. Most saved changes to the tc Runtime configuration require a server restart to take effect; HQ flags these cases and provides a link to easily restart the tc Runtime.

• **Undo** - to undo all changes that have been made since the last push or undo.

If you update tc Runtime configuration settings from the HQ user interface, do NOT manually update the tc Runtime configuration files at the same time. HQ clears its local memory and reloads the configuration files upon certain events, not continuously.

User Permissions Required to Use the tc Runtime Features

The HQ super-user can use all the tc Runtime features of the HQ UI. If, however, you log on to the HQ UI as a non-super-user, then that user must have certain permissions to be able to use the tc Runtime features, as described in this section.

In HQ, users are assigned roles, which in turn are assigned permissions, such as View and Control.

The following table describes the additional effects that some of the HQ permissions have on the tc Runtime features. Use this table to determine which role you should assign a user that will be managing tc Runtime instances.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Additional Effect on tc Server HQ Plug-in Features</th>
</tr>
</thead>
</table>
| View       | Allows the user to:  
|            | • View the deployed Web applications in the Views > Application Management tab.  
<p>|            | • View the current configuration of a tc Runtime instance in the Views &gt; Server Configuration tab. |</p>
<table>
<thead>
<tr>
<th>Permission</th>
<th>Additional Effect on tc Server HQ Plug-in Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify</td>
<td>Allows the user to:</td>
</tr>
<tr>
<td></td>
<td>• Update the fields in the Views &gt; Server Configuration tab and then push the data to the configuration files associated with the tc Runtime instance, such as server.xml.</td>
</tr>
<tr>
<td></td>
<td>• Use the application lifecycle commands of the Views &gt; Application Management tab to start, stop, reload, or undeploy a Web application.</td>
</tr>
<tr>
<td>Control</td>
<td>Allows the user to use the commands in the Control tab to start, stop, and restart a tc Runtime instance.</td>
</tr>
</tbody>
</table>

**Configuring General tc Runtime Options**

The main tc Runtime configuration page includes options to change the Shutdown Port and Shutdown Command.

1. Navigate to the configuration pages for the tc Runtime instance. For instructions, see Navigating tc Runtime Configuration Pages.
2. Click the **Configuration** tab.
3. Click the **General** link in the list on the left. For information about the fields on the page, see **tc Runtime Configuration Reference**.
4. Make your changes.
5. Click **Save**. The message "Configuration saved successfully" indicates your changes were successfully saved.

To write your changes to the tc Runtime configuration files, click **Push** in the "Changes have been made locally" box. See Saving or Undoing Changes.

**Configuring Startup Options**

The page for configuring tc Runtime Start settings includes options for configuring the JVM where the instance runs, including minimum and maximum heap size, garbage collection, and debugging options.

**NOTE:** HQ populates the tc Runtime Start page with information from the CATALINA_HOME/bin/setenv.sh file of the server instance you are configuring (specifically the JVM_OPTS environment variable.) If you have not set the JVM_OPTS environment variable in this file, then the fields in the Server Start page will be blank.

The page allows you to add your own command line arguments to the JVM; be careful using this option because HQ does not validate the options but simply adds them to the Java command that starts the tc Runtime instance. If you enter them incorrectly, you will get an error starting the tc Runtime instance.

1. Navigate to the tc Runtime configuration pages.
2. Click the **Configuration** tab.
3. Click the **Server Start** link in the list on the left. For information about the fields on this page, see **ui-tcserv.ServerConfigurationRef**.
4. Make your changes.
5. To add your own JVM command line arguments, click the Advanced link at the bottom and enter them in the form the form "-Xoption=value or -XX:option=value", separating options with a space.

6. Click Save. The message "Configuration saved successfully" indicates your changes were successfully saved.

To write your changes to the tc Runtime configuration files, click Push in the "Changes have been made locally" box. See Saving or Undoing Changes.

Configuring the Context Container

Use this page to configure the context for every Web application deployed to this tc Runtime instance.

1. Navigate to the tc Runtime configuration pages.
2. Click the Configuration tab.
3. Click the Context Container link in the list on the left.
4. Make your changes. For reference information about the fields on this page, see tc Runtime Configuration Reference.
5. Click Save. The message "Configuration saved successfully" indicates your changes were successfully saved.

To write your changes to the tc Runtime configuration files, click Push in the "Changes have been made locally" box. See Saving or Undoing Changes.

Configuring JSP Options

SpringSource tc Runtime implements version 2.1 of the Java Server Pages (JSP) specification. Use this page to configure the behavior of the JSPs that are deployed to a tc Runtime instance.

1. Navigate to the tc Runtime configuration pages.
2. Click the Configuration tab.
3. Click the Server Defaults: JSP link in the list on the left.
4. Make your changes. For information about the fields on this page, see tc Runtime Configuration Reference.
5. Click Save. The message "Configuration saved successfully" indicates your changes were successfully saved.

To write your changes to the tc Runtime configuration files, click Push in the "Changes have been made locally" box. See Saving or Undoing Changes.

Configuring Static Content Defaults

Use this page to configure the behavior of static content in Web applications that run on tc Runtime.

1. Navigate to the tc Runtime configuration pages.
2. Click the Configuration tab.
3. Click the Server Defaults: Static Content link in the list on the left.
4. Make your changes. For information about the fields on this page, see tc Runtime Configuration Reference.
5. Click **Save**. The message "Configuration saved successfully" indicates your changes were successfully saved.

To write your changes to the tc Runtime configuration files, click **Push** in the "Changes have been made locally" box. See **Saving or Undoing Changes**.

**Using the Advanced Server Configuration Options**

The Advanced section of the main Server Configuration tab includes options for reverting or reloading configuration values in the event you do not want to save any of the recent updates you have made using the HQ user interface. The Advanced section also includes an option to upload a local configuration file in its entirety, such as server.xml. The following sections provide more information about these options.

Use these options with caution.

**Reloading Settings From Server**

Click the **Reload Settings From Server** link if you want to reload the server configuration currently contained in the tc Runtime configuration files. With this option, all local changes to the tc Runtime instance you have made using the HQ user interface that you have not yet pushed to the instance will be lost.

**Reverting to a Previously Saved Configuration**

Click the **Revert To a Previously Saved Configuration** link if you want to revert to the most recent backup copy of the tc Runtime configuration. Each time you push changes from the HQ user interface to the tc Runtime configuration files, the tc Server HQ plug-in makes a time-stamped backup copy of the previous configuration before overwriting the relevant configuration file, such as server.xml. With this option, you can revert back to the most recent backup copy in the event that there was a problem with the most recent changes that you pushed. As with reloading the current configuration, if you revert to a backup copy, any local changes to the tc Runtime instance made using the HQ user interface will be lost.

If you have never pushed configuration changes from the HQ UI to the tc Runtime instance, then no backup file will exist to which the tc Server HQ plug-in can revert. In this case, if you try to revert, you will get an error.

**Uploading a Configuration File**

Click the **Upload a Configuration File** link to upload a local configuration file, such as server.xml, and copy it to the appropriate tc Runtime instance directory. Use the **Configuration File** drop-down list to specify the type of configuration file you are going to upload, and then use the Browse button to browse for the file on your local computer.

The tc Server HQ plug-in makes a timestamped backup copy of the current configuration file before it overwrites it with the one you uploaded. This means that you can revert to the backup copy in the event that you do not want to use the uploaded configuration file for some reason.
### Configuring and Creating JDBC Data Sources

JDBC datasources make it easy for a user to access data in a database server. A datasource defines a pool of JDBC connections which in turn connect to a specific database using a specified URL, username, and so on. Use this page to create and configure datasources.

You can create two types of JDBC data sources:

- **Database Connection Pool (DBCP) Datasource** — The DBCP Datasource is the standard datasource provided by tc Runtime that uses the commons-dbcp package. Although this datasource is adequate for simple applications, it is single-threaded which means that in order to be thread-safe, tc Runtime must lock the entire pool, even during query validation. Thus it is not suitable for highly concurrent environments. Additionally, it can be slow, which in turn can negatively affect the performance of Web applications.

- **Tomcat Datasource** — The **Tomcat Datasource** includes all the functionality of the DBCP datasource, but adds additional features to support highly-concurrent environments and multiple core/cpu systems. The Tomcat datasource typically performs much better than the DBCP datasource. Additional features include:
  
  o Dynamic implementation of the interfaces, which means that the datasource supports the java.sql and javax.sql interfaces for your runtime environment (as long as your JDBC driver supports it), even when compiled with a lower version of the JDK.
  
  o Validation intervals so that tc Runtime doesn't have to validate every single time the application uses the connection, which improves performance.
  
  o Run-Once query, which is a configurable query that the tc Runtime instance runs only once when the connection to the database is established. This is very useful to setup session settings that you want to exist during the entire time the connection is established.
  
  o Ability to configure custom interceptors to enhance the functionality of the datasource. You can use interceptors to gather query stats, cache session states, reconnect the connection upon failures, retry queries, cache query results, and so on. The interceptors are dynamic and not tied to a JDK version of a java.sql/javax.sql interface.
  
  o Asynchronous connection retrieval - you can queue your request for a connection and receive a Future back.

To create a new JDBC datasource, or edit an existing one:

1. Navigate to the tc Runtime configuration pages.
2. Click the **Resources** tab.
3. Click the **JDBC Data Sources** link in the list on the left.
4. If you want to edit an existing data source, click its name in the table and make your changes. If you want to create a new one, click the **Create a New Tomcat/DBCP Data Source** link. For information about the fields on this page, see [tc Runtime JDBC Reference](#).
5. Click **Save**. The message "Configuration saved successfully" indicates your changes were successfully saved.
6. To write your changes to the tc Runtime configuration files, click **Push** in the "Changes have been made locally" box. See **Saving or Undoing Changes**.

### Configuring and Creating tc Runtime Services

A tc Runtime service represents the combination of one or more connector components that share a single engine component for processing incoming requests. A tc Runtime instance can have one or more services configured. The default service is "catalina".

1. Navigate to the tc Runtime configuration pages.
2. Click the **Services** tab.

If you want to edit an existing service, such as the default "catalina" service, click its name in the table and then configure, or add, the following components of the service:

- **Connectors**
- **Engine**
- **Virtual Host**
- **Logging System**

3. If you want to create a new service, click the **New Service** link. For information about the fields on the **Create a New Service** page, see **tc Runtime Service Reference**.
4. Click **Save**. The message "Configuration saved successfully" indicates your changes were successfully saved.

### Configuring and Creating Connectors

Connectors represent the interface between external clients sending requests to (and receiving responses from) a particular tc Runtime service. A tc Runtime instance can have one or more connectors, one for each supported message protocol. The default connector, configured for each tc Runtime, is the HTTP connector.

Use this page to configure, or create new, connectors for the current tc Runtime service.

1. Navigate to the tc Runtime configuration pages.
2. Click the **Services** tab.
3. In the **Services** table, click the name of the service for which you want to configure or create a connector.
4. Click the **Connectors** link in the list on the left.
5. If you want to edit an existing connector, click its name in the table and make your changes.
6. If you want to create a new one, click the **New AJP Connector** or **New HTTP(S) Connector** link, depending on the type of connector you want to create. For information about the fields on this page, see **tc Runtime Services Reference**.
7. Click **Save**. The message "Configuration saved successfully" indicates your changes were successfully saved.

For additional detailed information about configuring tc Runtime connectors, see **Connectors How-To**, part of the general **Apache Tomcat documentation**.
Configuring and Creating Virtual Hosts

A tc Runtime host represents a virtual host, which is an association of a network name for a server (such as "www.mycompany.com") with the particular computer which hosts the tc Runtime instance. In order to be effective, this name must be registered in the Domain Name Service (DNS) server that manages your Internet domain.

Use this page to configure, or create new, virtual hosts for the current tc Runtime service.

1. Navigate to the tc Runtime configuration pages.
2. Click the Services tab.
3. In the Services table, click the name of the service for which you want to configure or create a virtual host.
4. Click the Hosts link in the list on the left.
5. If you want to edit an existing host, click its name in the table and make your changes. If you want to create a new one, click the New Host link. For reference information about the fields on this page, see tc Runtime Services Reference.
6. Click Save. The message "Configuration saved successfully" indicates your changes were successfully saved.

Configuring tc Runtime Logging

Use this page to configure the logging system for the current engine. Note that you can also configure logging for a host by configuring the specific Host component; see Configuring and Creating Virtual Hosts.

1. Navigate to the tc Runtime configuration pages.
2. Click the Services tab.
3. In the Services table, click the name of the service for which you want to configure logging.
4. Click the Logging link in the list on the left.
5. Make your changes in the table. For information about the fields on this page, see ui-tcserver.ServerServicesRef.
6. Click Save. The message "Configuration saved successfully" indicates your changes were successfully saved.

ui-tcserver.ServerConfigurationRef

tc Runtime Configuration Reference

This page defines the fields on the Views > Server Configuration > Configuration tab - the page where an authorized user can configure a tc Runtime instance.
## General Configuration
### Server Properties

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Shutdown Port      | The TCP/IP port where the tc Runtime instance listens for a shutdown command. The connection must be initiated from the same server computer that is running this instance of tc Runtime.  
Valid values are -1, 1, 2, ... up to 65535.  
With the default setting, "-1", no shutdown port is enabled, so that the only way the server instance can be shut down is by a local "kill" statement to the server process. |
| Shutdown Command   | The command to issue via a TCP/IP connection to the Shutdown Port to shut down tc Runtime.                                                      |

### JMX Listener

The **JMX Listener** section configures the component of the tc Runtime instance that listens for Java Management Extensions (JMX) connections from management tools, such as the Hyperic Agent. By default, tc Runtime enables JMX connectivity.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enabled    | Specifies whether the tc Runtime instance's pre-configured JMX listener is enabled.  
**Important:** The Hyperic Agent uses JMX to connect to tc Runtime, so if you disable the JMX listener then you will not be able to use configure tc Runtime instances or groups from the Hyperic user interface, unless you configure JMX for tc Runtime through some other mechanism. |
<p>| Port       | Specifies the port upon which tc Runtime listens for JMX/RMI connections. Specify a port number that is not in use by another process. |
| IP Address | Specifies the IP address upon which tc Runtime listens for JMX/RMI connections. If the IP address is on the same as the tc Runtime instance, you can enter <strong>127.0.0.1</strong>. |
| Protocols  | Specifies a comma-separated list of enabled SSL/TLS protocols. If you do not enter a value for this property, the default protocols are enabled. |</p>
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Authenticate</strong></td>
<td>Specifies whether tc Runtime authenticates users that connect to the server using the JMX port. If you enable this field, tc Runtime looks up the user and password in the files specified by the Access File and Password File fields, respectively; if tc Runtime finds the username and password in the files, then the user is authenticated and allowed JMX access. If you disable this property, all users may access tc Runtime via JMX. You configure the JMX user and password in Hyperic on server instances the <strong>Inventory &gt; Configuration Properties</strong> page. The default JMX user and password is configured by default when you install tc Server; if, however, you change the name or password of the user in the access and password files, you must also change the configured user/password in the Hyperic user interface.</td>
</tr>
<tr>
<td><strong>Access File</strong></td>
<td>Specifies the full pathname of the tc Runtime file that contains the list of users allowed to access tc Runtime using JMX. Note that this file is on the computer that hosts the tc Runtime instance, not the computer that hosts the Hyperic Server. The access file contains one line per user; each line contains a username and permission level: &quot;readonly&quot; - user can only view tc Runtime configuration &quot;readwrite&quot; - user can view and modify tc Runtime configuration. The default name for the access file is <code>jmxremote.access</code>; the default location is the <code>CATALINA_BASE/conf</code> directory of the tc Runtime instance. Each tc Runtime instance is configured by default with an &quot;admin&quot; user with readwrite permission.</td>
</tr>
<tr>
<td><strong>Password File</strong></td>
<td>Specifies the full pathname of the tc Runtime file that contains passwords for the users listed in the Access File. Note that this file is on the computer that hosts the tc Runtime instance, not the computer that hosts the Hyperic Server. The password file contains one line for each user listed in the access file; each line contains a username and password. The default name for the password file is <code>jmxremote.password</code>; the default location is the <code>CATALINA_BASE/conf</code> directory of the tc Runtime instance. The password for the pre-configured &quot;admin&quot; user is &quot;springsource&quot;.</td>
</tr>
<tr>
<td><strong>Use SSL</strong></td>
<td>Specifies whether to use secure sockets layer (SSL) for users' JMX connections to tc Runtime. To use SSL, you must first set up a digital certificate on the computer that hosts the tc Runtime instance and then configure the SSL settings on this page. You can use the command-line utility keytool (<a href="http://download.oracle.com/javase/1.4.2/docs/tooldocs/solaris/keytool.html">http://download.oracle.com/javase/1.4.2/docs/tooldocs/solaris/keytool.html</a>) to manage digital certificates.</td>
</tr>
</tbody>
</table>
### Field Name | Description
---|---
Client Authentication | Specifies whether client authentication is required when using SSL. If you enable this property, tc Runtime authenticates JMX/SSL clients using certificate authentication rather than file-based authentication; this means that tc Runtime must find the client's certificate in its trust store or it will deny the client JMX access. This implies that only clients with known SSL certificates are allowed access to tc Runtime.

Use JDK Client Factory | Specifies whether or not the Hyperic Agent uses the required client libraries from the JDK. The required libraries are used to pass SSL-specific properties (such as the trust store and password) to the tc Runtime instance. If you disable this property, you must manually set up the Hyperic Agent's CLASSPATH to find these client libraries.

Cipher Suites | Specifies a comma-separated list of enabled SSL/TLS cipher suites. A cipher suite is a combination of cryptographic parameters that define the security algorithms and key sizes used for authentication, key agreement, encryption, and integrity protection.

If you do not enter a value for this property, the default cipher suites are enabled.

Truststore File | Specifies the full pathname of the trust store file used by SSL. A trust store is a special kind of key store file that is used when making decisions about what to trust. If you receive some data from an entity that you already trust, and if you can verify that the entity is the one it claims to be, then you can assume that the data came from that entity. This means that the key of a trust store file typically contains an entity's identity and a public key, as opposed to a private key contained in a more restricted key store file.

Truststore Pass | Specifies the password used to access the trust store file.

Keystore File | Specifies the full pathname of the key store file.

A key store is a database of key material. Key material is used for a variety of purposes, including authentication and data integrity. There are various types of key stores available, including "PKCS12" and Sun's "JKS." Typically, the key of a key store consists of an entity's identity and its private key.

Keystore Pass | Specifies the password used to access the key store file.

### Server Start Configuration

**NOTE:** Hyperic populates these fields with information contained in the CATALINA_HOME/bin/setenv.sh file of the tc Runtime instance you are configuring, specifically argument values defined in the JVM_OPTS environment variable.

If for some reason setenv.sh does not exist, or does not define JVM_OPTS, the Server Start fields will be blank.
Edits you make to Server Start fields in the Hyperic user interface are written back to setenv.sh.

### General

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Home</td>
<td>Specifies the full pathname to the JDK or JRE used by the tc Runtime instance.</td>
</tr>
<tr>
<td>Use Server HotSpot VM</td>
<td>Check to use the Java HotSpot Virtual Machine.</td>
</tr>
<tr>
<td>Min Heap Size</td>
<td>Specifies the initial size, in MB, of the memory allocation pool.</td>
</tr>
<tr>
<td>Max Heap Size</td>
<td>Specifies the maximum size, in MB, of the memory allocation pool.</td>
</tr>
<tr>
<td>Thread Stack Size</td>
<td>Specifies the amount of memory, in KB, allocated to a single JVM thread.</td>
</tr>
</tbody>
</table>

### Sun Specific JVM Options

The options in the following table are specific to Sun JVMs. Modify the option values with caution. If you use a non-Sun VM, altering the values might have unintended side effects.

### Memory

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min Young Generation Size</td>
<td>Specifies the default size, in MB, of new generation.</td>
</tr>
<tr>
<td>Max Young Generation Size</td>
<td>Specifies the maximum size, in MB, of new generation.</td>
</tr>
<tr>
<td>Min Perm Gen Size</td>
<td>Specifies the initial size, in MB, of the permanent generation.</td>
</tr>
<tr>
<td>Max Perm Gen Size</td>
<td>Specifies the maximum size, in MB, of the permanent generation.</td>
</tr>
</tbody>
</table>

### Garbage Collection

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max GC Pause</td>
<td>Sends a hint to the virtual machine that pause times of the specified milliseconds or less are desired. The VM will adjust the Java heap size and other GC-related parameters in an attempt to keep GC-induced pauses shorter than the specified value. Note that this may cause the VM to reduce overall throughput, and in some cases the VM will not be able to meet the desired pause time goal.</td>
</tr>
<tr>
<td>Max GC Minor Pause</td>
<td>Similar to Max GC Pause, but for minor pauses.</td>
</tr>
</tbody>
</table>

### Debug

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heap Dump on Out of Memory Error</td>
<td>Directs the JVM to generate a heap dump when an allocation from the Java heap or the permanent generation cannot be satisfied.</td>
</tr>
</tbody>
</table>
### Field Name | Description
--- | ---
Print Message at GC | Specifies whether the JVM should print messages to the GC log file every time it performs a garbage collection.
Print Heap at GC | Specifies whether the JVM should print detailed information, including heap occupancy before and after a garbage collection, to the GC log file.
Print GC Application Stopped Time | Specifies whether the JVM should print the amount of time an application is stopped during a garbage collection to the GC log file.
Print GC Timestamps | Specifies whether the JVM should print timestamps relating to garbage collection to the GC log file.
Print GC Details | Specifies whether the JVM should print detailed information relating to garbage collection to the GC log file.
GC Log File | Specifies the name of the GC log file to which all garbage collection information is printed. Default value is `CATALINA_BASE/logs/gc.log`.

### Advanced

### Field Name | Description
--- | ---
Command Line Arguments | Enter additional options to the CATALINA_OPTS environment variables if they are not available as text fields on this configuration page. Use one of these forms:

- `-XOption=Value`
- `-XX:Option=Value`

with a space between options.

For example:

```
-Xms512M -Xmx512M -XX:NewSize=128M
```

### Context Container

The fields described in the following table configure the context for every Web application deployed to this tc Runtime instance. Hyperic loads and updates the values from the `CATALINA_BASE/conf/context.xml` file for this tc Runtime instance.

### Static Resource Cache

### Field Name | Description
--- | ---
Allow Caching | If checked, specifies that tc Runtime uses the cache for static resources.
Max Cache Size | Maximum size, in KB, of the static resource cache. Default value is 10240 (10 megabytes).
### Field Name | Description
--- | ---
Cache TTL | Amount of time, in milliseconds, between cache entries revalidation. Default value is 5000 (5 seconds).

#### Web Application Logger

| Field Name   | Description |
--- | --- |
Swallow Output | If checked, specifies that tc Runtime will redirect the bytes outputted by the Web application to System.out and System.err to the Web application logger. |

#### Server Defaults - JSP

The fields described in the following table configure JSP-related init params for every Web application deployed to this tc Runtime instance. Hyperic loads and updates the values from the CATALINA_BASE/conf/web.xml file for this tc Runtime instance.

| Field Name                               | Description |
--- | --- |
Recompile Check Interval (s) | Specifies the interval, in seconds, at which tc Runtime checks to see if a JSP and its dependent file need to be recompiled. Default value is 0. If you set this field to a value greater than zero, and Development Mode is unchecked, then tc Runtime performs the compilation in the background. |
Development Mode | Specifies that tc Runtime is working in development mode. When this value is checked, you can specify the frequency at which JSPs are checked for modification using the Modification Test Interval field. |
Modification Test Interval (s) | Specifies the interval, in seconds, that tc Runtime should wait before checking JSPs and their dependent files for modifications. If you set this field to 0, then tc Runtime checks the JSPs every time they are accessed. Default value is 4 seconds. This feature is enabled only when Development Mode is checked. |
Compiler | Specifies the JSPs compiler used by tc Runtime. If not set, then tc Runtime uses the default Eclipse JDT Java compiler. |
Compiler Target VM | Specifies the JDK version with which the generated files are compatible. Default value is JDK 1.4. |
Compiler Source VM | Specifies the JDK version with which the source files are compatible. Default value is JDK 1.4 |
Compile Class With Debug Information | Specifies whether the JSP class should be compiled with debug information. |
Classpath | Specifies the CLASSPATH that tc Runtime should use when compiling the generated servlets. tc Runtime creates the default CLASSPATH dynamically based on the current Web application. |
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fork JSP Page Compile to Separate JVM</td>
<td>Specifies whether tc Runtime should fork the compilation of JSPs so they are performed in a separate JVM than tc Runtime.</td>
</tr>
<tr>
<td>Enable Tag Handler Pooling</td>
<td>Enables tag handler pooling.</td>
</tr>
<tr>
<td>Internet Explorer class-id for <a href="">jsp:plug-in</a> Tags</td>
<td>Specifies the class-id value that tc Runtime sends to Internet Explorer when using the tags. Default value is clsid:8AD9C840-044E-11D1-B3E9-00805F499D93.</td>
</tr>
<tr>
<td>Java File Encoding</td>
<td>Specifies the Java file encoding to use for generating Java source files. Default value is UTF8.</td>
</tr>
<tr>
<td>Keep Generated Source Code</td>
<td>Specifies whether tc Runtime should keep the generated source code for each page rather than deleting it.</td>
</tr>
<tr>
<td>Generate One Print Statement Per Input Line</td>
<td>Specifies whether tc Runtime should generate static content with one print statement per input line, to ease debugging.</td>
</tr>
<tr>
<td>Trim Spaces In Template Text</td>
<td>Specifies whether tc Runtime should trim white spaces in template text between actions or directives.</td>
</tr>
<tr>
<td>Suppress SMAP Information</td>
<td>Specifies whether tc Runtime should suppress the generation of SMAP information for JSR-45 debugging.</td>
</tr>
<tr>
<td>Dump SMAP Information</td>
<td>Specifies whether tc Runtime should dump SMAP information for JSR-45 debugging to a file. If you want to set this field to true (checked), then be sure to also uncheck Suppress SMAP Information.</td>
</tr>
<tr>
<td>Generate Strings as Char Arrays</td>
<td>Specifies whether strings should be generated as character arrays. Checking this field will sometimes increase the performance of JSPs.</td>
</tr>
<tr>
<td>Issue Error For Invalid useBean Class Attribute</td>
<td>Specifies whether tc Runtime should issue an error when the value of the class attribute in a useBean action is not a valid bean class.</td>
</tr>
<tr>
<td>Scratch Directory</td>
<td>Specifies the scratch directory that tc Runtime should use when compiling JSP pages. Default value is the work directory for the current Web application.</td>
</tr>
<tr>
<td>Add X-Powered-By Response Header</td>
<td>Specifies whether generated servlet adds the the X-Powered-By response header.</td>
</tr>
</tbody>
</table>
Server Defaults - Static Content

The fields described in the following table configure static content-related init params for every Web application deployed to this tc Runtime instance. Hyperic loads and updates the values from the CATALINA_BASE/conf/web.xml file for this tc Runtime instance.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debug Level</td>
<td>Specifies the level of detail contained in the debugging messages from the current servlet. Default value is 0 (no debugging.)</td>
</tr>
<tr>
<td>File Encoding</td>
<td>Specifies the encoding that tc Runtime uses when reading static resources. The default value is the same as the file encoding of the platform on which tc Runtime is running.</td>
</tr>
<tr>
<td>Input Buffer Size</td>
<td>Specifies the size, in bytes, of the input buffer that tc Runtime uses when reading resources to be served. Default value is 2048.</td>
</tr>
<tr>
<td>Output Buffer Size</td>
<td>Specifies the size, in bytes, of the output buffer that tc Runtime uses when writing resources to be served. Default value is 2048.</td>
</tr>
<tr>
<td>Min Sendfile Size</td>
<td>Specifies the minimal file size, in KB, that tc Runtime uses with &quot;sendfile&quot;. This field only works if the connector supports sendfile. Default value is 48.</td>
</tr>
<tr>
<td>Show Directory Listings</td>
<td>Specifies whether tc Runtime should produce a directory listing if there is no welcome file in the directory. WARNING: Directory listings that include many entries can be slow and consume significant proportion of the tc Runtime resources.</td>
</tr>
<tr>
<td>Readme File Name</td>
<td>File name to display with the directory contents. No default value.</td>
</tr>
<tr>
<td>Read Only</td>
<td>Specifies whether the current context is read-only, which means that it rejects HTTP commands such as PUT and DELETE.</td>
</tr>
</tbody>
</table>

ui-tcserv.ApplicationManagement

This page describes the tc Server Application Management view in the VMware vCenter™ Hyperic® user interface enabled by the tc Server user interface plug-in. This page is present in the Hyperic user interface only if have the plug-in.

tc Runtime Application Management

The Application Management page, available when a tc Runtime instance or a group of tc Runtime instances is selected, enables an authorized user to manage applications deployed that server instance or group.
The HQ super-user can use all the tc Runtime Application Management features of the HQ UI. If, however, you log on to the HQ UI as a non-super-user, then that user must have certain permissions to be able to use the tc Runtime features. See User Permissions Required to Use the tc Runtime Features for details.

An HQ Group is not a Cluster
An HQ group is not equivalent or similar to a tc Runtime cluster. An HQ group is a set of other managed resources. An authorized user can create a group and assign resources to it. A group whose members are all of the same resource type is referred to as a compatible group. You can manage and monitor the resources in a compatible group at the group level. Grouping tc Runtime instances allows you manage applications across multiple tc Runtime instances.

A tc Runtime cluster enables session replication. Clustering behavior is defined in a tc Runtime instance's server.xml file.

Navigating to a tc Runtime Instance Or Group
1. To navigate to the Application Management page of a tc Runtime instance or group.
2. Click Resources > Browse at the top of the HQ Dashboard.
   - To browse to a server instance:
     Click Servers to view a list of the servers to which you have access. tc Runtime instances have the server type "SpringSource tc Runtime 6.0". Apache Tomcat server instances have the server type "Tomcat X.X".
   - To browse to a group of servers:
     Click Compatible Groups/Clusters to view a list all the compatible groups to which you have access. Groups of tc Runtime have the type "SpringSource tc Runtime 6.0".
3. In the table, click the name of the tc Runtime instance or group to which you want to navigate.
4. Click Views > Application Management.

Creating tc Runtime Groups
Grouping tc Runtime instances eases the process of managing server instances and applications. For example, you can deploy an application to group of tc Runtime with a single command, instead of deploying to each instance individually.

To create a group of tc Runtime instances:
1. Click Resources > Browse at the top of the HQ Dashboard.
2. Click **Servers** to list servers in inventory to which you have access. (Note: Only server instances that have been auto-discovered by HQ and added to inventory appear). tc Runtime instances have the server type "SpringSource tc Runtime 6.0". Apache Tomcat server instances have the server type "Tomcat X.X".

3. Check the box to the left of each tc Runtime instance you want to include in the new group.

4. Click **Group**.

5. Enter a name for the group (required) and a description and location as desired.

6. Click **OK**.

**Listing Applications**

Navigate to the **Application Management** page for a server instance or group. Deployed applications are listed in the **Deployed Applications** section of the page. For a group, the table lists all applications deployed to all servers in the group. The table shows:

- **Status** — The state of the application - either "Running" or "Stopped". For a group of servers:
  - "Running" or "Stopped" indicates that all instances of the application on all servers in the group have that state.
  - A numeric value indicates the number of servers upon which the application's state is "Running".
- **Sessions** — The number of current active sessions for the application.
- **Revision** — Current revision of the application. Hyperic creates a new revision each time you deploy an application that uses an existing context path

**NOTE:** Only applications on running tc Runtime instances appear. HQ returns an error for application hosts that are not running.

**Deploying Applications**

Deploying an application is the process of uploading it to tc Runtime and making it available to users. You can deploy an application to a single tc Runtime instance or to a group of tc Runtime instances. If you deploy to a group, the application will be deployed to each of tc Runtime instance in that group, enabling users to run the application from any of the tc Runtime instances in the group.

You can deploy an application from a WAR file located:

- on your local file system (on the the same machine as the browser you are using to connect to HQ's web user interface), or
- on the computer on which the tc Runtime resource is running.

Whether the WAR file is local or remote, you can either enter a new context path (string that uniquely identifies the Web application in the URL used to invoke it), or use the default value, which is the name of the WAR file, without the ".war" extension.

1. Navigate to the **Application Management** page for a tc Runtime instance or group.
2. Depending on the location of the WAR file for the application, either:
   - Click **Browse** in the **Deploy Application From Local Machine** section to browse to the file's location.
   - Enter the full path to the WAR file on the computer hosting the tc Runtime resource in the **Deploy Application from Server Machine** section.

3. As desired, enter a context path in the **Context path** text box.

4. Optionally check the **Use cold deployment strategy** if you want the tc Runtime instance to shutdown, deploy the application, and then start up again. By default (if box is unchecked), the tc Runtime instance hot-deploys the application, which means it does not shutdown then restart but simply deploys the application while the instance is still running. Use the cold deployment strategy if you want to avoid common hot deployment errors, such as running out of PermGen space. The PermGen space holds the metadata about classes that have been loaded/created in the JVM.

5. Click **Upload and Deploy** or **Deploy**, whichever is appropriate.

6. See the top "Results of the last operation" section for details about the result of deploying the application. When you deploy an application to tc Runtime, the application is started.

**Undeploying Applications**

Undeploying an application removes it from the tc Runtime instance or group. If you want to temporarily prevent users from accessing an application, stop it rather than undeploy it. See **Stopping Applications**.

1. Navigate to the application management page of a tc Runtime instance or group.
2. In the **Deployed Applications** section, check the box to the far-left of the application(s) you want to undeploy.
3. Click **Undeploy**. HQ removes the application from the list of deployed applications. See the top "Results of the last operation" section for details about the results of undeploying the application.

**Starting Applications**

Starting an application makes it available to users. You must have previously deployed the application to be able to start it.

1. Navigate to the application management page of a tc Runtime instance or group.
2. In the **Deployed Applications** section, check the box to the far-left of the application(s) you want to start.
3. Click **Start**. The status of the application changes to "Running". See the top "Results of the last operation" section for details about the result of starting the application.

**Stopping Applications**

Stopping an application makes it unavailable to users.

1. Navigate to the application management page of a tc Runtime instance or group.
2. In the **Deployed Applications** section, check the box to the far-left of the application(s) you want to stop.

3. Click **Stop**. The status of the application changes to "Stopped". See the top "Results of the last operation" section for details about the result of stopping the application.

**Reloading Applications**

When you reload an existing application, it shuts itself down and then reloads itself.

1. Navigate to the application management page of a tc Runtime instance or group.
2. In the **Deployed Applications** section, check the box to the far-left of the application(s) you want to reload.
3. Click **Reload**. The status of the application changes to "Running."
See the top "Results of the last operation" section for details about the result of reloading the application.

**ui-tcserver.ServerServicesRef**

**tc Runtime Services Reference**

This section defines the fields on the **Views > Server Configuration > Services** tab used to configure and create tc Runtime services.

A tc Runtime service represents the combination of one or more Connector components that share a single Engine component for processing incoming requests. A tc Runtime consists of one or more services. The default tc Runtime service which is always present in newly created tc Runtime instance is called "catalina."

**General Service Properties**

<table>
<thead>
<tr>
<th><strong>Field Name</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the name of this tc Runtime service. Within the scope of a tc Runtime, the service name must be unique. This is the name that appears in the tc Runtime log messages.</td>
</tr>
</tbody>
</table>

**Connector Properties**

Each tc Runtime service can have one or more connectors configured. Connectors are specific to a protocol, such as HTTP or AJP.
## General

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Specifies the protocol that handles incoming and outgoing messages for this connector. This field can have the following values: org.apache.coyote.http11.Http11Protocol (same as HTTP/1.1). This is the default value. Note that if you want to use HTTPS, you do not specify &quot;HTTPS/1.1&quot;, but rather, set the &quot;secure&quot; field to true. org.apache.coyote.http11.Http11NioProtocol - non blocking Java connector org.apache.coyote.http11.Http11AprProtocol - the APR connector.</td>
</tr>
<tr>
<td>IP Address</td>
<td>For tc Runtime instances with more than one IP address, this attribute identifies a single address, upon which the listen port defined in the Port attribute will be opened for connections. If a specific IP address is not specified, server sockets will be created on all IP addresses associated for the server, on the port specified in the Port attribute.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the TCP port number on which this connector will create a server socket and await incoming connections. Your operating system allows only one server application to listen to a particular port number on a particular IP address, which means that multiple tc Runtime instances running on the same computer must have unique ports. Default value is 8080.</td>
</tr>
<tr>
<td>Accept Count</td>
<td>HTTP(S) Connectors only. Specifies maximum queue length for incoming connection requests when all possible request processing threads are in use. Any requests received when the queue is full will be refused. The default value is 10.</td>
</tr>
<tr>
<td>Max Keep Alive Requests</td>
<td>HTTP(S) Connectors only. Specifies the maximum number of HTTP requests that can be pipelined until the connection is closed by the server. A value of 1 disables HTTP/1.0 keep-alive, as well as HTTP/1.1 keep-alive and pipelining. A value of -1 allows an unlimited amount of pipelined or keep-alive HTTP requests. The default value of this field is 100.</td>
</tr>
<tr>
<td>Proxy Host</td>
<td>If this connector is being used in a proxy configuration, specifies the server name that is returned from calls to request.getServerName.</td>
</tr>
<tr>
<td>Proxy Port</td>
<td>If this connector is being used in a proxy configuration, specifies the server port that is returned from calls to request.getServerPort().</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Redirect Port</td>
<td>Specifies the port to which a user is redirected if they require a secure connection. If this connector supports non-SSL requests, and a request is received for which a matching requires SSL transport, tc Runtime automatically redirects the request to the port number specified here.</td>
</tr>
<tr>
<td>Scheme</td>
<td>Specifies the name of the protocol you want to have returned by calls to <code>request.getScheme()</code>. For example, set this field to &quot;https&quot; for an SSL Connector. The default value is &quot;http&quot;.</td>
</tr>
<tr>
<td>Connection Timeout</td>
<td>Specifies the number of milliseconds this connector waits, after accepting a connection, for the request URI line to be presented. The default value is 60000 (i.e. 60 seconds).</td>
</tr>
<tr>
<td>Max Threads</td>
<td>Specifies the maximum number of request processing threads that this connector creates, which in turn determines the maximum number of simultaneous requests that can be handled. If an executor is associated with this connector, tc Runtime ignores this attribute as the connector will execute tasks using the executor rather than an internal thread pool. The default value of this field is 40.</td>
</tr>
<tr>
<td>Request Secret Keyword</td>
<td>Specifies that only requests from workers with this secret keyword will be accepted.</td>
</tr>
<tr>
<td>Use Request Secret Keyword</td>
<td>Specifies whether tc Runtime should generate a random value for the Request Secret Keyword field.</td>
</tr>
</tbody>
</table>

**Security/SSL**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure</td>
<td>Specifies whether you want user calls to <code>request.isSecure()</code> to return true for requests received by this connector. Check this field for connectors (both SSL and non-SSL) that receive data from an SSL accelerator, like a crypto card, a SSL appliance or even a Web server.</td>
</tr>
<tr>
<td>Enable SSL</td>
<td>Enables SSL traffic (handshake/encryption/decryption) for this connector. When enabled, be sure to also set the &quot;scheme&quot; and &quot;secure&quot; attributes so that correct values are returned to user calls to <code>request.getScheme()</code> and <code>request.isSecure</code></td>
</tr>
<tr>
<td>Certificate Encoding Algorithm</td>
<td>Specifies the certificate encoding algorithm. The default value is the Sun implementation (SunX509). For IBM JVMs use the value IbmX509. For other vendors, consult the JVM documentation for the correct value.</td>
</tr>
<tr>
<td>Keystore File</td>
<td>Specifies the pathname of the keystore file that contains the server certificate to be loaded. By default, the pathname is the file &quot;.keystore&quot; in the operating system home directory of the user that starts the tc Runtime instance.</td>
</tr>
</tbody>
</table>
### Keystore Password
Specifies the password used to access the server certificate from the specified keystore file. The default value is "changeit".

### Key Alias
Specifies the alias that tc Runtime uses when accessing the server certificate in the keystore. If not specified, tc Runtime uses the first key read in the keystore.

### Engine Properties
A tc Runtime engine represents the entire request processing machinery associated with a particular service. It receives and processes all requests from one or more connectors, and returns the completed response to the connector for ultimate transmission back to the client.

Each Service must be associated with exactly one engine.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the name of this service. This is the name used in tc Runtime logging messages. Each service name must be unique within the scope of a tc Runtime instance.</td>
</tr>
<tr>
<td>Default Host</td>
<td>Specifies the default host name. This name corresponds to the name of a Host component that processes requests directed to host names on this server, but which are not explicitly configured for this tc Runtime instance.</td>
</tr>
<tr>
<td>JVM Route</td>
<td>Specifies the identifier that must be used in load balancing scenarios to enable session affinity. The identifier, which must be unique across all tc Runtime instances that participate in a cluster, is appended to the generated session identifier, therefore allowing the front end proxy to always forward a particular session to the same tc Runtime instance.</td>
</tr>
</tbody>
</table>

### Thread Diagnostics
When you deploy and start a Web application on a tc Runtime instance, and then clients begin connecting and using the application, you might find that the clients occasionally run into problems such as slow requests or even failed requests. Although tc Runtime by default logs these errors in the log files, it is often difficult to pinpoint where exactly the error came from and how to go about fixing it. By enabling thread diagnostics, tc Runtime provides additional information to help you troubleshoot the problem.

A failed request is one that simply did not execute; a slow request is defined as a request that takes longer than the configured threshold. The default threshold is 500 milliseconds.
When you enable thread diagnostics, you can view the following contextual information about a slow or failed client request:

- The time and date when the slow or failed request happened.
- The exact URL invoked by the client that resulted in a slow or failed request.
- The exact error returned by the request.
- The database queries that were executed as part of the request and how long each one took.
- Whether any database connection failed or succeeded.
- Whether the database had any other connectivity problems.
- Whether the database connection pool ran out of connections.
- Whether any garbage collection occurred during the request, and if so, how long it took.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Thread Diagnostics</td>
<td>Enables the gathering of thread diagnostic information after you have enabled thread diagnostics. Go to the Monitor tab of a particular tc Runtime instance, then click on the servername Thread Diagnostics link in the Resources &gt; Services window on the left.</td>
</tr>
<tr>
<td>History</td>
<td>Specifies the maximum number of requests that have met the threshold condition that tc Runtime keeps as historical data. The default value is 1000. You can query this historical data using JMX; it is not presented in the HQ user interface.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Specifies the threshold, in milliseconds, after which a client request is considered slow. The default value is 5000 milliseconds.</td>
</tr>
</tbody>
</table>

**Host Properties**

A tc Runtime Host represents a virtual host, which is an association of a network name for a tc Runtime (such as "www.mycompany.com" associated with the particular tc Runtime). To be effective, the network name must be registered in the Domain Name Service (DNS) server that manages the Internet domain to which you belong.

A tc Runtime engine must be associated with one or more hosts. One of the hosts must be the default host, or the one pointed to by the "Default Host" field of the Engine configuration.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the network name of this virtual host, as registered in your Domain Name Service (DNS) server. One of the Hosts associated within a tc Runtime engine MUST have a name that matches the &quot;Default Host&quot; setting for that engine.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application Base Directory</td>
<td>Specifies the application base directory for this virtual host. The application base directory may contain Web applications to be deployed on this virtual host. You can specify an absolute pathname for this directory, or a pathname that is relative to the $CATALINA_BASE directory.</td>
</tr>
<tr>
<td>Auto Deploy Web Applications</td>
<td>Specifies whether new Web applications that are copied to the application base directory while tc Runtime is running should be automatically deployed.</td>
</tr>
<tr>
<td>Deploy Applications on Startup</td>
<td>Specifies whether Web applications from this host should be automatically deployed when the tc Runtime instance starts up.</td>
</tr>
<tr>
<td>Unpack WARs</td>
<td>Specifies whether tc Runtime should unpack Web applications that are copied to the application base directory as Web application archive (WAR) files into a corresponding disk directory structure. If unchecked, tc Runtime runs the Web applications directory from a WAR file.</td>
</tr>
<tr>
<td>Deploy XML</td>
<td>Specifies whether tc Runtime should parse the &quot;context.xml&quot; file embedded inside the Web application (located at META-INF/context.xml). Security conscious environments should set this to false (uncheck) to prevent applications from interacting with the container's configuration. The administrator will then be responsible for providing an external context configuration file, and put it in $CATALINA_BASE/conf/enginename/hostname/.</td>
</tr>
<tr>
<td>Work Directory</td>
<td>Specifies the pathname to a scratch directory used by applications for this Host. Each application will have its own sub directory with temporary read-write use. Configuring a Context work directory overrides use of the Host work directory configuration. This directory will be made visible to servlets in the Web application by a servlet context attribute (of type java.io.File) named javax.servlet.context.tempdir as described in the Servlet Specification. If not specified, a suitable directory underneath $CATALINA_BASE/work will be provided.</td>
</tr>
</tbody>
</table>

**HTTP Access Logging**

The tc Runtime logging subsystem creates log files in the same format as those created by standard Web servers. These logs can later be analyzed by standard log analysis tools to track page hit counts, user session activity, and so on. The logging files are rolled over nightly at midnight.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Logging</td>
<td>Specifies whether you want to enable logging on this engine or virtual host.</td>
</tr>
</tbody>
</table>
**Field Name** | **Description**
--- | ---
Directory | Specifies the absolute or relative pathname of a directory in which tc Runtime creates the log files. If you specify a relative pathname, it is relative to $CATALINA_BASE. The default value is $CATALINA_BASE/logs.

Pattern | A formatting layout identifying the various information fields from the request and response to be logged, or the word "common" or "combined" to select a standard format. Note that the optimized access does only support "common" and "combined" as the value for this attribute.

File Name Prefix | Specifies the prefix added to the start of each log file's name. The default value is "access_log." Leave the field blank if you do not want a prefix.

File Name Suffix | Specifies the suffix added to the end of each log file's name. Leave the field blank if you do not want a suffix (default behavior).

File Date Format | Specifies a customized date format in the access log file name. The date format also specifies how often the file is rotated. For example, if you want the log files to rotate every hour, then set this value to: yyyy-MM-dd.HH

**ui-tcserv. ServerJDBCRef**

**tc Runtime JDBC Reference**

This page provides reference information about the fields on the Views > Server Configuration > Resources tab used to configure and create JDBC data sources.

SpringSource tc Runtime provides two types of JDBC datasources: the standard DBCP one and a Tomcat datasource for highly-concurrent environments. For additional information about the two types of datasources, see Configuring and Creating JDBC Data Sources.

**General Properties**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JNDI Name</td>
<td>The JNDI path to which this data source is bound. By default, the JNDI name is the name of the data source.</td>
</tr>
</tbody>
</table>

**Connection Properties**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>The username that the JDBC driver uses to establish a connection to the database server.</td>
</tr>
<tr>
<td>Password</td>
<td>The password that the JDBC driver uses to establish a connection to the database server.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>URL</td>
<td>The connection URL that the JDBC driver uses to establish a connection to the database server. This URL varies for each type of database driver. An example for the MySQL database is: jdbc:mysql://localhost:3306/javatest?autoReconnect=true</td>
</tr>
<tr>
<td>Driver Class Name</td>
<td>The fully qualified name of the JDBC driver class used to create the physical database connections in the connection pool. The driver class name varies for the type of JDBC driver. An example of the driver class name for connecting to a MySQL database server is: com.mysql.jdbc.Driver.</td>
</tr>
<tr>
<td>Connection Properties</td>
<td>The connection properties that tc Runtime sends to the JDBC driver when establishing new connections. Format of the string must be [propertyName=property;]</td>
</tr>
<tr>
<td></td>
<td>NOTE - tc Runtime passes the &quot;user&quot; and &quot;password&quot; properties explicitly, so do not include them in this field.</td>
</tr>
</tbody>
</table>

**Tomcat/DBCP Connection Pool Properties**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Auto Commit</td>
<td>Specifies whether connections created by this pool are by default in an auto-commit state.</td>
</tr>
<tr>
<td>Default Read Only</td>
<td>Specifies whether connections created by this pool are by default read only.</td>
</tr>
<tr>
<td>Default Transaction Isolation</td>
<td>Specifies the default transaction isolation state for connections created by this pool. Values can be: NONE: Transactions are not supported. READ_COMMITTED: Dirty reads are prevented; non-repeatable reads and phantom reads can occur. READ_UNCOMMITTED: Dirty reads, non-repeatable reads and phantom reads can occur. REPEATABLE_READ: Dirty reads and non-repeatable reads are prevented; phantom reads can occur. Serializable: Dirty reads, non-repeatable reads and phantom reads are prevented. Default value depends on the database driver.</td>
</tr>
<tr>
<td>Default Catalog</td>
<td>Specifies the default catalog of connections created by this pool.</td>
</tr>
<tr>
<td>Initial Number of Connections</td>
<td>Specifies the initial number of connections that are created when tc Runtime starts this connection pool. Default value is 0 (DBCP datasource) or 10 (Tomcat datasource).</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Max Active Connections</td>
<td>Specifies the maximum number of active connections that tc Runtime can allocate from this pool at the same time. Specify a negative number for no limit. Default value is 8 (DBCP datasource) or 100 (Tomcat datasource).</td>
</tr>
<tr>
<td>Max Idle Connections</td>
<td>Specifies the maximum number of connections that can remain idle in the pool without any extra ones being released. Specify a negative number for no limit. Default value is 8 (DBCP datasource) or 100 (Tomcat datasource).</td>
</tr>
<tr>
<td>Min Idle Connections</td>
<td>Specifies the minimum number of connections that can remain idle in the pool without any extra ones being created. Specify 0 to create none. Default value is 0 (DBCP datasource) or 10 (Tomcat datasource).</td>
</tr>
<tr>
<td>Max Wait Time For Connection Borrow</td>
<td>The maximum number of milliseconds that the connection pool waits (when there are no available connections) for a connection to be returned before throwing an exception. Specify -1 to wait indefinitely. Default value is -1 (DBCP datasource) or 30000 (Tomcat datasource).</td>
</tr>
<tr>
<td>Validation Query</td>
<td>The SQL query that the driver uses to validate connections from this pool before returning them to the caller. If specified, this query MUST be an SQL SELECT statement that returns at least one row.</td>
</tr>
<tr>
<td>Test on Borrow</td>
<td>Specifies whether tc Runtime validates objects before being borrowed from the pool. If the object fails to validate, tc Runtime drops it from the pool and attempts to borrow another.</td>
</tr>
<tr>
<td>Test on Return</td>
<td>Specifies whether tc Runtime validates objects before returning them to the connection pool.</td>
</tr>
<tr>
<td>Test While Idle</td>
<td>Specifies whether the idle object evictor validates objects. If an object fails to validate, tc Runtime drops it from the connection pool.</td>
</tr>
<tr>
<td>Time Between Eviction Runs</td>
<td>The number of milliseconds to sleep between runs of the idle object evictor thread. When non-positive, tc Runtime does not run an idle object evictor thread. Default value is -1 (DBCP datasource) or 5000 (Tomcat datasource).</td>
</tr>
<tr>
<td>Test Per Eviction Runs</td>
<td>The number of objects to examine during each run of the idle object evictor thread (if any). Default value is 3.</td>
</tr>
<tr>
<td>Min Evictable Idle Time</td>
<td>The minimum amount of time, in milliseconds, that an object may sit idle in the pool before it is eligible for eviction by the idle object evictor (if any).</td>
</tr>
</tbody>
</table>

**NOTE** - for a value in this field to have any effect, you must set the Validation Query field to a non-null string.
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pool Prepared Statements</td>
<td>Enables prepared statement pooling for this connection pool.</td>
</tr>
<tr>
<td>Max Opened Prepared Statements</td>
<td>The maximum number of open statements that can be allocated from the statement pool at the same time. Set this field to 0 for no limit. Default value is 0.</td>
</tr>
<tr>
<td>Allow Access to Underlying Connection</td>
<td>Specifies whether the PoolGuard allows access to the underlying connection.</td>
</tr>
<tr>
<td>Remove Abandoned Connections</td>
<td>Specifies whether tc Runtime should remove abandoned connections if they exceed the value of the Remove Abandoned Timeouts field. If checked, a connection is considered abandoned and eligible for removal if it has been idle longer than the value of Remove Abandoned Timeouts. Checking this field can recover database connections from poorly written applications which fail to close a connection.</td>
</tr>
<tr>
<td>Remove Abandoned Timeouts</td>
<td>Specifies the amount of time, in seconds, before tc Runtime can remove an abandoned connection. Default value is 300 seconds.</td>
</tr>
<tr>
<td>Log Abandoned Statements and Connections</td>
<td>Specifies whether tc Runtime should log stack traces for application code that abandoned a Statement or Connection.</td>
</tr>
<tr>
<td>Log Abandoned Statements and Connections</td>
<td><strong>NOTE:</strong> Logging of abandoned Statements and Connections adds overhead for every Connection open or new Statement because a stack trace has to be generated.</td>
</tr>
<tr>
<td>Validation Interval (ms)</td>
<td><strong>Tomcat datasource only.</strong> Specifies the time, in milliseconds, that tc Runtime waits before running a validation check to ensure that the JDBC connection is still valid. Too frequent validation checks can slow performance. Default value for this field is 30000 (30 seconds).</td>
</tr>
<tr>
<td>Fair Queue</td>
<td><strong>Tomcat datasource only.</strong> Specifies that calls to getConnection() should be treated fairly in a true FIFO (first in, first out) fashion. You are required to enable this feature if you want to use the asynchronous connection retrieval feature, which is the ability to queue your connection request.</td>
</tr>
<tr>
<td>JMX Enabled</td>
<td><strong>Tomcat datasource only.</strong> Specifies whether the connection pool is registered with the JMX server.</td>
</tr>
<tr>
<td>Use equals comparison</td>
<td><strong>Tomcat datasource only.</strong> Specifies whether the ProxyConnection class should use String.equals() instead of == when comparing method names. Does not apply to added interceptors as those are configured individually.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Init SQL</td>
<td>Tomcat datasource only. Specifies an initial SQL statement that is run only when a connection is first created. You can use this feature to setup session settings that you want to exist during the entire time the connection is established.</td>
</tr>
<tr>
<td>JDBC Interceptors</td>
<td>Tomcat datasource only. Semi-colon separated list of classnames that tc Runtime inserts as interceptors in the chain of operations on the java.sql.Connection object. The interceptor classes must extend the abstract class: org.apache.tomcat.jdbc.pool.JdbcInterceptor. SpringSource tc Runtime provides a JDBC Interceptor called SlowQueryReportJmx that keeps a report of slow JDBC queries, or JDBC queries that did not complete below a configured time threshold. If you want AMS to display this report in its Console, then you must add the SlowQueryReportJmx interceptor to this text field. For example, to add it to the default interceptors, enter this value: ConnectionState;StatementFinalizer;SlowQueryReportJmx. The default threshold for the SlowQueryReportJmx interceptor is 5000 milliseconds. If you want to change the default value, include it as a parameter to the interceptor, as shown: ConnectionState;StatementFinalizer;SlowQueryReportJmx(threshold=6000). After you have configured the SlowQueryReportJmx interceptor, AMS creates and auto-discovers a service called &quot;JDBC Query Report&quot; that contains information about slow JDBC queries.</td>
</tr>
</tbody>
</table>

**ui-vSphere**

This page describes HQ vSphere page, enabled by the vSphere plug-in in VMware vCenter™ Hyperic®. This page is present in the Hyperic user interface only if you have vSphere components under management.
About the HQ vSphere Page

The HQ vSphere page is an interface for monitoring and managing vSphere Hosts and VMs available in vCenter Hyperic.

"Performance data not available?"
The Performance tab appears for a VM only if there is an Hyperic Agent running in the VM.

Display the HQ vSphere Page

To display the HQ vSphere page, select HQ vSphere from the Resources tab in the masthead.

Note: The HQ vSphere option appears on the Resources tab only if you have vSphere components under management.

You can also navigate to the HQ vSphere page from the Resource Hub. The resource page for a vCenter server or vSphere Host has a View in HQ vSphere link above the Monitor tab.

HQ vSphere and Resource Permissions

In vCenter Hyperic, a user can only access resources that are assigned to groups to which the user's role grants access. The accessible resources are further limited by the role's permissions to inventory types.

In other words, you can see PlatformA in browse dialogs and navigate to it if: (1) it is a member of a group assigned to your role, and (2) that role grants access to platforms.

The HQ vSphere user interface behaves somewhat differently: if you have view access to platforms, you can see all of the vSphere Hosts and vSphere VMs in the deployment whether or not they belong to a group assigned to your role.

Note also that even if your role does not grant view permission to servers, vCenter servers will appear in the HQ vSphere page. A vCenter server is the root of the vSphere resource hierarchy and is visible regardless of role permissions; the only resource data exposed for the vCenter server is its name.

HQ vSphere Inventory Tab

The Inventory tab on the HQ vSphere page is a tree of the vSphere resources under HQ management, organized in the resource type hierarchy shown below. The lowest level appears for a VM that has an Hyperic Agent running and monitoring resources running in the VM.

The contents of the Inventory tab are updated once per minute.

You can use the Inventory tab to view the virtual resource hierarchy and to navigate among resources. When you select a resource, the tab or tabs on the right side of the page contain resource data, performance charts, and resource control commands, as appropriate to the resource type.
The table below shows the vSphere resource type hierarchy; the right column indicates the inventory level for a type in the Hyperic inventory model.

<table>
<thead>
<tr>
<th>vSphere Resource Hierarchy</th>
<th>Inventory Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware vCenter</td>
<td>server</td>
</tr>
<tr>
<td>VMware vSphere Host</td>
<td>platform</td>
</tr>
<tr>
<td>VMware vSphere VM</td>
<td>platform</td>
</tr>
<tr>
<td>Hyperic Agent-managed resource in VM</td>
<td>server</td>
</tr>
</tbody>
</table>

**Icons in the vSphere Inventory Tab**

The icon to the left of an item in the resource tree indicates the type of the resource, and for a VM, its availability status. For information about how VM availability is determined, see [VMware vSphere VM Metrics](#) below.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="VCenter" /></td>
<td>vCenter Server</td>
</tr>
<tr>
<td><img src="image" alt="vSphere" /></td>
<td>vSphere Host</td>
</tr>
<tr>
<td><img src="image" alt="Up" /></td>
<td>VM whose availability is Up</td>
</tr>
<tr>
<td><img src="image" alt="Paused" /></td>
<td>VM whose availability isPaused</td>
</tr>
<tr>
<td><img src="image" alt="Powered Off" /></td>
<td>VM whose availability is Powered Off</td>
</tr>
<tr>
<td><img src="image" alt="Down" /></td>
<td>VM whose availability status is Down</td>
</tr>
<tr>
<td><img src="image" alt="Unknown" /></td>
<td>VM whose availability status is Unknown</td>
</tr>
<tr>
<td><img src="image" alt="Agent" /></td>
<td>A Hyperic-managed resource running in a VM that has an Hyperic Agent running in it.</td>
</tr>
</tbody>
</table>

**HQ vSphere Summary Tab**

The **Summary** tab, available when any resource in the **Inventory** tab is selected, displays properties for the selected resource, and its parent resource, as applicable.

**Jump to Resource Hub View of a Resource**

To view a vSphere resource in the Hyperic resource hub — for instance to visit its **Inventory** or **Alert** page — click the **view resource** link to the right of the resource name.

**Summary Tab for vCenter**

When a vCenter Server instance is selected in the HQ vSphere page, the **Summary** tab contains the name of the vCenter instance. You can view inventory and configuration properties for the vCenter instance in the Resource Hub — click **view resource** next to the resource name to view it in the Resource Hub.
**Summary Tab for vSphere Hosts**

The **Summary** tab for a vSphere Host displays the following properties:

- Host Information
- Hostname
- Location
- Manufacturer
- Model
- VMware Version
- Processor Details
- Type - of the processor
- CPUs - Processor sockets and cores per socket
- Network Details
- IP Address
- Default Gateway
- DNS - primary and secondary DNS server

**Summary Tab for vSphere VM**

The **Summary** tab for a vSphere VM displays the following VM properties:

- VM Information
- Hostname - of the vSphere Host (ESX platform) where the VM runs
- Guest OS - operating system running in the VM
- vCPU(s) - number of virtual processors in the VM
- Memory - VM memory, in MB
- MAC Address
- IP - VM's IP address
- VM Version - virtual machine hardware version
- Tools Version - version of VMware Tools on the VM.
- Config Details
- ESX Host - IP address of the vSphere Host (ESX platform) where the VM runs
- Resource Pool - resource pool with which the VM is associated
- Config File - path to the VM configuration (.vmx) file, expressed using the symbolic link path to the VMFS volume where the file is stored
- Properties for the vSphere Host where the VM runs, described above in **Summary Tab for vSphere Hosts**, are shown below the VM properties.

If the VM does not have an Hyperic Agent running in it, the **Summary** tab has a "Performance data not available" near the top of the page.

**Summary Tab for a Managed Resource in the VM**

This information applies to a VM with a running Hyperic Agent that is managing resources in the VM. Otherwise, resources running in the VM do not appear in the HQ vSphere page.
When you select a managed resource running in a VM, the **Summary** tab displays the vSphere Host and VM properties described in *Summary Tab for vSphere VM*.

The contents of the **Summary** tab are updated once per minute.

To view inventory properties for the managed resource itself, click the **view resource** link next to the resource name to view the resource in the Resource Hub.

**HQ vSphere Performance Tab**

The **Performance** tab appears when a vSphere Host is selected, and, if the VMs running on the host have Hyperic Agents running, for each VM, and for the managed resources running in the VMs.

The contents of the **Performance** tab are updated once per minute.

---

If a VM does not have an agent running in it, no **Performance** tab appears. You can view the VM metrics in its **Monitor** page in the Resource Hub. Click **view resource** next to the "Hostname" property on the VM's **Summary** tab.

---

**View Metrics**

The **Performance** tab displays an **Availability** bar, and a chart for each metric currently enabled for the selected resource type.

The tables in *VMware vSphere Host Metrics* list the supported vSphere metrics and default settings.

Twelve hours' history is displayed by default. You can use the **Data Range** pull-down to set the display range to the most recent:

- 1, 4, or 12 hours
- 1 or 2 days,
- 1 week, or
- 1 month

**Correlate Metrics**

On the **Performance** tab for a VM or an Hyperic Agent-managed resource running in the VM, you can use the **Compare** pull-down to correlate the selected resource's performance with its parent or grandparent. You can:

- **Compare each VM metric with its vSphere Host equivalent** — For example compare the VM's "Disk Usage (Average)" metric to its host's "Disk Usage (Average)" metric; the VM's "CPU Usage (Average)" metric to its host's "CPU Usage (Average)" metric; and so on.
- **Compare each VM metric to a selected vSphere Host metric** — For example, compare each VM metric to the "Disk Usage (Average)" metric of its vSphere host.
- **Compare metrics for a managed resource in the VM with performance of the VM or the vSphere host** — Use the **Compare** pull-down to select a VM or Host metric - the charts for the managed resource metrics will be overlayed with the line for the selected VM or host metric. The screen shot is an example in which the vSphere Hosts's "CPU Usage (Average)" counter is overlayed on each Hyperic Agent metric chart.

**HQ vSphere Control Tab**

The **Control** tab appears when a VM is selected (if there is an Hyperic Agent running in the VM) and allows you to issue a control command to the VM. See [Management Functions for VMware vSphere VM](#) for information about the supported control actions.

If a VM does not have an agent running in it, no **Control** tab appears. You can run control actions from the "Control" page for the VM in the Resource Hub. Click **view resource** next to the "Hostname" property on the VM's **Summary** tab.

**Metrics**

**VMware vSphere Host Metrics**

<table>
<thead>
<tr>
<th>Name</th>
<th>Alias</th>
<th>vCenter Statistics Level</th>
<th>Definition</th>
<th>Units</th>
<th>Category</th>
<th>Default On</th>
<th>Default Interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability</td>
<td>Availability</td>
<td>n/a, Availability is determined by HQ; it is not a vCenter statistic.</td>
<td>The plug-in determines a vSphere Host's availability by querying vCenter for the host's power state, once per minute, by default. Availability takes these values: If the power state is: Up — if vSphere Host power state is poweredOn. Paused — if vSphere Host power state is standby. Powered Off — if vSphere Host power state is poweredOff. Down — if the vSphere Host power state is none of the above.</td>
<td>percent</td>
<td>AVAILABILITY</td>
<td>true</td>
<td>1 min</td>
</tr>
<tr>
<td>Uptime</td>
<td>sysuptime</td>
<td>latest</td>
<td>sec</td>
<td>AVAILABILITY</td>
<td>false</td>
<td>1 min</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Alias</td>
<td>vCenter Statistics Level</td>
<td>Definition</td>
<td>Units</td>
<td>Category</td>
<td>Default On</td>
<td>Default Interval</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------</td>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>-----------</td>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td>CPU Usage (Average)</td>
<td>cpu.usage.average</td>
<td>1</td>
<td>CPU usage as a percentage during the interval. Actively used CPU of the host, as a percentage of the total available CPU. Active CPU is approximately equal to the ratio of the used CPU to the available CPU. Available CPU = # of physical CPUs × clock rate 100% represents all CPUs on the host. For example, if a four-CPU host is running a virtual machine with two CPUs, and the usage is 50%, the host is using two CPUs completely.</td>
<td>percent</td>
<td>UTILIZATION</td>
<td>true</td>
<td>5 min</td>
</tr>
<tr>
<td>Disk Usage (Average)</td>
<td>disk.usage.average</td>
<td>1</td>
<td>Aggregated disk I/O rate. For a vSphere host, this includes the rates for all virtual machines running on the host during the collection interval.</td>
<td>KB per second</td>
<td>UTILIZATION</td>
<td>true</td>
<td>5 min</td>
</tr>
<tr>
<td>Highest Disk Latency</td>
<td>disk.maxTotalLatency.latest</td>
<td>1</td>
<td>Highest latency value across all disks used by the host. Latency measures the time taken to process a SCSI command issued by the guest OS to the virtual machine. The kernel latency is the time VMkernel takes to process an IO request. The device latency is the time it takes the hardware to handle the request. Total latency = kernelLatency + deviceLatency</td>
<td>ms</td>
<td>UTILIZATION</td>
<td>true</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Usage (Average)</td>
<td>mem.usage.average</td>
<td>1</td>
<td>memory usage = memory consumed + host configured memory size</td>
<td>percent</td>
<td>UTILIZATION</td>
<td>true</td>
<td>5 min</td>
</tr>
<tr>
<td>Name</td>
<td>Alias</td>
<td>vCenter Level</td>
<td>Definition</td>
<td>Units</td>
<td>Category</td>
<td>Default On</td>
<td>Default Interval</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------</td>
<td>-------------</td>
<td>------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Network Usage (Average)</td>
<td>net.usage.aver age</td>
<td>1</td>
<td>Sum of the data transmitted and received during the collection interval. Sum of data transmitted and received across all physical NIC instances connected to the host.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>true</td>
<td>5 min</td>
</tr>
<tr>
<td>CPU Reserved Capacity</td>
<td>cpu.reserved.capacity.aver age</td>
<td>2</td>
<td>Total CPU capacity reserved by the virtual machines.</td>
<td>none</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>CPU Throttled (1 min. Average)</td>
<td>rescpu.maxLimit1.last</td>
<td>3</td>
<td></td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>CPU Throttled (5 min. Average)</td>
<td>rescpu.maxLimit5.last</td>
<td>3</td>
<td></td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>CPU Throttled (15 min. Average)</td>
<td>rescpu.maxLimit15.last</td>
<td>3</td>
<td></td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>CPU Running (1 min. Average)</td>
<td>rescpu.runav1.last</td>
<td>3</td>
<td></td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>CPU Running (5 min. Average)</td>
<td>rescpu.runav5.last</td>
<td>3</td>
<td></td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>CPU Running (15 min. Average)</td>
<td>rescpu.runav15.last</td>
<td>3</td>
<td></td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Name</td>
<td>Alias</td>
<td>vCenter Statistics Level</td>
<td>Definition</td>
<td>Units</td>
<td>Category</td>
<td>Default On</td>
<td>Default Interval</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------</td>
<td>----------</td>
<td>------------</td>
<td>------------------</td>
</tr>
<tr>
<td>CPU Active (1 min. Average)</td>
<td>rescpu.active1.lat</td>
<td>3</td>
<td>Sum of memory swapin of all powered on VMs on the host.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>CPU Active (5 min. Average)</td>
<td>rescpu.active5.lat</td>
<td>3</td>
<td>Sum of Memory Swap Out of all powered on VMs on the host.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>CPU Active (15 min. Average)</td>
<td>rescpu.active15.lat</td>
<td>3</td>
<td>Amount of memory that is used by swap. Sum of Memory Swapped of all powered on virtual machines and vSphere services on the host.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Balloon</td>
<td>mem.vm.memctl.ave</td>
<td>1</td>
<td>Sum of Memory Balloon (Amount of memory allocated by the virtual machine memory control driver) of all powered on virtual machines and vSphere services on the host. If the balloon target value is greater than the balloon value, the VMkernel inflates the balloon, causing more virtual machine memory to be reclaimed. If the balloon target value is less than the balloon value, the VMkernel deflate the balloon, which allows the virtual machine to consume additional memory if needed.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>true</td>
<td>5 min</td>
</tr>
<tr>
<td>Name</td>
<td>Alias</td>
<td>vCenter Statistics Level</td>
<td>Definition</td>
<td>Units</td>
<td>Category</td>
<td>Default On</td>
<td>Default Interval</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------</td>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------</td>
<td>---------------</td>
<td>------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Memory Unreserved</td>
<td>mem.unreserve.d.aver</td>
<td>2</td>
<td>Amount of memory that is unreserved. Memory reservation not used by the Service Console, VMkernel, vSphere services and other powered on VMs' user-specified memory reservations and overhead memory.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Heap</td>
<td>mem.heap.aver</td>
<td>2</td>
<td>Amount of VMkernel virtual address space dedicated to VMkernel main heap and related data.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Heap Free</td>
<td>mem.heapfree.aver</td>
<td>2</td>
<td>Amount of free address space in the VMkernel's main heap. Heap Free varies, depending on the number of physical devices and various configuration options. There is no direct way for the user to increase or decrease this statistic.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Overhead</td>
<td>mem.overhead.aver</td>
<td>1</td>
<td>Total of all overhead metrics (Amount of additional machine memory allocated to a virtual machine for overhead. The overhead amount is beyond the reserved amount), for powered-on virtual machines, plus the overhead of running vSphere services on the host.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Zero</td>
<td>mem.zero.aver</td>
<td>2</td>
<td>Amount of memory that is zeroed out (contains only 0s). This statistic is included in Memory Shared. For a vSphere Host, Sum of Memory Zero of all powered on VMs and vSphere services on the host.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Reserved Capacity</td>
<td>mem.reservedC.aver</td>
<td>2</td>
<td>Total amount of memory reservation used by powered on VMs and vSphere services on the host. Includes overhead amount.</td>
<td>MB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Name</td>
<td>Alias</td>
<td>vCenter Statistics Level</td>
<td>Definition</td>
<td>Units</td>
<td>Category</td>
<td>Default On</td>
<td>Default Interval</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------</td>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------</td>
<td>----------</td>
<td>------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Memory Active</td>
<td>mem.active.aver</td>
<td>2</td>
<td>Amount of memory actively used, as estimated by VMkernel. Active memory is based on the current workload of the virtual machine or host. For a vSphere Host, sum of the active guest physical memory of all powered on virtual machines on the host, plus memory used by basic VMKernel applications on the host.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>true</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Shared</td>
<td>mem.shared.aver</td>
<td>2</td>
<td>Sum of the shared memory values of all powered-on virtual machines, plus the amount for the vSphere services on the host. The host's Memory Shared may be larger than the amount of machine memory if memory is overcommitted (the aggregate virtual machine configured memory is much greater than machine memory). The value of this statistic reflects how effective transparent page sharing and memory overcommitment are for saving machine memory.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>true</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Granted</td>
<td>mem.granted.aver</td>
<td>2</td>
<td>The total of all granted metrics for all powered-on virtual machines, plus memory for vSphere services on the host.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Consumed</td>
<td>mem.consumed.aver</td>
<td>1</td>
<td>Amount of machine memory used on the host. Consumed memory includes memory used by virtual machines, the service console, VMkernel, and vSphere services, plus the total consumed memory for all running virtual machines. host consumed memory = total host memory - free host memory</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Name</td>
<td>Alias</td>
<td>vCenter Statistics Level</td>
<td>Definition</td>
<td>Units</td>
<td>Category</td>
<td>Default On</td>
<td>Default Interval</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------</td>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------</td>
<td>----------</td>
<td>------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Memory State</td>
<td>mem.state.latest</td>
<td>2</td>
<td>Amount of free machine memory on the host. VMkernel has four free-memory thresholds that affect the mechanisms used for memory reclamation. 0 (High) - Free memory &gt;= 6% of machine memory - service console memory 1 (Soft) - Free memory &gt;= 4% of machine memory - service console memory 2 (Hard) - Free memory &gt;= 2% of machine memory - service console memory 3 (Low)- Free memory &gt;= 1% of machine memory - service console memory For 0 and 1, swapping is favored over ballooning. For 2 and 3, ballooning is favored over swapping.</td>
<td>none</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Shared Common</td>
<td>mem.sharedcommon.average</td>
<td>2</td>
<td>Amount of machine memory that is shared by all powered-on virtual machines and vSphere services on the host. Memory Shared - Memory Shared Common = Host memory saved by sharing</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Used by vmkernel</td>
<td>mem.sysUsage.average</td>
<td>2</td>
<td>Amount of memory used by the VMkernel. Amount of machine memory used by the VMkernel for &quot;core&quot; functionality (such as its own internal uses, device drivers, etc). It does not include memory used by VMs or by vSphere services.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
</tr>
<tr>
<td>Name</td>
<td>Alias</td>
<td>vCenter Statistics Level</td>
<td>Definition</td>
<td>Units</td>
<td>Category</td>
<td>Default On</td>
<td>Default Interval</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------------</td>
<td>------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Availability</td>
<td>Availability</td>
<td>n/a, Availability is determined by HQ; it is not a vCenter statistic.</td>
<td>The plug-in determines a VM's availability by querying vCenter for a VM power state, once per minute, by default. Availability takes these values: If the power state is: Up — if VM power state is poweredOn. Paused — if VM power state is standby. Powered Off — if VM power state is poweredOff. Unknown — if the VM power state is none of the above. Down — if VM availability was not reported for a duration equal to, or greater than, twice the configured collection interval, which is 1 minute, by default.</td>
<td>percent</td>
<td>AVAILABILITY</td>
<td>true</td>
<td>1 min</td>
</tr>
<tr>
<td>Uptime</td>
<td>sys.uptime.lates</td>
<td>1</td>
<td></td>
<td>sec</td>
<td>AVAILABILITY</td>
<td>false</td>
<td>1 min</td>
</tr>
<tr>
<td>CPU Usage (Average)</td>
<td>cpu.usage.average</td>
<td>1</td>
<td>CPU usage as a percentage during the interval.</td>
<td>percent</td>
<td>UTILIZATION</td>
<td>true</td>
<td>5 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This value is reported with 100% representing all processor cores on the system. As an example, a 2-way VM using 50% of a four-core system is completely using two cores.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk Usage (Average)</td>
<td>disk.usage.average</td>
<td>1</td>
<td>Aggregated disk I/O rate.</td>
<td>KB per second</td>
<td>UTILIZATION</td>
<td>true</td>
<td>5 min</td>
</tr>
<tr>
<td>Memory Usage (Average)</td>
<td>mem.usage.average</td>
<td>1</td>
<td>The percentage of memory used as a percent of all available machine memory.</td>
<td>percent</td>
<td>UTILIZATION</td>
<td>true</td>
<td>5 min</td>
</tr>
<tr>
<td>Network Usage (Average)</td>
<td>net.use.averag.e</td>
<td>Sum of the data transmitted and received during the collection interval.</td>
<td>KB</td>
<td>UTILIZATION</td>
<td>true</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------</td>
<td>---------------------------------------------------------------------</td>
<td>----</td>
<td>-------------</td>
<td>------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>CPU Throttled (1 min. Average)</td>
<td>rescpu.maxLimi.ted1.late.st</td>
<td>3</td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>CPU Throttled (5 min. Average)</td>
<td>rescpu.maxLimi.ted5.late.st</td>
<td>3</td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>CPU Throttled (15 min. Average)</td>
<td>rescpu.maxLimi.ted15.late.st</td>
<td>3</td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>CPU Running (1 min. Average)</td>
<td>rescpu.runav1.la.test</td>
<td>3</td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>CPU Running (5 min. Average)</td>
<td>rescpu.runav5.la.test</td>
<td>3</td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>CPU Running (15 min. Average)</td>
<td>rescpu.runav15.la.test</td>
<td>3</td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>CPU Active (1 min. Average)</td>
<td>rescpu.actav1.la.test</td>
<td>3</td>
<td>percent</td>
<td>UTILIZATION</td>
<td>false</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>Metric</td>
<td>Value</td>
<td>Description</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CPU Active (5 min. Average)</strong></td>
<td>3</td>
<td><strong>percent UTILIZATION false 5 min</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CPU Active (15 min. Average)</strong></td>
<td>3</td>
<td><strong>percent UTILIZATION false 5 min</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Memory Swap In</strong></td>
<td>2</td>
<td>Average memory Swap In. A large number here represents a problem with lack of memory and a clear indication that performance is suffering as a result.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Memory Swap Out</strong></td>
<td>2</td>
<td>Average Memory Swap Out. A large number here represents a problem with lack of memory and a clear indication that performance is suffering as a result.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Memory Balloon</strong></td>
<td>1</td>
<td>Sum of Memory Balloon (Amount of memory allocated by the virtual machine memory control driver)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Memory Balloon Target</strong></td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If the balloon target value is greater than the balloon value, the VMkernel inflates the balloon, causing more virtual machine memory to be reclaimed. If the balloon target value is less than the balloon value, the VMkernel deflates the balloon, which allows the virtual machine to consume additional memory if needed.
<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
<th>Unit</th>
<th>Utilization</th>
<th>Datasearchable</th>
<th>Timeframe</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Zero</td>
<td>Amount of memory that is zeroed out (contains only 0s). This statistic is included in Memory Shared. For a vSphere Host, Sum of Memory Zero of all powered on VMs and vSphere services on the host.</td>
<td>KB</td>
<td>false</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>Memory Active</td>
<td>Amount of memory actively used, as estimated by VMkernel. Active memory is based on the current workload of the virtual machine or host. For a vSphere Host, sum of the active guest physical memory of all powered on virtual machines on the host, plus memory used by basic VMKernel applications on the host.</td>
<td>KB</td>
<td>true</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>Memory Shared</td>
<td>The average amount of shared memory. Shared memory represents the entire pool of memory from which sharing savings are possible. The amount of memory that this has been condensed to is reported in shared common memory. So, total saving due to memory sharing equals shared memory minus shared common memory.</td>
<td>KB</td>
<td>true</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>Memory Granted</td>
<td>The amount of memory that was granted to the VM by the host. Memory is not granted to the host until it is touched one time and granted memory may be swapped out or ballooned away if the VMkernel needs the memory.</td>
<td>KB</td>
<td>false</td>
<td>5 min</td>
<td></td>
</tr>
</tbody>
</table>
The amount of machine memory that is in use by the VM.

While a VM may have been configured to use 4 GB of RAM, as an example, it might have only touched half of that. Of the 2 GB left, half of that might be saved from memory sharing. That would result in 1 GB of consumed memory.
Live Exec

This page describes the Live Exec pages in the VMware vCenter™ Hyperic® user interface, available on the Views menu for platform types.

Live Exec Commands

**Live Exec** view allows you to run system commands on a managed platform, or a group of platforms.

**Live Exec** uses SIGAR — an API for gathering system information in real-time. The table below describes the queries you can run from **Live Exec**.

<table>
<thead>
<tr>
<th>Command</th>
<th>Data Returned</th>
</tr>
</thead>
<tbody>
<tr>
<td>cpuinfo</td>
<td>All CPUs on a platform.</td>
</tr>
<tr>
<td>cpuperc</td>
<td>Usage percentages on each CPU and related data. Equivalent to <code>uptime</code> command.</td>
</tr>
<tr>
<td>df</td>
<td>All filesystems on a platform. This does not list disk-usage percentages.</td>
</tr>
<tr>
<td>ifconfig</td>
<td>Network statistics on each of the platform's network interfaces</td>
</tr>
<tr>
<td>netstat</td>
<td>Active socket connections on the platform</td>
</tr>
<tr>
<td>top</td>
<td>All processes (that the Hyperic Agent can see) running on the platform.</td>
</tr>
<tr>
<td>who</td>
<td>Logged-in users</td>
</tr>
</tbody>
</table>

### Run Live Exec on a Platform or Group of Platforms

To run **Live Exec**:

1. Navigate to a platform, or a group of platforms in the Resource Hub.
2. Click the resource's Views tab.
3. On the Views tab, click **Live Exec**.
   
   The **Live Exec** page appears. Available queries are listed in the left page.
   
   If the selected resource is a group, the individual platforms in the group appear as well. You can select individual platforms within the group.
4. Select a command from the Please select a query to run dropdown menu.
   
   Command results appear in the right side of the page.
   
   If the resource is an individual platform, the results pane includes its name, with the name of the platform and the selected command listed about the data table.
5. (Optional) In the case of a group:
   - If a member of the group has not previously been selected, click 🔄 next to a specific platform now. That platform will be displayed first by default for subsequent commands.
   - If a member of a group is not available, 🔄 is displayed next to the resource, and, when it is clicked, the reason why it is unavailable is displayed at the right.
   - To view the real-time data for another platform in the group, click 🔄 next to that platform. The platform for which data is currently being displayed is highlighted at the left.

If the Hyperic Agent cannot reach the platform, an error message is displayed.

**ui-Views.AgentCommands**

You can run Hyperic Agent control commands for a single agent, or for a group of agents from the user interface.

**Restart an Agent or a Group of Agents**

1. Navigate to the Hyperic Agent or group of agents.
2. Click the Views tab.
3. Click Agent Commands.
4. Select the restart command.
5. Click Execute.

This command invokes the agent's Java Service Wrapper's *restart *command, which shuts down the JVM process in which the agent runs, waits for the process to terminate cleanly, and spawns a new JVM process for the agent. During the restart process, the agent's metric collection and resource control functionality will be interrupted.

The restart command happens asynchronously. To verify successful restart, navigate to the agent in the Hyperic user interface check its availability.

**Ping an Agent or a Group of Agents**

1. Navigate to the Hyperic Agent or group of agents.
2. Click the Views tab.
3. Click Agent Commands.
4. Select the ping command.
5. Click Execute.

This command invokes the agent's Java Service Wrapper's ping command on the agent.

If the ping is not successful, this message appears in the Result pane on the right side of the page:
Failed to send ping command to agent with id nnnnn. Reason: Unable to connect to AgentIpAddress.

If the ping is successful, this message appears in the Result pane on the right side of the page:
Successfully sent ping command to agent with id nnnnn.
Upgrade an Agent or Group of Agents to a Newer Version

1. Navigate to the Hyperic Agent or group of agents.
2. Click the Views tab.
3. Click Agent Commands.
4. Select the upgrade command.
5. Select a bundle from the agent bundle pull-down list.
6. Click Execute.

The selected agent bundle is transferred from the Hyperic Server to the target agent(s).

The agent expands the bundle locally.

The agent updates the local bundle property.

The server restarts the agent.

The configuration settings in the agent.properties file are preserved.

Push a Plug-in to an Agent or Group of Agents

This operation allows you to transfer new, custom, updated, or patched plug-ins from the Hyperic Server's ServerHome/hq-engine/hq-server/webapps/ROOT/WEB-INF/hq-plug-ins directory to the target agents' AgentHome/bundles/AgentBuildDir/pdk/plug-ins directory. Pushing a plug-in to an agent results in an agent restart.

1. Navigate to the Hyperic Agent or group of agents.
2. Click the Views tab.
3. Click Agent Commands.
4. Select the push plug-in command.
5. Select a plug-in from the plug-in pull-down list.
6. Click Execute.

ui-Views.GemFire

The vCenter™ Hyperic® GemFire plug-in provides a live data user interface for viewing metrics in real-time. (As opposed to the Monitor tab for a GemFire component, which presents metrics that have been saved to the Hyperic database.)

Learn About GemFire Monitoring
See GemFire in vCenter Hyperic Resource Configuration and Metrics.

GemFire View for a DS

The HQ GemFire View for a Distributed System displays the following information.

- Servers in the DS — The number of Cache Servers, Gateway Hubs and Application Peers in the DS.
• Gateways in the DS — If the DS is part of a multi-site deployment, the number of Gateways in the DS's Gateway Hub.
• Clients connected to the DS — The number of clients (Cache Servers, Gateways, or Application Peers) in other Distributed Systems that are connected to the DS.

The table in the middle displays inventory properties and last reported metric values for each server (including Cache Servers, Gateway Hubs and Application Peers) the DS.

GemFire View for a Cache Server or Application Peer

The GemFire View for a Cache Server or Application Peer displays server and region inventory properties and metrics:

• Server metrics — The single row table presents last reported metric values for the Cache Server or Application Peer.
• Region metrics — The multi-row table presents inventory properties and the Entry Count metric for each region the server contains.

GemFire View for a Gateway Hub

The HQ GemFire View for a Gateway Hub displays inventory data and live measurements for the Gateway Hub, the Hubs and Regions it contains, and any clients connected to the Hub.

ui-CurrentlyDown

Currently Down Resources

The Currently Down Resources page, available on the Resource tab is lists resources that are not currently available, up to a maximum of 1000 resources.

Contents of the Currently Down Page

The right pane of the Currently Down Resources pane lists resources that match the filter criteria selected in the "Resource Types" panel on the left, ordered by Down Time, from longest to shortest. Click a column header to sort by that column's contents — except for the "Alerts" column.

By default, the page will list up to 50 resources. You can choose to list up to 100, or up to 1000, using the Show Most Recent control.

The following data is shown for each resource on the list:

• Resource — Name of the down resource. Click to view the resource's Indicators page.
• Type — The resource's platform, server, or service type.
• Down Since — The time at which the resource became unavailable.
• Down Time — The length of time the resource has been unavailable.
• Alerts — Click the icon in this column to see a list of alerts fired for the resource.

Click 💻 at the top right to refresh the page.
Filter Resources of the Currently Down Page
To list all currently unavailable resources of a particular inventory level click one of the top level links in Resource Types pane:

- Platforms
- Servers
- Services

To further narrow the list to unavailable resources of a particular resource type, expand the link

ui-Inventory

ui-Inventory.Server
This page describes the contents of the Inventory page for a server.

Learn about Servers
See Resources, Resource Types and Inventory Types in vCenter Hyperic Overview.

Inventory Page for a Server
To display the Inventory page for a server, use Resources > Browse > Servers to navigate to the server, and click the Inventory tab.

A user can view and modify resources only to the extent that the user's role(s) permit. For more information see User Accounts and Roles in Hyperic in vCenter Hyperic Administration.

Inventory Page Header for a Server
The sections below describe the data and controls that appear at the top of the Inventory page for a server.

Resource Properties
The properties at the top of the Inventory page for a server provide identifying information about the managed product. The inventory properties displayed for a server vary by server type, but typically will include vendor name and software version.

The properties displayed in the screenshot below (for a JBoss server) are:

- Java Vendor
- Owner - By default, the Hyperic user under whose account the resource was added to inventory. Click Change... to assign a different resource owner.
- Build Date
• JBoss Version
• Version Name

The plug-in developer controls which resource properties are displayed at the top of a resource's **Inventory** page: any properties enclosed in a `<properties>` element for a resource type appear in the page header when you browse to an instance of that type.

**Map Control for a Server**

Click the **Map** control in the page header to view the server's child services(s) and its parent platform.

The map in the screenshot above, for a PostgreSQL 8.2 server, shows that:

The server has multiple children of resource type "PostgreSQL 8.2 Table service" - which have been automatically grouped into an autogroup with the same name as the resource type.

The server runs on the platform of type "MacOSX" named "Marie-McGarrys-MacBook-Pro-46.local".

Click the name of a child or parent resource to view its **Monitor** page.

**Tools Menu for a Server**

When a server is selected, the **Tools** menu has the following commands:

• **Configure Server** — Opens the **Configuration Properties** page for the server, where you can edit the resource's configuration properties.
• **Delete Server** — Delete the server and all its child services from inventory.
• **New Service** — Displays the **New Service** page, where you can manually add a new child service to the server. (For instance, a service that was not auto-discovered.)
• **Add to Dashboard Favorites** — Adds the server to the **Favorite Resources** portlet on the the current Hyperic user's Dashboard.
• **Add to Group** — Opens the **Group Manager** page, which lists any compatible groups of the same type as the server.

A user can view and modify resources only to the extent that the user's role(s) permit. For more information see *User Accounts and Roles in Hyperic* in *vCenter Hyperic Administration*. 
General Properties for a Server

The **General Properties** section of the **Inventory** page for a server lists the following information about the server:

- Description — A description of the server. This is an optional, user-configured value.
- Resource type — The server type.
- Date Created — The date the server was added to the Hyperic inventory
- Date Modified, Modified By — The date the server properties were last modified and the user who modified them

Click the **Edit** button to open a page where you can edit the server's Name or Description.

Type and Host Properties

The **Type and Host Properties** section of the **Inventory** page for a server lists the following information about the server:

- Install Path — The path where this server is installed.
- Host Platform — The platform where the server runs.

Click the **Edit** button to open a page where you can edit the server's Install Path.

Services on a Server

The **Services** section of the **Inventory** page for a server contains

The total number of child services on the server, and the number of services of each service type discovered on the server.

The following columns for each service:

- Service — Name of the service
- Service Type — Resource type of the service.
- Description — Text description of the service. This is an optional, user-configured value.
- Availability — Current availability of the service.

To delete one or more services from inventory, click the box to the left of each service you wish to delete, and click **Delete**.

Groups Containing a Server

The **Groups Containing This Resource** section of the **Inventory** page for a server lists the groups of which this server is a member. To view the **Inventory** page for a group, click its name.
Configuration Properties for a Server

The Configuration Properties section of the Inventory page for a resource contains the configuration options and currently selected values for the resource. Configuration properties for the resource are presented in three sections:

- **Shared** — The properties in this section relate to more than one management function, for instance both monitoring and control actions.
- **Monitoring** — These properties set options related to log tracking, configuration tracking, and, for servers, here is where you can disable auto-discovery of child services.
- **Control** — If Hyperic supports control actions for the currently selected resource type, this section includes any configuration properties required to enable resource control, for example, the path of the start script to use to start a server.

Click Edit to open the Edit Configuration Properties page for the currently selected resource.

The plug-in developer defines each configuration property for a resource type in the plug-in descriptor. The plug-in or the descriptor may set the initial value for a configuration property. For some types of resources, you may need to supply configuration property values to enable monitoring.

---

ui-Inventory.Server.New

This page has general instructions for creating a platform in Hyperic.

**Note:** For information about creating a server using the HQApi see HQApi resource command in Web Services API.

When to Create a Server Manually

Most server types that Hyperic manages are auto-discovered, rather than manually added to inventory on the New Server page.

You may need to create a server manually under some circumstances, for instance, if:

The plug-in that manages the server does not support auto-discovery of server instances.

The auto-discovery method used by the plug-in failed, because the entry it looked for in the process table or Windows registry was not found. For example, the server's name in the process list is different than the plug-in uses to detect server instances.

Create a Server

1. Use Browse > Resources > Platforms to navigate to the platform to which you wish to add a server.
2. Select New Server from the Tools menu.
3. On the New Server page enter:
   - **Name**—The name of the server
- **Description**---(optional) A description of the server
- **Server Type**---Select the server type for the new resource.
- **Install Path**---If there are other servers of the type you are creating on the current platform, make sure that the installation path you define for the new server instance is unique, and not the same as any of the other servers of the same type. For autodiscovered servers, the plug-in sets the value of the **Install Path** property, and uses it as the basis for the resource's *autoinventory identifier*. Note that if you create a server manually, you must specify the **Install Path** property, but it need not be the actual installation path for the server. The only requirement is that all servers of the same resource type on the same platform have unique **Install Path** property values.

4. Click **OK**.

The **Inventory** tab for the resource appears. See *Inventory Page for a New Server* for more information.

**Inventory Page for a New Server**

The screenshot below is the **Inventory** page for a server that is newly added to inventory. It contains these sections:

**General Properties**---The server's **Owner** is the username for the Hyperic account that created the server.

**Type and Host Properties**---The **Host Platform** is the name of the platform to which you added the server.

**Services**---This section of the page lists services discovered in the server instance. For an new server instance, no services appear until any required configuration properties are defined. You can manually add services to a server, but it is uncommon.

**Groups Containing this Resource**---Click **Add to List** in this section if you wish to assign the server to one or more resource groups.

**Configuration Properties**---The properties in the section vary, depending on the resource type of the server you are created.

**Shared** For some server types, you need to supply resource connection or authorization credential data in this section in order to monitor and manage the resource.

**Monitoring**---If the server type supports log or configuration tracking, you can configure tracking options in this section.

**Control**---If the server type supports control actions, you configure associated options in this section.
Configure Server for Monitoring

After creating the new server, you may need to supply values for one or more configuration properties. See the resource's Inventory page for configuration options and requirements.

   Edit a Server's Type and Host Properties

1. Click Edit in the "Type and Host Properties" section of a server's Inventory page.
2. Edit the Install Path property for the server as desired.

Note: If there are other servers of the same type as the selected server on the current platform, make sure that the installation path you define is unique, and not the same as any of the other servers of the same type. For auto discovered servers, the plug-in sets the value of the Install Path property, and uses it as the basis for the resource's autoinventory identifier. Note that if you create a server manually, you must specify the Install Path property, but it need not be the actual installation path for the server. The only requirement is that all servers of the same resource type on the same platform have unique Install Path property values.

ui-Inventory.Service

This page describes the contents of the Inventory page for a service.

Inventory Page for a Service

- To display the Inventory page for a service, use Resources > Browse > Services to navigate to the service, and click the Inventory tab.
- To view a screenshot of the Inventory page for a service, see Inventory Page - Service.
Inventory Page Header for a Service

The following sections describe the data and controls that appear at the top of the Inventory page for a service.

Resource Properties

The properties at the top of the Inventory page for a service provide identifying information including:

- Description
- Owner - By default, the Hyperic user under whose account the resource was added to inventory. Click Change... to assign a different resource owner.

The plug-in developer controls which resource properties are displayed at the top of a resource's Inventory page: any properties enclosed in a <properties> element for a resource type appear in the page header when you browse to an instance of that type.

Map Control for a Service

The Map control presents graphical view of the service and the resources that are related to it. The map illustrates hierarchical inventory relationships, and a resource's membership in groups or applications.

Tools Menu for a Service

When a service is selected, the Tools menu has the following commands:

- Configure Service — Opens the Configuration Properties page for the service, where you can edit the resource's configuration properties.
- Delete Service — Delete service from inventory.
- Add to Dashboard Favorites — Adds the service to the Favorite Resources portlet on the the current Hyperic user's Dashboard.
- Add to Group — Opens the Group Manager page, which lists the groups to which the service may be added. You can add a service to a group if you have permission to access the group, and:
  - The group is a mixed group that contains platforms, servers, and services.
  - The group is a compatible group of the selected service's service type.

General Properties for a Service

The General Properties section of the Inventory page for a service lists the following information:

- Description — A description of the service. This is an optional, user-configured value.
- Date Created — The date the service was added to the Hyperic inventory
- Location
- Date Modified, Modified By — The date the service was last modified and the user who modified it.
- Resource Type — The service type.
Click the **Edit** button to open a page where you can edit the service’s Name or Description.

*Groups Containing a Service*

This "Groups Containing this Resource" section lists the following information for each the group of which the service is a member.

- **Group** — The resource name, presented as a hyperlink you can click to navigate to the group.
- **Description**

There are two controls available:

- **Add to List** — Click to add the service to a group.
- **Remove From List** — If you have checkmarked one or more groups in the list, this control allows you to remove the resource from the selected groups.

*Configuration Properties for a Service*

This section displays the configuration properties for the service.

- **Shared** — These properties vary by service type.
- **Monitoring** — These properties control log and configuration tracking for the service.

For more information see [ui-Inventory.Service](#).

**ui-Inventory.Service.New**

**Configure a Platform Service**

This page has instructions for configuring a platform service.

1. Browse to the platform.
2. Select **New Platform Service** from the **Tools** menu.
3. On the **New Service** page, enter:
   - **Name** - A meaningful name for the service.
   - **Description** - (optional) A description of the service
   - **Service Type** - Select the desired service type from the pull-down list.
4. Click **OK** to create the new service.

The **Inventory** tab for the new service appears and prompts: "This resource has not been configured. Please set its Configuration Properties.

5. Click **Configuration Properties** in the prompt.

On the **Configuration Properties** page, enter values for the required configuration properties, which are prefixed with a red asterisk, and optional properties as appropriate.

For definitions of configuration properties, see the information in the **Configuration Requirements** column in the [Platform Service Types](#) table.

<table>
<thead>
<tr>
<th>Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td></td>
</tr>
<tr>
<td>DHCP</td>
<td>Use to monitor a remote Dynamic Host Configuration Protocol server.</td>
</tr>
<tr>
<td>Service</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DNS</td>
<td>Use to monitor a remote Domain Name System server.</td>
</tr>
<tr>
<td>FileServer Directory</td>
<td>Use to monitor a remote filesystem mount point and associated disks and raid arrays. Note: The Hyperic Agent auto-discovers local mount points. You only need to explicitly configure a FileServer Mount service to monitor a remote network file system (NFS). Alternatively, you can install an Hyperic Agent on the system that hosts the NFS, in which case the NFS will be auto-discovered.</td>
</tr>
<tr>
<td>FileServer File</td>
<td>Use to monitor a remote File Transfer Protocol server.</td>
</tr>
<tr>
<td>FileServer Mount</td>
<td>Use to monitor a remote Internet Message Access Protocol server.</td>
</tr>
<tr>
<td>FileServer DirectoryTree</td>
<td>Use to monitor a directory and the entire tree under that directory.</td>
</tr>
<tr>
<td>HTTP</td>
<td>Use to monitor a particular URL.</td>
</tr>
<tr>
<td>FTP</td>
<td>Use to monitor a remote File Transfer Protocol server.</td>
</tr>
<tr>
<td>IMAP</td>
<td>Use to monitor a remote Internet Message Access Protocol server.</td>
</tr>
<tr>
<td>InetAddress Ping</td>
<td>Use to ping a remote host for availability.</td>
</tr>
<tr>
<td>LDAP</td>
<td>Use to monitor a remote Lightweight Directory Access Server.</td>
</tr>
<tr>
<td>Multiprocess</td>
<td>Use to monitor multiple related processes. For example, to monitor the number of httpd processes running on Apache and the system resource they consume in aggregate.</td>
</tr>
<tr>
<td>NetworkServer Interface</td>
<td>Use to monitor a network interface.</td>
</tr>
<tr>
<td>Note: Because the Hyperic Agent auto-discovers network interfaces, manual configuration of a NetworkServer Interface is rare.</td>
<td></td>
</tr>
<tr>
<td>NTP</td>
<td>Use to monitor a remote Network Time Protocol server.</td>
</tr>
<tr>
<td>POP3</td>
<td>Use to monitor a remote Post Office Protocol 3 server. Configure along with an SMTP service to monitor incoming and outgoing email services.</td>
</tr>
<tr>
<td>Process</td>
<td>Use to monitor a process using a Hyperic SIGAR Process Table Query Language (PTQL) query. To configure, you supply the PTQL query in the form: Class.Attribute.operator=value For example, Pid.PidFile.eq=/var/run/sshd.pid</td>
</tr>
<tr>
<td>RPC</td>
<td>Use to monitor a Remote Procedure Call service. Note: Not available on Windows platforms.</td>
</tr>
<tr>
<td>Script</td>
<td>Used to configure Hyperic to periodically run a script that collects a system or application metric.</td>
</tr>
<tr>
<td>SMTP</td>
<td>Use to monitor a remote Simple Mail Transfer Protocol server. Configure along with a POP3 service to monitor incoming and outgoing email services.</td>
</tr>
<tr>
<td>Service</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SNMP</td>
<td>Use to monitor a remote Simple Network Management Protocol agent.</td>
</tr>
<tr>
<td>SSH</td>
<td>Use to monitor a remote SSH service.</td>
</tr>
<tr>
<td>TCP Socket</td>
<td>Use to monitor the availability of a remote TCP socket.</td>
</tr>
<tr>
<td>Windows Service</td>
<td>Use to monitor an application that runs as a service under Windows. To configure it, you supply its Service Name in Windows. To determine the Service Name: Select Run from the Windows Start menu. Type services.msc in the run dialog and click OK. In the list of services displayed, right-click the service you wish to monitor and choose Properties. Locate the Service Name on the General tab.</td>
</tr>
</tbody>
</table>

**ui-Inventory.Owner**

By default, the owner of a resource is the HQ account under which the resource was added to inventory. A resource's owner can be changed by its current owner, or by a superuser. To change the owner of a resource.

1. Navigate to the resource's Inventory page,
2. If you are authorized to modify the resource’s owner, a Change link is available next to the Owner field in the header of the Inventory page - click the link.
4. Click OK.

**ui-Inventory.GeneralProperties**

To edit a resource's name or description.

1. Navigate to the resource's Inventory page,
2. Click Edit the General Properties section of the page.
4. Click OK.

The resource owner is shown on the General Properties page. An authorized user can change the owner of a resource on its Inventory page. If a user has the right to modify a resource's owner, a Change link is available next to the Owner field in the header of the Inventory page.

**ui-Inventory.Configuration**

Navigate to the Configuration Properties Page

The Configuration Properties section of the Inventory page for a resource contains the configuration options and currently selected values for the resource. Configuration properties for the resource are presented in three sections:

- **Shared** — The properties in this section relate to more than one management function, for instance both monitoring and control actions.
• **Monitoring** — These properties set options related to log tracking, configuration tracking, and, for servers, here is where you can disable auto-discovery of child services.

• **Control** — If Hyperic supports control actions for the currently selected resource type, this section includes any configuration properties required to enable resource control, for example, the path of the start script to use to start a server.

Click **Edit** to open the **Edit Configuration Properties** page for the currently selected resource.

If a resource type requires user-supplied configuration property values, configuration instructions should be available at the bottom of the **Configuration Properties** for a resource of that type. In addition, vCenter Hyperic Resource Configuration and Metrics documents the configuration requirements for many Hyperic plug-ins.

**Configure Shared Properties**

The properties that appear in the "Shared" section of the **Configuration Properties** page vary by resource type.

Some resource types have no configuration properties. Some resource types’ configuration properties are discovered by the managing product plug-in, and you do not need to supply property values unless, for some reason, the plug-in fails to obtain the values.

**Configure Control Properties**

If the plug-in that manages a resource type enables control actions for the type, a "Control" section of the **Configuration Properties** page for a resource instance lists any properties required or supported for the control actions. In some cases, you must provide the value of required properties. Often, there are optional properties; for example, if Hyperic can perform a "start" command for a server type, there is usually an optional property that you can use to supply command arguments.

**Configure Alert Definitions Based on Events**

You can configure an resource alert condition based on a log event, configuration event, or a control action.

**ui-Inventory.Platform**

This section describes the contents of the **Inventory** page for a platform.

**Navigate to the Inventory Page for a Platform**

To display the **Inventory** page for a platform, use **Resources > Browse > Platforms** to navigate to the platform, and click the **Inventory** tab.

**Inventory Page Header**

The sections below describe the data and controls that appear at the top of the **Inventory** page for a platform.
Resource Properties

The properties at the top of the Inventory page for a platform provide identifying information about the managed product. The inventory properties displayed for a platform vary slightly by platform type, but typically will include most of these properties.

- Description
- Owner - By default, the Hyperic user under whose account the resource was added to inventory. Click Change... to assign a different resource owner.
- Secondary DNS
- Default Gateway
- Vendor
- Vendor Version
- IP Address
- Primary DNS
- CPU Speed
- OS Version
- RAM
- Architecture

The plug-in developer controls which resource properties are displayed at the top of a resource's Inventory page: any properties enclosed in a <properties> element for a resource type appear in the page header when you browse to an instance of that type.

Map Control for a Platform

Click the Map control in the page header for a graphical view the servers on the platform. The platform is displayed at the bottom of the map; servers are displayed above the platform. Resource names are in bold and the resource type is displayed just below in smaller type. Click a resource name to navigate to that server.

Tools Menu for a Platform

When a platform is selected, the Tools menu has the following commands:

- **Configure Platform** — Opens the Configuration Properties page for the platform, where you can edit the resource's configuration properties.
- **Clone Platform** — Creates a new platform with the same configuration as an existing platform. For more information, see Clone a Platform.
- **Delete Platform** — Delete the platform, its platform services, servers, and the services in the servers from inventory.
Do you want to rediscover the platform?

Note that if you delete all of the platforms that a Hyperic Agent manages, the Hyperic Server also removes the saved authentication token for that agent from the Hyperic database. So if you delete a platform that is managed by an agent that does not manage any other platforms (as in the case of an agent that manages only the platform it runs on), the agent will no longer be able to connect to the Hyperic Server. If you want the agent to rediscover the platform where the agent runs, you must repeat the agent setup process. Otherwise (if you do not want the agent to rediscover the platform it runs on) shut down the agent, and uninstall the agent from that platform.

- **New Server** — Displays the **New Server** page, where you can manually add a new server to the platform. (For instance, a server that was not auto-discovered.)
- **New Platform Service** — Displays the **New Service** page, where you can manually add a new service, for instance a remotely monitored network service, to the platform.
- **New Auto-Discovery**
- **Enable All Alerts On This Agent**
- **Disable All Alerts On This Agent**
- **Add to Dashboard Favorites** — Adds the platform to the **Favorite Resources** portlet on the current Hyperic user's Dashboard.
- **Add to Group** — Opens the **Group Manager** page, which lists the groups to which the platform may be added. You can add a platform to a group if you have permission to access the group, and:
  - The group is a mixed group that contains platforms, servers, and services.
  - The group is a compatible group of the selected platform's platform type.

**General Properties for a Platform**

The **General Properties** section of the **Inventory** page for a platform lists the following information:

- **Description** — A description of the platform. This is an optional, user-configured value.
- **Date Created** — The date the platform was added to the Hyperic inventory
- **Location**
- **Date Modified, Modified By** — The date the platform was last modified and the user who modified it.
- **Resource Type** — The platform type.

Click the **Edit** button to open a page where you can edit the platform's Name or Description.

**Type and Network Properties for a Platform**

The **Type and Network Properties** section of the **Inventory** page for a platform lists the following information:

- **Platform Type** — The type of platform (This value cannot be changed.)
• **Agent Connection** — The IP address:port pair that the Hyperic Server will use to connect to the Hyperic Agent on the platform device.

• In the case of a platform type that is monitored by a Hyperic Agent on a different platform, such as a network or virtual host, this property identifies the agent that manages the platform.

• **Fully Qualified Domain Name** — The platform’s FQDN.

• **IP Address, MAC Address, Netmask** — One or more sets of these identifiers for the platform. There is at a minimum one set for the loopback (local) IP address — 127.0.0.1 — and then additional sets for each network interface on the device.

Click the **Edit** button to open a page where you can select platform properties.

**Servers on a Platform**

The "Servers" section lists the following information for each server on the platform:

• **Server** — The resource name, presented as a hyperlink you can click to navigate to the server.

• **Server Type**

• **Install Path**

• **Description**

• **Availability** — Current availability of the server.

There are two controls available:

• **New** — Click to add a server to the platform.

• **Delete** — Click to delete a server from the platform. Services in the server will also be deleted.

**Services on a Platform**

This section lists the following information for each platform service on the platform:

• **Service** — The resource name, presented as a hyperlink you can click to navigate to the service.

• **Description**

• **Availability** — Current availability of the platform service.

There are three controls available:

• **View** — This pull-down allows you to filter the list to display only platform services of a selected type.

• **New** — Click to add a platform service to the platform.

• **Delete** — Click to delete a platform service from the platform.
Groups Containing a Platform

This section lists the following information for each the group of which the platform is a member:

- **Group** — The resource name, presented as a hyperlink you can click to navigate to the group.
- **Description**

There are two controls available:

- **Add to List** — Click to add the platform to a group.
- **Remove From List** — If you have checkmarked one or more groups in the list, this control allows you to remove the resource from the selected groups.

Configuration Properties for a Platform

This section displays the configuration properties for the platform.

- **Shared** — These properties are typically only present for platform types that Hyperic does not auto-discover, and vary by platform type.
- **Monitoring** — These properties control log and configuration tracking for the platform. For more information see *Log and Configuration Event Tracking* in vCenter Hyperic Administration.

**ui-Inventory.Platform.AutoDiscovery**

To initiate a platform scan:

1. Navigate to the platform you want to scan.
2. Select **New Auto-Discovery** from the **Tools** menu.

   **Some Platforms Cannot Be Scanned**

   You can only initiate an auto-discovery scan for a platform that runs a Hyperic Agent. Platforms that are remotely monitored, such as Cisco and other network device platforms that do not run an agent, cannot be scanned.

3. Run default scan only, or run a file scan in addition to the default scan.
   - To run a default scan only, click **OK** at the top of the page.
   - To run a file scan in addition to the default scan:
     a. Check the **Server Types** that Hyperic should look for on the platform.
     b. In **ScanDirs**, specify the directories that Hyperic should scan.
     c. In **ExcludeDirs**, specify the directories that Hyperic should not scan.
     d. In **fsTypes**, select the type of file system to scan: local disks, network-mounted disks, or both ("all").
     e. In **depth**, specify the depth in the directory structure to which Hyperic should scan.
     f. To have Hyperic follow symlinks when scanning, check **Should symlinks be followed**.
     g. Click **OK** at the bottom of the screen.
When to Create a Platform Manually

Operating system platform types are auto-discovered and cannot be manually added to inventory. The only platform types you can manually add to inventory are:

- Cisco IOS
- Cisco PIXOS
- GemFire Distributed System
- NetApp Filer
- Network Device
- VMWare VI3 Host
- Network Host
- VMWare vSphere Host
- VMWare vSphere VM
- Xen Host

Add a Platform to Inventory from the Hyperic User Interface

1. Click **New Platform** on either:
   - The Dashboard's **Summary Counts** portlet
   - The Tools menu on the Browse > Resources.

2. On the **New Platform** page, enter:
   - **Name** — The name of the platform
   - **Description** — (optional) A description of the platform
   - **Location** — (optional) The physical location of the platform hardware
   - **Platform Type** — Select the platform type from the list. Once you create the platform, you cannot change its type.
   - **Fully Qualified Domain Name** — The platform's FQDN
   - **Agent Connection** — The IP address:port pair that the HQ Server will use to connect to the Hyperic Agent on the platform device.

      In the case of a platform type that is monitored by a Hyperic Agent on a different platform, such as a network or virtual host, this property identifies the agent that manages the platform.

      - **Agent Connection** dropdown menu lists connections for all deployed agents.
        - **IP Address** — (optional)
        - **MAC Address** — (optional)
        - **Netmask** — At a minimum specify values for the loopback (local) IP address, and then additional sets of values for each network interface on the device.

3. Click **OK**.

The Inventory page for the new platform is displayed.

The platform's Owner defaults to the account that created the platform.
Edit a Platform's Type and Network Properties

Click the Edit button in the "Type and Network Properties" section of the platform's Inventory page to display an edit window that displays the following properties:

- **Platform Type** — The type of platform (This value cannot be changed.)
- **Agent Connection** — The IP address:port pair that the HQ Server will use to connect to the Hyperic Agent on the platform device.
- In the case of a platform type that is monitored by a Hyperic Agent on a different platform, such as a network or virtual host, this property identifies the agent that manages the platform.
- **Fully Qualified Domain Name** — The platform’s FQDN.
- **IP Address, MAC Address, Netmask** — One or more sets of these identifiers for the platform. There is at a minimum one set for the loopback (local) IP address — 127.0.0.1 — and then additional sets for each network interface on the device.

Cloning a Platform

The Clone Platform feature allows you to copy configuration properties for servers and manually created platform services from one platform to one or more other platforms.

**Note:** Manually created platform services are the types of platform services that cannot be auto-discovered - typically the types you configure to proxy metrics for network services and devices, such as "HTTP", "POP3, or "DNS" services.

Platform cloning is supported between platforms of the same type (for example, "Linux") that run the same version of the Hyperic Agent.

How to Clone a Platform

The Clone Platform page is available on the Tools menu when a platform is selected.

1. Navigate to the platform whose inventory resources you wish to clone.
2. Choose Clone Platform from the Tools menu.
3. On the Clone Platform page, the "Available clone targets" list shows platforms of the same type as the source platform. You can narrow the list by entering a string in the "Search resources" box.
4. Move the target platforms that you from the "Available clone targets" list to the "Selected clone targets" list.
5. Click Queue for Cloning. Cloning occurs asynchronously. You can perform other functions in the user interface without waiting for the cloning process to complete.
What Cloning is Good For

Platform cloning simplifies replication of configuration properties for resources of the same type. For instance, you have a dozen Linux platforms, each running Tomcat 6.0, JBoss 4.2, and MySQL 5.0. The Hyperic Agent is installed on each platform, and has auto-discovered the Tomcat, JBoss, and MySQL instances on each platform. You want to implement an identical log tracking configuration for servers of the same type on each of platforms. You edit the "Configuration Properties" on the Inventory page for the Tomcat, JBoss, and MySQL instances on one of the platforms. You can use Clone Platform to copy the configuration settings to the Tomcat, JBoss, and MySQL instances on the other 11 platforms.

You are setting up multiple platforms to monitor network services or devices. To enable network monitoring, on each platform you need a properly configured platform service to serve as a proxy for each remote service or device. You can configure the platform services on one platform, and use Clone Platform to create platform services with the same configuration properties on each of the other platforms.

What Cloning Does

The cloning process can create new resources on the target platform or update an existing resource's configuration properties. The cloning process:

- Copies the configuration properties for each server on the source platform to corresponding servers of the same type on the target platforms. If there is not a corresponding server of the same type on a target platform, it is created, with the same configuration properties as the source server.
- Copies the configuration properties for each manually created platform service on the source platform to the target platforms - adding a new platform service to the target platform's inventory, or updating configuration properties of corresponding instances in the target platform inventory.

Cloning occurs asynchronously, so you can perform other functions in the Hyperic user interface after initiating the process. The Event Center indicates the start and stop of the cloning process for the source platform.

What Cloning Does Not Do

The cloning process:

- Does not update auto-discovered properties
- Does not create or update auto-discovered platform services, such as CPUs or File Server Mounts
- Does not create or update services that comprise the cloned servers; the child services will be added to inventory on the target platform via auto-discovery.
To initiate a platform scan:

1. Navigate to the platform you want to scan.
2. Select New Auto-Discovery from the Tools menu.
   The New Auto-Discovery page appears.

   **Some Platforms Cannot Be Scanned**
   You can only initiate an auto-discovery scan for a platform that runs an Hyperic Agent. Platforms that are remotely monitored, such as Cisco and other network device platforms that do not run an agent, cannot be scanned.

3. Run default scan only, or run a file scan in addition to the default scan.
   - To run a default scan only, click OK at the top of the page.
   - To run a file scan in addition to the default scan:
     a. Check the the Server Types that Hyperic should look for on the platform.
     b. In ScanDirs, specify the directories that HQ should scan.
     c. In ExcludeDirs, specify the directories that Hyperic should not scan.
     d. In fsTypes, select the type of file system to scan: local disks, network-mounted disks, or both ("all").
     e. In depth, specify the depth in the directory structure to which HQ should scan.
     f. To have Hyperic follow symlinks when scanning, check Should symlinks be followed.
     g. Click OK at the bottom of the screen.

**Contents of the Auto-Discovery Results Page**

The Auto-Discovery Results page appears when you click a platform name in the Dashboard's Auto-Discovery portlet. The page shows the results of the most recent platform scan - the new or changed resource information that was discovered, as well as information for unchanged resources. You can filter the page for new, modified, or unchanged resources. You can selectively import new and changed data to inventory.

The Auto-Discovery Results page has three sections:

- **Platform Type** — This section contains the following data and controls:
  o Platform Type — The resource type of the platform.
  o Fully Qualified Domain Name — The platform's FQDN.
  o Import Values/Do Not Import (callout #1 in screenshot) — In this version of Hyperic, this control has no effect. Changing the value has no impact on what values are imported.
• **Network Properties** — This section contains the following data and controls:
  o **All States/New/Modified/Unchanged** selector (callout #2 in screenshot) — This dropdown menu allows you to filter the IP addresses that appear in the list by change state.
  o The following data is shown for each IP address matching the currently selected filter value:
    - **IP Address**
    - **Netmask**
    - **MAC Address**
    - **Properties State** — Value indicates if the connection properties are "New", "Unchanged", or "Changed".

• **Servers** — This section contains the following data and controls:
  o **Server Types** selector (callout #3 in screenshot) — This dropdown menu allows you to restrict the list to servers of a particular type.
  o **All States/New/Modified/Unchanged** filter (callout #4 in screenshot) — This dropdown menu allows you to filter the servers that appear in the list by change state.
  o The following data is shown for each server in the list:
    - **Server** — The name of the resource.
    - **Server type** — The resource type of the server.
    - **Install Path** — Where the server is installed
    - **Server Status** — Value indicates whether the server is "New", "Unchanged", or "Modified.
    - **Import Values/Do Not Import** (callout #5 in screenshot) — The value of this pull-down controls whether the server data will be imported when the OK button is clicked.

**Import or Skip Resources in Auto-Discovery Results Page**

To process the contents of the Auto-Discovery Results page:

1. View the new and changed properties in the **Network Properties** section of the page.
2. (Optional) If you do not want to import the new or changed network properties to Hyperic inventory, select "Do Not Import" from the dropdown menu in the **Platform Type** section of the page.
3. View the new and changed servers listed in the **Servers** section of the page.
4. For each new or changed server, if you do not want to import a new or changed server to Hyperic inventory, select "Do Not Import" from the dropdown menu in the "Action *column
5. Click **OK** to import the resource data which you have approved for import.
Configure Resources for Monitoring

If the Hyperic Agent discovered all of the resource properties required to monitor a resource, it starts monitoring that resource as soon as you add it to inventory. This is the case for most resource types. Note however, that some level of configuration is required to start managing some resources types - see the Configuration Properties section on a resource's Inventory tab for configuration requirements.

**ui-Inventory.Application**

**Inventory Page for an Application**

In Hyperic, an application is an inventory type, configured by an authorized user. An application is a set of selected services, usually running in different servers on multiple platforms, that together fulfill a single business purpose. Configuring applications enables you to manage your infrastructure from an application — as opposed to a hardware — perspective.

To display the Inventory page for an application, use Resources > Browse > Applications to navigate to the application, and click the Inventory tab.

A user can view and modify resources only to the extent that the user's role(s) permit. For more information see User Accounts and Roles in Hyperic in vCenter Hyperic Administration.

Use the Inventory tab to add services to an application.

The "Service Counts" section of this tab shows the total number of services in the application, and the number of each type.

The "Services" section lists key information for each service in the application.

**Inventory Page Header for an Application**

The sections below describe the data and controls that appear at the top of the Inventory page for an application.

**Resource Properties**

The property at the top of the Inventory page for an application is:

- **Owner** - By default, the Hyperic user under whose account the resource was added to inventory. Click Change... to assign a different resource owner.

**Tools Menu for an Application**

When an application is selected, the Tools menu has the following commands:

- **Delete Application** — remove the application from inventory.
- **Add to Dashboard Favorites** — Adds the application to the Favorite Resources portlet on the current Hyperic user's Dashboard.
• **Add to Group** — Opens the **Group Manager** page described below in **Group Manager**.

A user can view and modify resources only to the extent that the user's role(s) permit. For more information see *User Accounts and Roles in Hyperic in vCenter Hyperic Administration*.

**General Properties for an Application**

The **General Properties** section of the **Inventory** page for an application lists the following information about the application:

- **Description** — A description of the application. This is an optional, user-configured value.
- **Location** — An optional property.
- **Date Created** — The date the application was created.
- **Date Modified, Modified By** — The date the application was last modified and the user who modified it.

Click the **Edit** button to open a page where you can edit the application's Name or Description.

**Application Properties**

The **General Application** section of the **Inventory** page for an application lists the following information about the application:

- **Application Type** — This property, supported in previous versions of Hyperic, is no longer used.
- **Engineering Contact** — An optional property.
- **Business Owner** — The date the application was created.
- **IT Operations Contact** — The date the application was last modified and the user who modified it.

Click the **Edit** button to open a page where you can edit the contact-related properties for the application.

**Service Counts for an Application**

The **Service Counts** section of the **Inventory** page for an application lists the total number of services in the application and the number of services of each service type.

**Services in an Application**

The **Services** section of the **Inventory** page for an application lists the following information for each of the services in the application:

- **name** — Name of the service
- **Entry Point** — Whether the service is the entry point for the application.
- **Service Type** — Resource type of the service.
- **Res Type** —
- **Host Server** — Name of the server where the service runs.
- **Availability** — Current availability of the service.
You update the application in these ways:

- To add services to the application, click **Add to List**--the **Edit ApplicationName** appears.
- To remove one or more services from the application, click the box to the left of each service you wish to delete, and click **Delete**.

**Note:** The **Dependencies** control relates to functionality not implemented in this version of Hyperic.

Groups Containing an Application

The **Groups Containing This Resource** section of the **Inventory** page for an application lists the groups to which it belongs.

- To view the inventory page for a group to which the application belongs, click the group's name.
- Click **Add To List** to select the groups to which you wish to add the application.
- To remove the application from a group, checkmark the group, and click **Remove From List**.

Group Manager

The **Group Manager**, which appears when you click **Add to List** on the **Groups Containing This Resource** section of a resource's **Inventory** page, lists the groups to which you can add the application. Only groups that contain applications appear on the list, and only those that do not already contain the current application.

Create an Application

1. Click **Browse** on the **Resources** tab.
2. Click **New Application** in the **Tools** menu.
   The **New Application** page appears.
3. In the "General Properties" section of the **New Application** page, enter:
   - **Name** — Supply the name of the application.
   - **Description** — Enter a description of the application, if desired.
   - **Location** — Enter the location of the application, if desired.
4. In the "Application Properties" section of the New Application page, provide desired contact information:
   - Engineering Contact
   - Business Owner
   - IT Contact
5. Click **OK**.
   The **Inventory** page for the application appears.
Add Services to an Application

1. In the "Services" section of the Inventory page for the application, click Add to List. The Edit Application page appears.
2. Checkmark desired services and click the blue arrow to move them from the Services column to the Add Services column. (The arrow is enabled when you select a resource.)
3. Click OK.

Edit Application Properties

2. Enter desired contact information:
   - Engineering Contact
   - Business Owner
   - IT Contact
3. Click OK.

ui-Inventory.Application.SvcDep

The service dependency page is a user interface for supplying data required for functionality not implemented in this version of Hyperic. Service dependency data is not used by Hyperic.

ui-Inventory.Group

This page describes the contents of the Inventory page for a group.

Navigate to the Inventory Page for a Group

To display the Inventory page for a compatible or mixed group, use:

- Resources > Browse > Compatible Groups/Clusters, or
- Resources > Browse > Mixed Groups

and click the Inventory tab.

A user can view and modify resources only to the extent that the user's role(s) permit. For more information see User Accounts and Roles in Hyperic in vCenter Hyperic Administration.

Inventory Page Header for a Group

The sections below describe the data and controls that appear at the top of the Inventory page for a group.
Resource Properties for a Group

The properties at the top of the Inventory page for either a compatible or mixed group are:

- Description
- Owner — By default, the Hyperic user under whose account the resource was added to inventory. Click Change... to assign a different resource owner.

Map Control for a Compatible Group

The Map control is present on the Inventory tab for a compatible group, not for a mixed group. The map for a compatible group shows the members of the group.

Tools Menu for a Group

The Tools menu for a compatible or a mixed group has the following commands:

- New Group — Opens the New Group page, where you can create a new group.
- Delete Group — Deletes the group, but not its member resources.
- Add to Dashboard Favorites — Adds the group to the Favorite Resources portlet on the current Hyperic user’s Dashboard.
- Add to Group — Opens the Group Manager page, which lists the groups to which the group may be added. You can add a group to another group if:
  - You have permission to access the target group, and:
  - The target group is a mixed group that contains groups.
- Schedule Downtime — This option, available vCenter Hyperic, opens the Schedule Downtime popup, where you can schedule a period of time during which alerts for members of the group will not fire.

General Properties for a Group

The General Properties section of the Inventory page for a service lists the following information:

- Description — A description of the service. This is an optional, user-configured value.
- Date Created — The date the service was added to the Hyperic inventory
- Location
- Date Modified, Modified By — The date the service was last modified and the user who modified it.
- Resource Type — The service type.

Click the Edit button to open a page where you can edit the service’s Name or Description.

Resources

This section lists the following information for each the group of which the service is a member.

- Group — The resource name, presented as a hyperlink you can click to navigate to the group.
- Description
There are two controls available:

- **Add to List** — Click to add the service to a group.
- **Remove From List** — If you have checkmarked one or more groups in the list, this control allows you to remove the resource from the selected groups.

**Roles a Group is Assigned To**

The "Roles Assigned To" section lists the roles to which the group is assigned, which, along with the permission matrix for the role, governs the access that users with the role have to resources in the group.

For more information about roles, groups, and resource permissions, see *Roles in vCenter Hyperic in vCenter Hyperic Overview*.

**Create a Group**

1. Click **New Group** on either:
   - The Dashboard's **Summary Counts** portlet
   - The **Tools** menu on the **Browse > Resources** page

2. On the **New Group** page, enter
   - **Name**: The name of the group
   - **Description**: (optional) A description of the group
   - **Location**: (optional) The physical location of the group's hardware
   - **Make group private**: Checkmark to make the group private. A private group is invisible to other users, including admin users. You can share a private group with other users by associating it with a role. Note that the name you assign to a private group is automatically prefixed with the string "private to *username*", where username is the creator's HQ username.
   - **Contains Resources**: Select the type of group:
     - **Compatible/cluster** - the group will contain resources of a single type. For example, "Linux" or "JBoss 4.2"
     - **Mixed** - the group will contain multiple resource types. Mixed groups are useful for role-based resource access control.

The **Select Resource Type** dropdown menu appears to the right of the **Contains Resources** — the options vary depending upon whether you are created a compatible or mixed group.

- For a compatible group, the **Select Resource Type** dropdown menu contains a list of all resource types in inventory, as shown in the thumbnail screenshot below.
- For a mixed group, the **Select Resource Type** dropdown menu contains these choices:
  - Groups
  - Platforms, Servers, & Services
  - Applications
3. Click OK to create the group. The Inventory page for the new group appears.

Assign Roles to a Group
To add a role to a group:

1. Navigate to the group’s Inventory page, if it is not currently selected.
2. Click Add To List in the Roles section of the page.
3. On the Add to Roles to Group page, checkmark desired roles and click the blue arrow to move them from the Roles column to the Add To Roles column. (The arrow is enabled when you select a role.)
4. Click OK.

Adding the Current Resource to a Group
This screen allows users to add the current resource to a group or groups. Once the resource is a member of a group, it can be more efficiently managed at the group level, and, when the group is assigned to a role, users with that role can see the resource.

Which Groups Are Available for Selection? The only groups available for selection are compatible groups of the resource's resource type and all mixed groups. If the resource is an application, only mixed groups of type "Application" are available. Groups that the resource is already a member of are not listed for selection.

Tasks Available on This Screen
On this screen, users can do one thing: select a group or groups for the resource to be a member of.

To add the resource to groups:

1. Check the desired groups in "Groups containing this resource" and click the arrow icon to move the selected resources to "Add To Groups." (The arrow is enabled only when resources are selected.)
2. Click OK.

Assign Resource Groups
To add a resource to one or more groups:

1. Navigate to the resource's Inventory page, if it is not currently selected.
2. Click Add To List in the Groups Containing this Resource section of the page.
3. The Add to Groups page lists groups to which the resource can be added: Compatible groups that contain resources of the same type as the current resource. For example, you can add a platform whose type is "Linux" to compatible groups that contain "Linux" platforms.
Mixed groups that contain resources of the inventory type of the current resource. For example, you can add a platform (of any type) to mixed groups that contain "Platforms, Servers, and Services", but not a mixed group that contains "Groups".

4. Checkmark desired groups and click the blue arrow to move them from the Groups not containing this resource column to the Add to Groups column. (The arrow is enabled when you select a resource.)

5. Click OK to add the resource to the groups you have chosen.
Hyperic Dashboard

The Hyperic Dashboard is the first page displayed in the user interface when you log on. The dashboard contains multiple portlets, each of which presents a particular type of information, such as resource health, recent alerts, recently discovered resource or changes to resources, recently performed resource control actions, and so on.

You can personalize the dashboard to suit your responsibilities and preferences; you can add or remove portlets, rearrange them, and customize the contents of many of the portlets.

You can have multiple dashboards — one for each role to which you are assigned. For more information, see Using Multiple Dashboards.

Note also that the roles you are assigned govern what resource data appears in dashboard portlets. Portlets will contain only the resource data to which your Hyperic roles allow access.

Portlet Quick Facts and Links

<table>
<thead>
<tr>
<th>Portlet</th>
<th>Description</th>
<th>More Information and Configuration Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autodiscovery</td>
<td>Lists new and changed resources, and allows you to add them to inventory.</td>
<td>Auto-Discovery Portlet</td>
</tr>
<tr>
<td>Availability Summary</td>
<td>Displays the availability of selected of resources, aggregated by resource type. Refreshes every minute. This portlet does not contain any resources until you configure it.</td>
<td>Availability Summary Portlet</td>
</tr>
<tr>
<td>Control Actions</td>
<td>Lists the control actions that Hyperic has most recently performed on any managed resource, upcoming scheduled control actions, and the most frequently performed quick control actions.</td>
<td>Control Actions Portlet</td>
</tr>
<tr>
<td>Favorite Resources</td>
<td>Lists resources that have been added to the portlet. This portlet does not contain any resources until you configure it.</td>
<td>Favorite Resources Portlet</td>
</tr>
<tr>
<td>Saved Charts</td>
<td>Displays charts that have been saved to the Dashboard. In vCenter Hyperic, charts are displayed as a slideshow.</td>
<td>Saved Charts Portlet</td>
</tr>
<tr>
<td>Portlet</td>
<td>Description</td>
<td>More Information and Configuration Options</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Recent Alerts</td>
<td>Lists the most recently triggered alerts for a set of user-selected resources. Refreshes every minute.</td>
<td>[Recent Alerts Portlet]</td>
</tr>
<tr>
<td>Recently Added</td>
<td>Lists platforms recently added to inventory.</td>
<td>[Recently Added Portlet]</td>
</tr>
<tr>
<td>Search Resources Portlet</td>
<td>Allows you to search for resources. The search supports case-insensitive, partial-term queries and is restricted to a single inventory type.</td>
<td></td>
</tr>
<tr>
<td>Summary Counts</td>
<td>Displays a count of all the managed resource of each inventory type. In vCenter Hyperic, the resources that appear are limited to those that you have permissions to view.</td>
<td>[Summary Counts]</td>
</tr>
<tr>
<td>Group Alert Summary*</td>
<td>Displays traffic light indicators for resource alerts and group alerts for selected groups. Click on the traffic light for a group alert to view a list of alerts that have fired. Click on a group name to view the group page. This portlet does not present any groups until you add them to it.</td>
<td>[Group Alerts Summary Portlet]</td>
</tr>
<tr>
<td>Metric Viewer</td>
<td>Shows selected metrics for selected resources. Refreshes every minute. This portlet does not contain any resources until they have been added to it.</td>
<td>[Metric Viewer Portlet]</td>
</tr>
<tr>
<td>Problem Resources*</td>
<td>Lists all resources with problem metrics, their availability, the number of alerts triggered on each, the number of times the metric has been out of bounds, and the last time the OOB metric was collected. Click the resource name to view the Monitor page for it.</td>
<td>[Problem Resources Portlet]</td>
</tr>
</tbody>
</table>

**Tailor Dashboard**

You can customize the dashboard in these ways:

- **Add portlets** — At the bottom of each column of portlet, click **Add Content to this column** to list portlets you can add.
- **Remove portlets** — The top right corner of each portlet has a delete icon you can use to remove it from your Dashboard. If you remove a portlet, you can add it back later — removed portlets can be selected from the list that displays when you click **Add Content to this column**.
- **Change layout** — You move a portlet to a different location in a column by grabbing it by the bar at the top of it and dragging it to the desired location.
• Change portlet behavior — Most portlets have a gear-shaped icon in the bar at the top, which you can click to display a configuration dialog.

Using Multiple Dashboards

In vCenter Hyperic, you can:

• Select a dashboard — Select which dashboard to view using the Select a Dashboard pull-down in the upper left of the page. In addition to your personal dashboard, the list will contain the role-specific dashboard for each role to which you are assigned.
• Set a default dashboard — By default, your default dashboard is your personal dashboard. To change the default dashboard, select the desired dashboard, and click Make Default to the right of the Select a Dashboard pull-down — this control appears on a dashboard that is not currently your default dashboard.

ui-Login

This is the logon page for the Hyperic user interface.

If the "Use my Organization Authentication" box is checked, Hyperic will check your credentials against your LDAP system instead of the user accounts defined on Hyperic.

If vCenter Hyperic is not configured to authenticate users via LDAP, uncheck the box.

HQ Dashboard Settings: Add Resources

This screen allows users to select which resources appear in one of several portlets on the Dashboard. (Which portlet is affected depends on how users get to this screen.)

Tasks Available on This Screen

On this screen users can select a set of resources.

To select a set of resources:

1. Filter the list of resources:
   a. Select an inventory type (Platform, Server, Service, and so on) from the View pull-down, as desired.
   b. Select a value from the All Types pull-down, as desired.
      The values in the pull-down depend on the inventory type currently selected. For example, if the selected inventory type is Platform, the available values in the All Types pull-down are AIX, Linux, Solaris, and so on.
      Note: filtering by type is not supported for the Compatible Groups/Clusters inventory type.
   c. Enter (part of) the resource's name in Filter By Name and click the arrow directly to the right.
2. Check the desired resources in "Resources" and click the arrow between the two lists to move the selected resources to "Add Resources."
3. To remove resources from the desired set, check the resources in "Add Resources" and click arrow between the two lists to move the selected resources back to "Resources." (The arrow is enabled only when some resources are selected.)
4. Click OK.

ui-Dashboard.Alerts

About the Recent Alerts Portlet

The Recent Alerts portlet presents a list of recently fired alerts. The following information is shown for each alert:

- **Date/Time** - When the alert fired. Click to view the Alert Detail page.
- **Alert Name** - Name of the alert definition.
- **Resource Name** - The resource where the alert fired.
- **Fixed** - Whether the alert has been marked "fixed".
- **Ack** - whether the alert has been acknowledged.

Configure the Recent Alerts Portlet

1. Click the gear icon in the upper right corner of the Recent Alerts portlet. The HQ Dashboard Settings: Recent Alerts page appears.
2. In the Display Settings section:
   - Description — (optional) Enter a description, if desired. The description will appear at the top of the portlet.
   - Alert Range — Select:
     - Maximum length of the alert list: 4, 10, 20 or 30.
     - The minimum priority of the alerts to include.
     - Timeframe of interest; choices range from 30 minutes to a month.
     - Resources of interest:
       - all resources - With this this setting, alerts (that meet the priority and timeframe criteria) on any resource can appear in the list.
       - selected resources - With this this setting, the alert list contains only resources listed in the Selected Resources section that meet the priority and timeframe criteria.
3. If desired, define a set of resources of interest in the Selected Resources section.

The content of the portlet will be limited to alerts that fired on resources in the Selected Resources only when the "all resources/selected resources" switch is set to "selected resources". The contents of the Selected Resources section is ignored when the "all resources/selected resources" switch is set to "selected resources".

- a. If the Selected Resources section contains resources not of interest, check the box next to them and click Remove from List.
- b. If you wish to add resources to Selected Resources click Add to List.
c. In the Resources column:
   iv. Use the View filters to filter by inventory type, resource type, or both, as desired.
   v. Enter a substring in the Filter by Name field to filter by resource name, as desired.
   vi. In the list of resources, checkmark desired resources, and click the right arrow between the columns to include them in the portlet.

d. If the Add Resources column contains resources that are not of interest, checkmark those resources and click the left arrow between the columns.

4. Click OK.

ui-Dashboard.Availability

About the Availability Summary Portlet

The Availability Summary portlet presents the availability of selected resources by resource type. The portlet is empty until you configure the resources to include.

Configure the Availability Summary Portlet

1. Click the gear icon in the upper right corner of the Availability Summary portlet.
2. The HQ Dashboard Settings: Availability Summary page appears.
   In the Description field, enter the title to appear at the top of the portlet.
3. In the Display Range dropdown menu, select the maximum number of resource types to list in the portlet.
4. (Optional) If the Selected Resources section contains resources that you do not want to be included in the availability summary, checkmark them and click Remove From List.
5. (Optional) To add resources to the portlet:
   a. Click Add to List.
   b. In the Resources column:
      i. Use the View filters to filter by inventory type, resource type, or both, as desired.
      ii. Enter a substring in the Filter by Name field to filter by resource name, as desired.
      iii. In the list of resources, checkmark desired resources, and click the right arrow between the columns to include them in the availability summary.
   c. If the Add Resources column contains resources you do not wish to include in the availability summary, checkmark those resources and click the left arrow between the panels.
6. Click OK.
ui-Dashboard.AutoDiscovery

Contents of the Auto-Discovery Portlet

The Auto-Discovery portlet on the Hyperic Dashboard lists recently added or modified platforms and servers, and allows an authorized user to view discovery details, and to import the new or changed resource data to the Hyperic database.

By default, the Auto-Discovery portlet lists the (up to) five most recently new or changed platforms. To set the maximum number of platforms that can appear in the list, see Configure the Number of Auto-Discoveries Displayed.

A platform appears in the Auto-Discovery portlet if it, or a server running on it, is new or changed. The rules are these:

- **The platform is new** — A platform appears as new in the portlet, if neither its IP address or FQDN match that of an existing platform in inventory. In this case, any new servers discovered on the platform appear below the platform in the portlet.
- **The platform has a new server** — A new server has been discovered on the platform since the last scan. The new server is listed below the platform.
- **Platform or server properties have changed** — One or more inventory properties for the platform, or for one or more of the servers running it, have changed since the last scan. Servers with changed properties are listed below the platform.

The Auto-Discovery portlet presents the following information for each platform it contains:

- **Hostname** — The hostname of the platform is a link to a page — the Auto-Discovery Results page - that contains detailed information about the scan results for the platform and servers running there. See Using the Auto-Discovery Results Page.
- **Platform type** — The resource type for the platform.
- **Status** — Indicates the type of change that was detected for a resource, either "new" or "modified".
- **Changes** — If the Status for a resource is "modified", the Changes column contains a summary of what changed. For example:
  - "server set changed" — Applies to platforms; this value indicates that changes to one or more servers on the platform were detected. The changed server(s) are listed below the platform.
  - "name change" — Indicates that the name of the resource has changed; a resource name can change when a resource is upgraded from one version to another, if version number forms a portion of the resource name, as is often the case.
  - "install path changed" — Indicates that the installation path for a server has changed; the installation path for a resource can change when a resource is upgraded from one version to another, if version number forms a portion of the path, as is often the case.
"IP set changed" — Indicates that the IP address has changed. When the agent detects an IP address not associated with an existing platform in inventory, it checks for a platform with a matching FQDN - if found, Hyperic recognizes the platform as existing.

"FQDN changed"

- For each newly discovered or changed server on the platform:
  - Installation path —
  - Status — Indicates "new" or "modified"
  - Changes — If Status is "modified", the Changes column contains a summary of what changed.

About Discovery and Import of Services
The Auto-Discovery Portlet does not display new or changed services. Services are discovered during a run-time scan and are automatically added to Hyperic inventory.

Import or Skip Resources in Auto-Discovery Portlet
You can process the contents of the Auto-Discovery Portlet in these ways:

- To import all resources---leave all resources selected, and click Add to Inventory.
- To skip all resources---leave all resources selected, and click Skip Checked Resources.
- To import selected resources---Either:
  - De-select the resources you do not want to add to inventory, and click Add to Inventory, or
  - De-select the resources you do want to add to inventory and Skip Checked Resources.

About Skipped Resources
If you do not import a resource displayed in the Auto-Discovery portlet, note:
If you skip a new platform, you skip its servers as well.
During the next platform scan, skipped resources will reappear in the portlet after the next scan that detects them. If you have resources that you do not want the agent to discover, see the relevant section in Options for Running and Controlling Resource Discovery.

If the Hyperic Agent discovered all of the resource properties required to monitor a resource, it starts monitoring that resource as soon as you add it to inventory. This is the case for most resource types. Note however, that some level of configuration is required to start managing some resources types - see the Configuration Properties section on a resource's Inventory tab for configuration requirements.
Configure the Number of Auto-Discoveries Displayed
To set the number of completed auto-discoveries displayed in the portlet, click the gear icon in the upper left corner of the portlet. On the Display Settings page, select "10" or "all", and click OK.

ui-Dashboard.Charts

About the Saved Charts Portlet
The Saved Charts portlet allows you to view charts of interest from the dashboard. Charts are shown as a slideshow.

Add Chart to Saved Charts Portlet
When you are viewing a chart, click Save to Dashboard.

Remove Chart from Saved Charts Portlet
Click Remove Chart button on the chart.

ui-Dashboard.Control

About the Control Actions Portlet
The Control Actions portlet displays information about recent control actions performed on resources over a configurable period of recent history.

Recent Control Actions - This section lists the individual resource control action performed during the configured period, starting with the most recent. The following information is displayed for each resource:
- Resource Name — Name of the resource.
- Control Action — The control action that was performed.
- Date/Time — When the action was performed
- Message — Results of the control action.

Quick Control Frequency - This section lists the resources upon which the most on-demand control actions have been performed during the configured interval. The following information is displayed for each resource:
- Resource Name — Name of the resource.
- # of Control Actions — How many control actions were performed during the interval.
- Most Frequent Control Action - The control action that was most frequently performed.
Configure the Control Actions Portlet

To configure the amount of data in the Control Actions portlet:

1. Click the gear icon in the upper right corner of the Control Actions portlet.
2. Configure what appears in the Recent Control Actions section using the first row of filters:
   a. Check the box next to Control Action Range if you want to list recent control actions in the portlet. (To stop the display of this data, uncheck it.)
   b. In the first drop-down list, select the maximum number of completed control actions to list.
   c. In the second drop-down list, select the time range from which to gather that data.
3. Configure what appears in the *Quick Control Frequency *section using the second row of filters:
   a. Check the box if you want to list the resources with the most on-demand control actions. (To stop the display of on-demand control-action data, uncheck it.)
   b. Select the maximum number of resources to list.
4. Click OK.

ui-Dashboard.FavoriteResources

About the Favorite Resources Portlet

The Favorite Resources portlet lists the name, resource type, current availability, and total fired alerts for selected resources.

Select a Favorite Resource On the Fly

You can add a resource to Favorite Resources when you are viewing it in the Resources tab — click Add to Dashboard Favorites on the Tools menu.

Configure Favorite Resources on the Dashboard

1. Click the gear icon in the upper right corner of the Favorite Resources portlet.
2. (Optional) If the Selected Resources section contains resources that you do not want to be included in the portlet, checkmark them and click Remove From List.
3. (Optional) To add resources to the portlet:
   a. Click Add to List.
   b. In the Resources column:
      i. Use the View filters to filter by inventory type, resource type, or both, as desired.
      ii. Enter a substring in the Filter by Name field to filter by resource name, as desired.
      iii. In the list of resources, checkmark desired resources, and click the right arrow between the columns to include them in the portlet.
   c. If the Add Resources column contains resources you do not wish to include in the portlet, checkmark those resources and click the left arrow between the panels.
4. Click OK.
Group Alerts Summary Portlet

About the Group Alerts Portlet
The Group Alerts Summary portlet displays traffic light indicators for resource alerts and group alerts for selected groups. Click on the traffic light for a group alert to view a list of alerts that have fired. Click on a group name to view the group page. This portlet does not present any groups until you add them to it.

Configure the Group Alerts Portlet
1. Click the gear icon in the upper right corner of the **Group Alerts Summary** portlet. The portlet refreshes.
   * The **Available groups** column lists compatible groups that have not been added to the portlet.
   * The **Enabled groups** column lists compatible groups that have been added to the portlet.
2. Change the content of the portlet by clicking a group, and using the appropriate arrow to move the group from one column to another.
3. Click **save** to save your changes.

ui-Dashboard.Metric

About the Metric Viewer Portlet
The Metric Viewer portlet displays a selected metric for selected resources of the same resource type.

Configure the Metric Viewer Portlet
1. Click the gear icon in the upper right corner of the **Metric Viewer** portlet.
2. Specify the display settings for the portlet:
   * **Description** — This description shows up at the top of the portlet.
   * **Display Range** — The total number of resources to display in the portlet.
   * **Resource Type** — This selection filters both the set of resources that users can add to the portlet and the list of metrics available for selection.
   * **Metric** — The single metric that will be displayed for the user-selected set of resource in the portlet.
   * **Sort Order** — Determines whether the resources will be displayed in the portlet by descending or ascending metric value/
3. (Optional) If the **Selected Resources** section contains resources that you do not want to be included in the portlet, checkmark them and click **Remove From List**.
4. (Optional) To add resources to the portlet:
   a. Click **Add to List**.
   b. In the **Resources** column:
      i. Enter a substring in the **Filter by Name** field to filter by resource name, as desired.
      ii. In the list of resources, checkmark desired resources, and click the right arrow between the columns to include them in the portlet.
5. (Optional) If the **Add Resources** column contains resources you do not wish to include in the portlet, checkmark those resources and click the left arrow between the panels
6. Click **OK**.

**ui-Dashboard.ProblemResources**

**About the Problem Resources Portlet**

The **Problem Resources** portlet on the HQ Dashboard lists resources that, over a configured period of recent history, have either had a fired alert, or an *out-of-bounds* metric. An out-of-bounds metric is a metric that had a value outside the "acceptable" range of values set by the baselining process.

**Note:** Tracking out-of-bounds metrics is a behavior that is configured globally, in the "Automatic Baseline Configuration Properties" section of the **Administration > HQ Server Settings** page. If tracking of OOB metrics is not enabled, OOB metrics will not cause a resource to appear in the **Problem Resources** portlet.

The following information is shown for each problem resource:
- Current availability of the resource.
- Number of alerts that have fired during the historical period.
- Number of out-of-bounds metrics reported during the historical period.

Resources are ordered by inventory type (platform, server, and service), and then by the date and time of problem occurrence, from most recent to least recent.

**Configure the Problem Resources Portlet**

You can use the **HQ Dashboard Settings: Problem Resources** page to limit the resources that are included in the **Problem Resources** portlet.

1. Click the gear icon in the upper right corner of the **Problem Resources** portlet.
2. To limit the resources that appear in the portlet:
   - **Show Maximum of** — Select maximum number of problem resources to list.
   - **For the Last** — Choose the period of history for which to show problem resources.
3. Click **OK**.
 ui-Dashboard.RecentlyAdded

About the Recently Added Portlet
The Recently Added portlet lists platforms that have recently been added to inventory.

Configure the Recently Added Portlet
1. Click the gear icon in the upper right corner of the Recently Added portlet.
2. In the Show Maximum of: dropdown menu, select the maximum number of platforms to list in the portlet.
3. Click OK.

 ui-Dashboard.Summary

About the Summary Counts Portlet
The Summary Counts portlet on the HQ Dashboard shows resource counts by inventory type, and if configured to do so, counts for selected resource types. By default, the Summary Counts portlet shows the total resources of each inventory type — Application, Platform, Server, Service, Compatible Group, and Mixed Group.

Configure the Summary Counts Portlet
To tailor the content of the Summary Counts portlet:

1. Click the gear icon in the upper right corner of the portlet.
2. (Optional) To exclude the count for a particular inventory type, (for instance, Applications) uncheck the "Show Total of All ..." checkbox for the inventory type.
3. (Optional) To show the count of resources of particular resource types, (for instance, WebLogic Admin 8.1 and MySQL 5.x), check the box next those resource types.
4. Click OK.
Event Center

The Event Center page, available on the Analyze tab in the Masthead, is a deployment wide view of events that have been logged for resources in your Hyperic deployment.

Learn about Events in Hyperic

Hyperic logs alerts as events automatically. You can configure Hyperic to log events for log messages and resource configuration changes.

Events are ordered by date, with most recent events first. To reverse the sort order, click the control in the Date column header.

Click the refresh icon at the top right to refresh the list.

Filter the Event List

To limit the events displayed in the Events section, choose one or more filter options.

- **Minimum Status** — Select a status to limit the log tracking events in the list to those of that level or higher. Log tracking event levels, in decreasing order of severity, are:
  - Error
  - Warning
  - Info
  - Debug

- **Type** — Select a type to limit events in the list to those of that type:
  - Log track
  - Event Track
  - Alerts

- **Time Range** — Select on the following time ranges to limit the events in the list to those occurred during the range:
  - Last 4 hours
  - Last 8 hours
  - Last day
  - Last week
  - Last month

- **Groups** — Select one or more groups to limit the events in the list to those related to resources in the selected group(s).
Contents of the Event Center Page

The following data is shown for each event that matches the filter criteria selected in the Filter pane. The following information is shown for each event in the list:

- **Date** — Date and time the event happened
- **Status** — For log track events, the level is shown. For alerts, the status column contains "alert".
- **Resource** — The name of the resource that caused the event
- **Subject** —
  - For an alert, the alert name.
  - For a configuration tracking event, the type of change: "add", "delete", "modify", or "rename".
- **Detail** — Information about the event detail or triggering condition.
  - For a configuration tracking event, a limited portion of the raw "diff" detected. For folder changes the diff contains a list of changed files.

ui-Alert.Center

The Alert Center page is a deployment-wide view of alerts and alert definitions.

View Alerts In the Alert Center

1. Click the Analyze tab.
   The Alerts page displays the following data for each fired alert that matches the currently selected filter criteria, ordered chronologically.
   - **Date** — The date and time the alert was triggered.
   - **Alert Definition** — The name of the alert definition that prompted the alert.
   - **Resource** — The resource the alert was triggered on.
   - **Fixed** — Whether or not the alert was fixed.
   - **Acked by** — The name of the user who acknowledged the alert.
   - **Priority** — The alert's priority.
2. Click a column heading to sort the table by the content of that column.

Filter Alert List

These are the options for filtering the list of alerts, and their default settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Values</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>Filters the list of alerts by state.</td>
<td>Not Fixed In Escalation All</td>
<td>All</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Values</td>
<td>Default Setting</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Alert type</td>
<td>Filters the list of alerts by the type of target resource.</td>
<td>Resource — With this setting, only alerts fired on individual resources will appear. This includes alerts applied at the resource type level. Group — With this setting, only alerts that fired on resource groups appear.</td>
<td>All</td>
</tr>
<tr>
<td>Minimum</td>
<td>Filters the list of alerts by the priority of the associated alert definition.</td>
<td>Low, Medium, High</td>
<td>Low</td>
</tr>
<tr>
<td>Priority</td>
<td>In the last Limits the list to alerts fired with a recent period of time.</td>
<td>All Time, day, 2 days, 3 days, 4 days, 5 days, 6 days, week</td>
<td>All Time</td>
</tr>
<tr>
<td>Groups</td>
<td>Limits the list of alerts to those fired on resources in a group.</td>
<td>The dropdown menu lists every resource group (whether compatible or mixed) in the deployment, and the options &quot;All Groups&quot;.</td>
<td>All Groups</td>
</tr>
</tbody>
</table>

**Fix or Acknowledge an Alert in the Alert Center**

To mark alerts "Fixed" from the Alert Center page, and (in vCenter Hyperic) to acknowledge an alert in escalation, checkmark the desired alerts, and click **Fixed** or **Acknowledge** at the bottom of the page.

**View Alert Definitions In the Alert Center**

The **Definitions** tab on the Alert Center page lists alert definitions in your deployment — resource alerts, resource type alerts, and group alerts — that match the current filter criteria.

1. Click the **Analyze** tab.
2. Click the **Definitions** tab to display the "Resource Alert Definitions" pane.
   
   The "Resource Alert Definitions" pane displays the following data for each alert definition that matches the currently selected filter criteria, ordered by creation date, with most recently created definitions first.
   
   - **Name** — The alert definition's name. Click to view the alert definition in the Resource Hub.
   - **Created** — Date and time the alert was defined
   - **Modified** — Date and time the alert was modified (if at all)
• **Active** — Whether or not the alert definition is configured to generate alerts) or not. If the alert is defined to fire once, and not again until after it is fixed, an yellow flag icon will be displayed in this column if the the alert is not fixed.

• **Last Alert** — Date and time the alert was last triggered. Click to view a list of alerts that fired for the alert definition.

• **Resource** — The resource, resource type, or group for which the alert was defined. Click to view the Monitor tab for the resource in the Resource Hub.

• **Escalation** — The name of the escalation scheme assigned to the alert definition. Click to view the escalation.

• **Priority** — The alert definition priority.

Click a column heading to sort the table by the content of that column.

**Filter Alert Definition List**

These are the options for filtering the list of alerts, and their default settings:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition Type</td>
<td>Filters the list of alert definitions by whether the definition was for an individual resource, a group of resources, or a resource type target — so you can limit the list to definitions assigned to a resource, or to a resource type. Values are: Resource — To list all alert definitions that assigned to individual resources or to a resource type. Group — To list only alert definitions defined for a resource group. Resource Type — To list only alert definitions that are assigned to resource groups.</td>
</tr>
<tr>
<td>Exclude Type-Based Definitions</td>
<td>This option is available only when &quot;Resource&quot; is selected for &quot;Definition Type&quot; — checkmark to exclude resource type alert definitions from the list.</td>
</tr>
<tr>
<td>Show Only Disabled Definitions</td>
<td>Further limit the definitions listed to those that are currently disabled.</td>
</tr>
</tbody>
</table>

**ui-Operations.Center**

The Operations Center page, available on the Analyze tab in the Masthead lists resources that are down, have unfixed alerts, or both. You can use filters to scope the content of the page to the resources and problem type of interest. This concise view includes shows the current number of unavailable resources and unfixed alerts, and a single line problem summary for each resource.
Filter by Problem Type and Resource

Use the "Display Filters" fields in the upper left of the page to specify the issues and resources to include in the page.

1. Select a "Status Type":
   - **All** — list every resource that is currently unavailable or has an unfixed alert.
   - **Down Resources** — list only resources that are currently unavailable.
   - **All Alerts** — list all resources with unfixed alerts.
   - **Alerts in Escalation** — list resources with unfixed alerts that are currently in escalation.
   - **Alerts not in Escalation** — list resources with unfixed alerts that are not in escalation.

2. (Optional) To further limit the resources included in the page by hosting platform, enter a string in the "Platform Filter" field and press Return or Enter to update the page.
   The list includes resources with the selected "Status Type" that run on the platform(s) whose names match the specified "Platform Filter" string.

3. (Optional) To further limit the resources included based on group membership, select a group from the "Group Filter" pull-down.
   The list includes resources with the selected "Status Type", that run on platforms whose names match the "Platform Filter" (if specified), and belong to the selected group.

Set Table Controls

Use the **Table Controls** to specify the number of resources listed per page and the frequency with which the page content is updated.

Contents of Operations Center Page

The **Operation Center** page contains summary and detailed information for the alert or availability events that match the current "Display Filter" settings.

Current Filter Totals

The tables in the "Current Filter Totals" section summarize the results that match the current filter settings:

- **Resources** table - Current number of unavailable platforms and the current number of unavailable resources of any type - platform, server, or service. If the current **Status Type** selection limits the page to alerts, the count column contains "N/A".

- **Alerts table** - Total number of unfixed alerts and number of unfixed alerts in escalation, broken down by alert priority. If the current **Status Type** selection limits the page to alert events, the cells contain "N/A".

Resource Details for All Hosts

Each row in the table in the lower part of the **Operations Center** page represents a resource that is currently down or a resource that has an unfixed alert. If a resource is currently down and has an unfixed alert, it will appear in two rows.

- **Platform** - The platform where the resource runs.
- **Resource** - Name of the resource that is unavailable or has an unfixed alert.
- **Alert Name** - In a row for a resource with an alert, the name of the alert definition that fired the alert.
- **Priority** - In a row for a resource with an alert, the alert priority.
- **Status Type** - Indicates whether the row corresponds to a "Resource Down" event or an unfixed "Alert".
- **Last Escalation** - In a row for a resource with an alert in escalation, timestamp for the last escalation step performed.
- **Last Check** - For an unavailable resource, shows when metrics for the resource were last collected. For an alert, shows when it last fired.
- **Duration** - Indicates how long ago the alert fired or the resource went down.
- **State** - For an alert, a 🔄 icon indicates the alert is in escalation. A 😊 icon indicates the alert in escalation has been acknowledged.
- **Status Information** - For an alert, shows how many times it has fired and the condition that triggered it. If a metric condition triggered the alert, the triggering and current values of the metric are shown.

**ui-Report.Center**

The HQ Report Center has predefined reports you can run. Reports generation is synchronous, and on-demand. The Report Center does not support scheduled or batch report execution.

**Navigate to the Report Center.**

Click **Report Center** on the **Analyze** tab.

**Run a Report**

To run a report:

1. Click the desired report in the **Select a report** list.
2. In the "Report Options" section, enter values for report parameters.
   - Report parameters vary by report.
   - If a report is designed for a particular resource type and supports a **Group** parameter, only compatible groups will appear in the group selector list.
3. Select a format for the report in **Export the report as**, one of:
   - PDF
   - HTML
   - Excel
   - CSV
4. Click **OK**.
The report is displayed.

**HTML Report Displayed in the Same Window**

HTML reports appear in the same window that the HQ user interface is running in. When you are done viewing an HTML report, click the vCenter Hyperic logo in the upper left of the report or the back button in your browser to return to the **Report Center** page, rather than close your browser.

5. Save the report to disk, as desired.

**View a Report**

Note that in reports formatted as PDF or HTML:

- Hostnames and alerts listed in the reports link to the **Monitoring** page or the **Alert List** page for the resource, respectively.
- The vCenter Hyperic logo in the upper left of the report is a link to the **Report Center** page.